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Copyright

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any
means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of
Seiko Epson Corporation. No patent liability is assumed with respect to the use of the information contained
herein. Neither is any liability assumed for damages resulting from the use of the information herein. The
information contained herein is designed only for use with this Epson product. Epson is not responsible for any
use of this information as applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for
damages, losses, costs, or expenses incurred by the purchaser or third parties as a result of accident, misuse, or
abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.)
failure to strictly comply with Seiko Epson Corporation's operating and maintenance instructions.

Seiko Epson Corporation and its affiliates shall not be liable for any damages or problems arising from the use of
any options or any consumable products other than those designated as Original Epson Products or Epson
Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that
occurs from the use of any interface cables other than those designated as Epson Approved Products by Seiko
Epson Corporation.

© 2017 Seiko Epson Corporation

The contents of this manual and the specifications of this product are subject to change without notice.
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Trademarks

[J EPSONB® is a registered trademark, and EPSON EXCEED YOUR VISION or EXCEED YOUR VISION is a
trademark of Seiko Epson Corporation.

(4 PRINT Image Matching™ and the PRINT Image Matching logo are trademarks of Seiko Epson Corporation.
Copyright © 2001 Seiko Epson Corporation. All rights reserved.

[d Epson Scan 2 software is based in part on the work of the Independent JPEG Group.
1 libtiff

Copyright © 1988-1997 Sam Leftler

Copyright © 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is
hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in
all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics
may not be used in any advertising or publicity relating to the software without the specific, prior written
permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS,
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED
OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

(d SDXC Logo is a trademark of SD-3C, LLC.

Y 4
xXC

[ PictBridge is a trademark.

A

PictBridge
USB_LAN_WLAN
vvyYy
d Microsoft®, Windows®, and Windows Vista® are registered trademarks of Microsoft Corporation.

[d Apple, Macintosh, macOS, OS X, Bonjour, Safari, AirPrint, the AirPrint Logo, iPad, iPhone, iPod touch, and
iTunes are trademarks of Apple Inc., registered in the U.S. and other countries.

[d Google Cloud Print, Chrome, Chrome OS, Google Play and Android are trademarks of Google Inc.

[d Adobe and Adobe Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the
United States and/or other countries.

[ Intel® is a registered trademark of Intel Corporation.

(d QR Code is a registered trademark of DENSO WAVE INCORPORATED in Japan and other countries.
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[d General Notice: Other product names used herein are for identification purposes only and may be trademarks
of their respective owners. Epson disclaims any and all rights in those marks.
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About This Manual

Introduction to the Manuals

The following manuals are supplied with your Epson printer. As well as the manuals, check the various types of
help information available from the printer itself or from the Epson software applications.

[ Start Here (paper manual)

Provides you with information on setting up the printer, installing the software, using the printer, solving
problems, and so on.

(d User's Guide (digital manual)

This manual. Provides overall information and instructions on using the printer, on network settings when
using the printer on a network, and on solving problems.

You can obtain the latest versions of the above manuals with the following methods.

(A Paper manual

Visit the Epson Europe support website at http://www.epson.eu/Support, or the Epson worldwide support
website at http://support.epson.net/.

(J Digital manual

Start EPSON Software Updater on your computer. EPSON Software Updater checks for available updates of
Epson software applications and the digital manuals, and allows you to download the latest ones.

Related Information
= “EPSON Software Updater” on page 156

Marks and Symbols

A Caution:

Instructions that must be followed carefully to avoid bodily injury.

g Important:

Instructions that must be observed to avoid damage to your equipment.

Note:
Provides complementary and reference information.

= Related Information

Links to related sections.

10
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About This Manual

Descriptions Used in this Manual

[ Screenshots of the printer driver and the Epson Scan 2 (scanner driver) screens are from Windows 10 or macOS
Sierra. The content displayed on the screens varies depending on the model and situation.

[ Tllustrations of the printer used in this manual are examples only. Although there may be slight differences
depending on the model, the method of operation is the same.

[d Some of the menu items on the LCD screen vary depending on the model and settings.

Operating System References

Windows

In this manual, terms such as "Windows 10", "Windows 8.1", "Windows 8", "Windows 7", "Windows Vista", and
"Windows XP" refer to the following operating systems. Additionally, "Windows" is used to refer to all versions.

(d Microsoft® Windows® 10 operating system

(J Microsoft® Windows® 8.1 operating system

([ Microsoft® Windows® 8 operating system

[ Microsoft® Windows® 7 operating system

[ Microsoft® Windows Vista® operating system

(J Microsoft® Windows® XP operating system

(J Microsoft® Windows® XP Professional x64 Edition operating system

Mac OS

In this manual, "Mac OS" is used to refer to macOS Sierra, OS X El Capitan, OS X Yosemite, OS X Mavericks, OS X
Mountain Lion, Mac OS X v10.7.x, and Mac OS X v10.6.8.

1
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Important Instructions

Safety Instructions

Read and follow these instructions to ensure safe use of this printer. Make sure you keep this manual for future
reference. Also, be sure to follow all warnings and instructions marked on the printer.

[d Some of the symbols used on your printer are to ensure safety and proper use of the printer. Visit the following
Web site to learn the meaning of the symbols.

http://support.epson.net/symbols

(4 Use only the power cord supplied with the printer and do not use the cord with any other equipment. Use of
other cords with this printer or the use of the supplied power cord with other equipment may result in fire or
electric shock.

(d Be sure your AC power cord meets the relevant local safety standard.

[d Never disassemble, modify, or attempt to repair the power cord, plug, printer unit, scanner unit, or options by
yourself, except as specifically explained in the printer's manuals.

(J Unplug the printer and refer servicing to qualified service personnel under the following conditions:

The power cord or plug is damaged; liquid has entered the printer; the printer has been dropped or the casing
damaged; the printer does not operate normally or exhibits a distinct change in performance. Do not adjust
controls that are not covered by the operating instructions.

[ Place the printer near a wall outlet where the plug can be easily unplugged.

(A Do not place or store the printer outdoors, near excessive dirt or dust, water, heat sources, or in locations
subject to shocks, vibrations, high temperature or humidity.

(d Take care not to spill liquid on the printer and not to handle the printer with wet hands.

(d Keep the printer at least 22 cm away from cardiac pacemakers. Radio waves from this printer may adversely
affect the operation of cardiac pacemakers.

[ If the LCD screen is damaged, contact your dealer. If the liquid crystal solution gets on your hands, wash them
thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them immediately with
water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately.

Safety Instructions for Ink

[d Be careful not to touch any ink when you handle the ink tanks, ink tank caps, and opened ink bottles or ink
bottle caps.
[ If ink gets on your skin, wash the area thoroughly with soap and water.

[ If ink gets into your eyes, flush them immediately with water. If discomfort or vision problems continue after
a thorough flushing, see a doctor immediately.

[ If ink gets into your mouth, see a doctor right away.

[d Do not disassemble the maintenance box; otherwise ink may get into your eyes or on your skin.
d Do not shake an ink bottle too vigorously or subject it to strong impacts as this can cause ink to leak.

(4 Keep ink bottles, the ink tank unit, and maintenance box out of the reach of children. Do not allow children to
drink from or handle the ink bottles and ink bottle cap.

12
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Printer Advisories and Warnings

Read and follow these instructions to avoid damaging the printer or your property. Make sure you keep this
manual for future reference.

Advisories and Warnings for Setting Up the Printer

(d Do not block or cover the vents and openings in the printer.

[d Use only the type of power source indicated on the printer's label.

[d Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch on and off.
(4 Avoid electrical outlets controlled by wall switches or automatic timers.

[d Keep the entire computer system away from potential sources of electromagnetic interference, such as
loudspeakers or the base units of cordless telephones.

(4 The power-supply cords should be placed to avoid abrasions, cuts, fraying, crimping, and kinking. Do not place
objects on top of the power-supply cords and do not allow the power-supply cords to be stepped on or run over.
Be particularly careful to keep all the power-supply cords straight at the ends and the points where they enter
and leave the transformer.

[ If you use an extension cord with the printer, make sure that the total ampere rating of the devices plugged into
the extension cord does not exceed the cord's ampere rating. Also, make sure that the total ampere rating of all
devices plugged into the wall outlet does not exceed the wall outlet's ampere rating.

[ If you plan to use the printer in Germany, the building installation must be protected by a 10 or 16 amp circuit
breaker to provide adequate short-circuit protection and over-current protection for the printer.

(d When connecting the printer to a computer or other device with a cable, ensure the correct orientation of the
connectors. Each connector has only one correct orientation. Inserting a connector in the wrong orientation
may damage both devices connected by the cable.

[J Place the printer on a flat, stable surface that extends beyond the base of the printer in all directions. The printer
will not operate properly if it is tilted at an angle.

[d Allow space above the printer so that you can fully raise the document cover.
[d Leave enough space in front of the printer for the paper to be fully ejected.

(d Avoid places subject to rapid changes in temperature and humidity. Also, keep the printer away from direct
sunlight, strong light, or heat sources.

Advisories and Warnings for Using the Printer

[d Do not insert objects through the slots in the printer.

(d Do not put your hand inside the printer during printing.

(4 Do not touch the white flat cable and ink tubes inside the printer.

(d Do not use aerosol products that contain flammable gases inside or around the printer. Doing so may cause fire.
(4 Do not move the print head by hand; otherwise, you may damage the printer.

[d Be careful not to trap your fingers when closing the scanner unit.

(d Do not press too hard on the scanner glass when placing the originals.
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[d Prolonged use of the printer when the ink level is below the lower line could damage the printer. Fill the ink
tank to the upper line while the printer is not operating. To display the correct ink level estimates, reset the ink
level after filling the tank.

(d Always turn the printer off using the O button. Do not unplug the printer or turn off the power at the outlet
until the O light stops flashing.

[ If you are not going to use the printer for a long period, be sure to unplug the power cord from the electrical
outlet.

Advisories and Warnings for Transporting or Storing the Printer

[d When storing or transporting the printer, avoid tilting it, placing it vertically, or turning it upside down;
otherwise ink may leak.

[d Before transporting the printer, make sure that the print head is in the home (far right) position.

Advisories and Warnings for Using the Printer with a Wireless
Connection

[J Radio waves from this printer may negatively affect the operation of medical electronic equipment, causing
them to malfunction. When using this printer inside medical facilities or near medical equipment, follow

directions from the authorized personnel representing the medical facilities, and follow all posted warnings and
directions on the medical equipment.

[d Radio waves from this printer may negatively affect the operation of automatically controlled devices such as
automatic doors or fire alarms, and could lead to accidents due to malfunction. When using this printer near
automatically controlled devices, follow all posted warnings and directions on these devices.

Advisories and Warnings for Using Memory Cards

(d Do not remove a memory card or turn off the printer while the memory card light is flashing.

[J The methods for using memory cards vary according to card type. Be sure to refer to the manual packaged with
your memory card for details.

(4 Use only memory cards compatible with the printer.

Related Information

= “Supported Memory Card Specifications” on page 196

Advisories and Warnings for Using the LCD Screen

[J The LCD screen may contain a few small bright or dark spots, and because of its features it may have an uneven
brightness. These are normal and do not indicate that it is damaged in any way.

(d Only use a dry, soft cloth for cleaning. Do not use liquid or chemical cleaners.

[d The exterior cover of the LCD screen could break if it receives a heavy impact. Contact your dealer if the
screen's surface chips or cracks, and do not touch or attempt to remove the broken pieces.
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Protecting Your Personal Information

When you give the printer to someone else or dispose of it, erase all the personal information stored in the printer's
memory by selecting Settings > Restore Default Settings > All Settings on the control panel.
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Printer Basics

Part Names and Functions

(1) Rear paper feed Loads paper.

(2] Paper support Supports loaded paper.

(3] Feeder guard Prevents foreign substances from entering the printer. This cover should
usually be closed.

(4] Edge guide Feeds the paper straight into the printer. Slide to the edges of the paper.

(5) Control panel Operates the printer. You can change the angle of the control panel by hand.

(6] CD/DVD tray Place a CD/DVD for label printing. This should usually be stored on the

bottom of the printer.
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(1) Ink tank cover Open to refill the ink tank.

(2] Ink reservoir tanks (Ink tanks) Supplie ink to the print head.

(3] Ink tank unit Contains the ink tanks.

(4] Print head Ink is ejected from the print head nozzles underneath.

Front cover

Open to load paper in the paper cassette.

Output tray

Holds the ejected paper. Pull out manually and push it back in to store.

Paper cassette 1

Paper cassette 2

Loads paper.

® 0|0 0|0

Edge guide

Feeds the paper straight into the printer. Slide to the edges of the paper.

000
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(1) Document cover Blocks external light while scanning.

(2] Scanner glass Place the originals.

(3] Scanner unit Scans placed originals. Open to refill the ink tank or to remove jammed
paper. This unit should usually be kept closed.

(4] Memory card slot Insert a memory card.

(5] External interface USB port Connects an external storage device or a PictBridge capable device.

(1) Maintenance box cover Remove when replacing the maintenance box. The maintenance box is a
container that collects a very small amount of surplus ink during cleaning or
printing.

(2] ACinlet Connects the power cord.

(3] Rear cover Remove when removing jammed paper.

(4] LAN port Connects a LAN cable.

(5) USB port Connects a USB cable to connect with a computer.

Control Panel

You can change the angle of the control panel.

3
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Buttons

]—-o

Q

o

(3 (@]

o
<>

(8]

Bax
8|0

©
o) (] (13

o)
o]

(1) (!) Turns the printer on or off.

Do not turn off while the power light is flashing (while the printer is operating or processing
data).

Unplug the power cord when the power light is off.

(2] ﬂ Displays the home screen.
(3] -+ Selects the number of pages to print.
(4] @ Stops the current operation.
(5] @ Displays menus such as CD/DVD label printing and copying.
0 ps) Returns to the previous screen.
o AV 4P oK Use the A ¥ 4P buttons to select a menu, and then press the OK button to open the selected
menu.
(3] @ Starts an operation such as printing or copying.
Guide to the LCD Screen

Menus and messages are displayed on the LCD screen. Select a menu or setting by pressing the A ¥ 4P buttons.

Guide to the Home Screen

The following icons and menus are displayed on the home screen.

OK| Proceed |4Ip) Select
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(1] Icons that show the network status are displayed. You can learn the meaning of the icons in the Help menu. Select

Help from the home screen using the € or P> button, and then press the OK button. Select Icon List using the A or
V¥ button, and then press the OK button.

®

Displays the status of the maintenance box. You can learn the meaning of the icon in the Help menu.

(3] Function icons and names are displayed as menu icons.

Copy

Allows you to copy a document.

Print Photos

Allows you to print photos on your memory card.

Scan

Allows you to scan a document or a photo.

More Functions

Allows you to access a variety of printing features such as copying photos, printing photos in
different layouts, and copying or printing on a CD/DVD.

Settings

Allows you to perform maintenance and make various settings for the printer features and
operations.

Maint.

Access the menus recommended to improve the quality of your printouts. This is a shortcut to
the following menu.

Settings > Maintenance

Help

Displays help information on basic operations, meaning of the icons displayed on the LCD
screen, and troubleshooting information.

Quiet Mode

Displays Quiet Mode setting that allows you to reduce the noise the printer makes. However,
enabling this may reduce print speed. Depending on the paper type and print quality settings
you selected, there may be no difference in the printer's noise level. This is a shortcut to the
following menu.

Settings > Printer Setup > Quiet Mode

Wi-Fi Setup

Displays menus that allow you to set up the printer for use on a wireless network.

o When dand P> are displayed, you can scroll right or left.

(5) Available buttons are displayed. In this example, you can proceed to the selected menu by pressing the OK button,

and you can select another menu by pressing the € or P> button.

Related Information

= “Copying Basics” on page 99

= “Printing Photos by Selecting from a Memory Card” on page 61

= “Scanning Using the Control Panel” on page 106

= “Copying Photos” on page 102

= “Printing in Various Layouts” on page 69
= “Printing Photos from a Memory Card onto a CD/DVD Label” on page 62

= “Menu Options for Settings Mode” on page 139

= “Menu Options for Maintenance” on page 139

= “Menu Options for Network Settings” on page 141
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Entering Characters

To enter characters and symbols for network settings from the control panel, use the A, ¥, 4, and P> buttons and

the software keyboard on the LCD screen. Press the AY, 4, or P> button to highlight a character or function
button on the keyboard, and then press the OK button to confirm. When you have finished entering characters,
highlight Done, and then press the OK button.

The displayed screen varies depending on the settings items. The following is the screen for entering the password
for your Wi-Fi network.

Il'lil"]"l'.l_:
ABCDEFGHI JIABT2IEBI2
KLMNOPQRS T Symbol

UVW XY Z
1234567890

&l/[:|C[I]+|-]

Icons Descriptions
AB12 Changes letters to uppercase.
ab12 Changes letters to lowercase.
Symbol Displays symbols.
4> Moves the cursor to the left or right.

Deletes a character to the left (backspace).

Space Enters a space to the right of the cursor.

Done Closes the software keyboard screen and displays a confirmation screen, or moves to the next screen.
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Network Connection Types

You can use the following connection methods.

Ethernet Connection

Connect the printer to a hub with an Ethernet cable.

Related Information

= “Connecting to a Computer” on page 23
= “Making Advanced Network Setting” on page 28

Wi-Fi Connection

Connect the printer and the computer or smart device to the access point. This is the typical connection method
for home or office networks where computers are connected by Wi-Fi through the access point.

Gib)

Z

(i

1)
M)
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Related Information
= “Connecting to a Computer” on page 23
= “Connecting to a Smart Device” on page 24

= “Making Wi-Fi Settings from the Printer” on page 24

Wi-Fi Direct (Simple AP) Connection

Use this connection method when you are not using Wi-Fi at home or at the office, or when you want to connect
the printer and the computer or smart device directly. In this mode, the printer acts as an access point and you can
connect up to four devices to the printer without having to use a standard access point. However, devices directly
connected to the printer cannot communicate with each other through the printer.

Note:
Wi-Fi Direct (Simple AP) connection is a connection method designed to replace Ad Hoc mode.

(i

)

)

—~ —~
— —~

The printer can be connected by Wi-Fi or Ethernet, and Wi-Fi Direct (Simple AP) connection simultaneously.
However, if you start a network connection in Wi-Fi Direct (Simple AP) connection when the printer is connected
by Wi-Fi, the Wi-Fi is temporarily disconnected.

Related Information
= “Making Wi-Fi Direct (Simple AP) Connection Settings” on page 27

Connecting to a Computer

We recommend using the installer to connect the printer to a computer. You can run the installer using one of the
following methods.

[ Setting up from the website
Access the following website, and then enter the product name. Go to Setup, and then start setting up.
http://epson.sn

[ Setting up using the software disc (only for the models that come with a software disc and users with computers
with disc drives.)

Insert the software disc into the computer, and then follow the on-screen instructions.

23


http://epson.sn/?q=2

User's Guide

Network Settings

Selecting the Connection Methods

Follow the on-screen instructions until the following screen is displayed, and then select the connection method of
the printer to the computer.

Select the connection type and then click Next.

I instatl Navi [XXXX Series] - x

Start Setup Connecting your
_+ License Agreement — ® Wi-Fi Connection (Recommended)
0 Establishes a wireless connection with the El (o =

.+ System Check

O Ethernet Connection
- Instaliation Select this if you are using a wired network E j—H

and wish to connect with an Ethernet cable.

O USB connection
- Connect the « toa computer using a E =

Additional USE cable.

Installation

Finish The computer is connected to the wireless network.
'o You can use the « by selecting [Wi-Fi Connection].

Advanced configuration

. Cancel Mext

Setup Complete

Follow the on-screen instructions.

Connecting to a Smart Device

You can use the printer from a smart device when you connect the printer to the same Wi-Fi network (SSID) as the
smart device. To use the printer from a smart device, set up from the following website. Access to the website from
the smart device that you want to connect to the printer.

http://epson.sn > Setup

Note:
If you want to connect a computer and a smart device to the printer at the same time, we recommend connecting the
computer first.

Making Wi-Fi Settings from the Printer

You can make network settings from the printer's control panel in several ways. Choose the connection method
that matches the environment and conditions that you are using.

If you know the information for the access point such as SSID and password, you can make settings manually.

If the access point supports WPS, you can make settings by using push button setup.
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After connecting the printer to the network, connect to the printer from the device that you want to use (computer,
smart device, tablet, and so on.)

Making Wi-Fi Settings Manually

You can manually set up the information necessary to connect to an access point from the printer's control panel.
To set up manually, you need the SSID and password for an access point.

Note:
If you are using an access point with its default settings, the SSID and password are on the label. If you do not know the SSID
and password, contact the person who set up the access point, or see the documentation provided with the access point.

r N
SsID
< XXXXXXXXXX
o
° rl : KEY
° XXXXXXXXXXXXX

.

1. Select Wi-Fi Setup on the home screen, and then press the OK button.
2. Select Wi-Fi (Recommended), and then press the OK button.

3. Press the OK button.

4. Select Wi-Fi Setup Wizard, and then press the OK button.

5. Select the SSID for the access point from printer's control panel, and then press the OK button.

Note:
(A If the SSID you want to connect to is not displayed on the printer’s control panel, select Search Again to update the
list. If it is still not displayed, select Other Networks, and then enter the SSID directly.

A If you do not know the SSID, check if it is written on the label of the access point. If you are using the access point
with its default settings, use the SSID written on the label.
6. Enter the password, and then select Done. Press the OK button.

Note:
(A The password is case-sensitive.

A If you do not know the password, check if it is written on the label of the access point. If you are using the access point
with its default settings, use the password written on the label. The password may also be called a "Key", a
"Passphrase”, and so on.

A If you do not know the password for the access point, see the documentation provided with the access point, or
contact the person who set it up.

7. Check the settings, and then press the OK button.

8. Select whether or not you print a network connection report after finishing the settings.

Note:
If you fail to connect, load papers, and then press the D button to print a network connection report.
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Related Information
= “Checking the Network Connection Status” on page 29
= “When You Cannot Make Network Settings” on page 171

Making Wi-Fi Settings by Push Button Setup

You can automatically set up a Wi-Fi network by pressing a button on the access point. If the following conditions
are met, you can set up by using this method.

(4 The access point is compatible with WPS (Wi-Fi Protected Setup).

[d The current Wi-Fi connection was established by pressing a button on the access point.

Note:
If you cannot find the button or you are setting up using the software, see the documentation provided with the access point.

1. Select Wi-Fi Setup on the home screen, and then press the OK button.
2. Select Wi-Fi (Recommended), and then press the OK button.

3. Press the OK button.

4. Select Push Button Setup (WPS), and then press the OK button.

5. Hold down the [WPS] button on the access point until the security light flashes.

If you do not know where the [WPS] button is, or there are no buttons on the access point, see the
documentation provided with your access point for details.

6. Press the OK button on the printer's control panel. Follow the on-screen instruction hereafter.

Note:
If connection fails, restart the access point, move it closer to the printer, and try again. If it still does not work, print a
network connection report and check the solution.

Related Information

= “Checking the Network Connection Status” on page 29
= “When You Cannot Make Network Settings” on page 171
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Making Wi-Fi Settings by PIN Code Setup (WPS)

You can connect to an access point by using a PIN code. You can use this method to set up if an access point is
capable of WPS (Wi-Fi Protected Setup). Use a computer to enter a PIN code into the access point.

1. Select Settings on the home screen, and then press the OK button.

2. Select Network Settings and then press the OK button.

3. Select Wi-Fi Setup on the home screen and then press the OK button.
4. Select PIN Code Setup (WPS) and then press the OK button.

5. Use your computer to enter the PIN code (an eight digit number) displayed on the printer's control panel into
the access point within two minutes.

Note:

See the documentation provided with your access point for details on entering a PIN code.
6. Press the OK button.

Setup is complete when the setup completion message is displayed.

Note:
If connection fails, restart the access point, move it closer to the printer, and try again. If it still does not work, print a
connection report and check the solution.

Related Information
= “Checking the Network Connection Status” on page 29
= “When You Cannot Make Network Settings” on page 171

Making Wi-Fi Direct (Simple AP) Connection Settings

This method allows you to connect the printer directly to computer or smart devices without an access point. The
printer acts as an access point.

n Important:

When you connect from a computer or smart device to the printer using the Wi-Fi Direct (Simple AP) connection,
the printer is connected to the same Wi-Fi network (SSID) as the computer or smart device and the communication
is established between them. Since the computer or smart device is automatically connected to the other connectable
Wi-Fi network if the printer is turned off, it is not connected to the previous Wi-Fi network again if the printer is
turned on. Connect to the printer's SSID for Wi-Fi Direct (Simple AP) connection from the computer or smart
device again. If you do not want to connect every time you turn the printer on or off, we recommend using Wi-Fi
network by connecting the printer to an access point.

1. Select Wi-Fi Setup on the home screen, and then press the OK button.
2. Select Wi-Fi Direct, and then press the OK button.
3. Press the OK button.

4. Press the OK button to start the setup.
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Press the OK button.

Check the SSID and password displayed on the printer's control panel. On the network connection screen of
the computer or smart device, select the SSID shown on the printer's control panel to connect.

Enter the password displayed on the printer's control panel on the computer or smart device.
After the connection is established, press the OK button on the printer's control panel.

Press the OK button.

Related Information

= “Checking the Network Connection Status” on page 29
= “When You Cannot Make Network Settings” on page 171

Making Advanced Network Setting

You can change the network device name, TCP/IP setup, DNS server and so on. Check your network environment
before making changes.

1.

Select Settings on the home screen, and then press the OK button.
Select Network Settings, and then press the OK button.
Select Manual Network Setup, and then press the OK button.

Enter the device name.

You can enter the following characters. To fix the device name, move the cursor on the Done, and then press
the OK button.

[d Character limits: 2 to 15 (you must enter at least 2 characters)
(1 Usable characters: AtoZ,atoz,0to9, -.
[d Characters you cannot use at the top: 0 to 9, -.

(d Characters you cannot use at the bottom: -

Note:
If you press the OK button without entering the device name, the default device name (EPSON and the last six digits of
the device's MAC address) are set.

Select the method for acquiring the IP address (TCP/IP Setup).
d Auto

Select when you are using an access point at home or you are allowing the IP address to be acquired
automatically by DHCP.

[ Manual

Select when you do not want the device's IP address to be changed. Enter the IP address, subnet mask,
default gateway, primary DNS server, and secondary DNS server according to your network environment.
Press the OK button, and go to step 7.
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6. Select the method for setting the DNS server.
d Auto

Select when you want to acquire the IP address automatically.

J Manual

Select when you want to set a unique DNS server address to the device. Enter the addresses for the primary
DNS server and the secondary DNS server.
7. Select whether or not to use a proxy server.

[ Do Not Use

Select when you are using the printer in a home network environment.

1 Use

Select when you are using a proxy server in your network environment and you want to set it to the printer.
Enter the proxy server address and port number.
8. Check the settings and press the OK button.

A message is displayed on the LCD screen when the network settings are complete, and you are returned to
the home screen after a short period of time.

Checking the Network Connection Status

You can check the network connection status in the following way.

Checking the Network Status Using Network Icon

You can check the network connection status using the network icon on the printer's home screen. The icon
changes depending on the connection type and strength of the radio wave. For more information, select Help >
Icon List on the printer's control panel.

Checking the Network Status from the Control Panel

You can also view other network-related information by pressing the network menus you want to check.
1. Select Settings on the home screen, and then press the OK button.
2. Select Network Settings, and then press the OK button.

3. Select Network Status, and then press the OK button.

Displays the Wi-Fi and Wi-Fi Direct (Simple AP) connection status. You can check if the printer is connected
to the network, or how many devices are connected when the printer is connected by Wi-Fi Direct (Simple
AP) connection.

29



User's Guide

4.

Network Settings

To check other information, press the € or P> button and then press the A or ¥ button to select the menus
that you want to check.

[ Wired LAN/Wi-Fi Status

Displays the network information (Obtain IP Address, Default Gateway, DNS Server Setup Mode and so
on) for Ethernet or Wi-Fi connections.

[ Wi-Fi Direct Status

Displays the network information (Obtain IP Address, the number of connected devices, Default Gateway
and so on) for Wi-Fi Direct (Simple AP) connections.

[d Epson Connect Status
Displays the registered information for Epson Connect services.
d Google Cloud Print Status

Displays the registered information for Google Cloud Print services and the connection status.

[ Print Status Sheet

Make sure that papers are set to the printer, then press the <> button to print a network status sheet.

Printing a Network Connection Report

You can print a network connection report to check the status between the printer and the access point.

1.

Load papers.
Select Settings on the home screen, and then press the OK button.
Select Network Settings, and then press the OK button.

Select Connection Check, and then press the OK button.

The connection check starts.

Select Yes, and then press the OK button.

Press the <> button to print the network connection report.

If an error has occurred, check the network connection report, and then follow the printed solutions.

Related Information

= “Messages and Solutions on the Network Connection Report” on page 31
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Messages and Solutions on the Network Connection Report

Check the messages and error codes on the network connection report, and then follow the solutions.

2 Clum

Check Hetwerk Connection

Check Result FAIL

Error code [ (E=2)

See the Hetwork Status and check Lf the Betwork Nams (S5ID) is

el SOTE au WAAE B8 SSRBGST, b
If the S5ID isx cocrect, sake fuse B9 Gatss the corrach Pl.llul'ﬂ.liﬂ

and try sgain.

If your problems persist.
sad your desussntatiss for halp and networking elps.

Chackad Itams

fizreless Wetworck Masa (S53I0) Check FAIL

Communication Mode Chock Urchgs kod
Bacurity Mode Check Uncheaked
MAC Address Filvering Check Unchieo ked
Security Key/Password Check Unches oed
1P Address Check Unchas ked
Detalled IPF Setup Checok Unchecked

Betwork Status

Printer Hams EPSOH XXXXXX
Pripear Madel XX-XXX Baries
IP Addreas 1£9.254.137.8
Subnet Mask £35.255.0.0
Default Catoway

Habwork Nasa (S5ID) Epsoniet
SasuEley Nonie

Signal Strength Poar

MAC Address FR:D0: 2T 140100 AC

a. Error code

b. Messages on the Network Environment

a. Error code

Code Solution

E-1 ([ Make sure that the Ethernet cable is connected to the printer, a hub, or other network devices.

1 Make sure that the hub or other network devices are turned on.
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E-2 (1 Make sure that the access point is turned on.
E-3 Check that the computer or other devices are connected correctly to the access point.

E-7 Place the printer close to the access point. Remove any obstacles between them.

| T

If you have entered the SSID manually, check if it is correct. Check the SSID from the Network Status part on
the network connection report.

(W]

To establish a network using push button setup, check that the access point supports WPS. If it does not
support WPS, you cannot establish a network using push button setup.

1 Check that only ASCII characters (alphanumeric characters and symbols) are used for the SSID. The printer
cannot display an SSID which contains any characters other than ASCII characters.

1 Check the SSID and password before connecting to the access point. If you are using an access point with its
default settings, the SSID and password are on the label. If you do not know the SSID and password, contact
the person who set up the access point, or see the documentation provided with the access point.

(1 When you want to connect to an SSID generated using the tethering function on a smart device, check the
SSID and password in the documentation provided with the smart device.

[ If the Wi-Fi connection is suddenly disconnected, check the following. If any of these are applicable, reset the
network settings using the installer. You can run it from the following website.

http://epson.sn > Setup

[ Another smart device was added to the network using push button setup.

[ The Wi-Fi network was set up using any method other than push button setup.

E-5 Make sure the access point's security type is set to one of the following. If it is not, change the security type on
the access point, and then reset the printer's network settings.

d WEP-64 bit (40 bit)
WEP-128 bit (104 bit)
WPA PSK (TKIP/AES)"
WPA2 PSK (TKIP/AES)"
WPA (TKIP/AES)
WPA2 (TKIP/AES)

U0 UJd o od

*

: WPA PSK is also known as WPA Personal. WPA2 PSK is also known as WPA2 Personal.

E-6 [ Check if the MAC address filtering is disabled. If it is enabled, register the printer's MAC address so that it is
not filtered. See the documentation provided with the access point for details. You can check the printer's
MAC address from the Network Status part on the network connection report.

[ If the access point's shared authentication is enabled on the WEP security method, make sure the
authentication key and index are correct.

E-8 (d Enable DHCP on the access point when the printer's Obtain IP Address is set to Auto.

([ If the printer's Obtain IP Address is set to Manual, the IP address you manually set is out of range (for
example: 0.0.0.0) and it is disabled. Set a valid IP address from printer's control panel or Web Config.
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Code Solution
E-9 Check the following.
(4 Devices are turned on.
[ You can access the Internet and other computers or network devices on the same network from the devices
you want to connect to the printer.
If it still does not work after checking the above, reset the network settings using the installer. You can run it
from the following website.
http://epson.sn > Setup
E-10 Check the following.
[ Other devices on the network are turned on.
1 Network addresses (IP address, subnet mask, and default gateway) are correct if you have set the printer's
Obtain IP Address to Manual.
Reset the network address if these are incorrect. You can check the IP address, subnet mask, and default
gateway from the Network Status part on the network connection report.
When DHCP is enabled, change the printer's Obtain IP Address to Auto. If you want to set the IP address
manually, check the printer's IP address from the Network Status part on the network connection report, and
then select Manual on the network settings screen. Set the subnet mask to [255.255.255.0].
E-11 Check the following.
(d The default gateway address is correct when you set the printer's TCP/IP Setup to Manual.
[ The device that is set as the default gateway is turned on.
Set the correct default gateway address. You can check the default gateway address from the Network Status
part on the network connection report.
E-12 Check the following.
(1 Other devices on the network are turned on.
1 The network addresses (IP address, subnet mask, and default gateway) are correct if you are entering them
manually.
d The network addresses for other devices (subnet mask and default gateway) are the same.
[d The IP address does not conflict with other devices.
If it still does not work after checking the above, try the following.
[ Make network settings on the computer that is on the same network as the printer using the installer. You
can run it from the following website.
http://epson.sn > Setup
[d You can register several passwords on an access point that uses the WEP security type. If several passwords
are registered, check if the first registered password is set on the printer.
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E-13 Check the following.

http://epson.sn > Setup

[ Network devices such as an access point, hub, and router are turned on.

1 The TCP/IP Setup for network devices has not been set up manually. (If the printer's TCP/IP Setup is set
automatically while the TCP/IP Setup for other network devices is performed manually, the printer's network
may differ from the network for other devices.)

If it still does not work after checking the above, try the following.

(1 Make network settings on the computer that is on the same network as the printer using the installer. You
can run it from the following website.

[d You can register several passwords on an access point that uses the WEP security type. If several passwords
are registered, check if the first registered password is set on the printer.

b. Messages on the Network Environment

Message

Solution

*Multiple network names (SSID) that
match your entered network name (SSID)
have been detected. Confirm network
name (SSID).

The same SSID may be set on several access points. Check the settings on the
access points, and change the SSID.

The Wi-Fi environment needs to be
improved. Turn the wireless router off and
then turn it on. If the connection does not
improve, see the documentation for the
wireless router.

After moving the printer closer to the access point and removing any
obstacles between them, turn the access point on. If it still does not connect,
see the documentation supplied with the access point.

*No more devices can be connected.
Disconnect one of the connected devices if
you want to add another one.

You can simultaneously connect up to four computers and smart devices in
Wi-Fi Direct (Simple AP) connection. To add another computer or smart
device, disconnect one of the connected devices first.

Related Information

= “Connecting to a Computer” on page 23

= “Application for Configuring Printer Operations (Web Config)” on page 146

= “Cannot Connect from Devices Even Though Network Settings are No Problems” on page 171

Printing a Network Status Sheet

You can check the detailed network information by printing it.

1. Load papers.

2. Select Settings on the home screen, and then press the OK button.

3. Select Network Settings, and then press the OK button.

4. Select Network Status, and then press the OK button.

5. Press the € or P> button, then select Print Status Sheet using the A or ¥ button.
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6. Press the < button.

The network status sheet is printed.

Replacing or Adding New Access Points

If the SSID changes due to the replacement of an access point, or an access point is added and a new network
environment is established, re-set the Wi-Fi settings.

Related Information

= “Changing the Connection Method to a Computer” on page 35

Changing the Connection Method to a Computer

Using the installer and re-set up in a different connection method.

[ Setting up from the website
Access the following website, and then enter the product name. Go to Setup, and then start setting up.

http://epson.sn

[ Setting up using the software disc (only for the models that come with a software disc and users with computers
with disc drives.)

Insert the software disc into the computer, and then follow the on-screen instructions.

Selecting Change the Connection Methods

Follow the on-screen instructions until the following screen is displayed.
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Select Change or re-set the connection method on the Select Software Installation screen, and then click Next.

I3 install Navi [XXXXSeries] - b
Start Setup Select Software Installation
- License Agreement . O Re-install the essential software
Select this to re-install software and change the

connection settings.
_» System Check

. O Install application software
Instaliation Select this to install additional Epson printing and scanning

applications.

Connection Setting

F~3 ® Change or re-set the connection method
=~
L

Select this if the network environment has changed because

Additional of replacement of the access point or if you want to change
Instalation or re-set the connection method between the and
computer,
Finish
Setup Complete

Disabling Wi-Fi from the Control Panel

When Wi-Fi is disabled, the Wi-Fi connection is disconnected.
1. Select Settings on the home screen.

2. Select Network Settings.

3. Select Wi-Fi Setup.

4. Select Disable Wi-Fi.

5. Check the message, and then select Yes.

Disconnecting Wi-Fi Direct (Simple AP) connection
from the Control Panel

Note:

When Wi-Fi Direct (Simple AP) connection disabled, all computers and smart devices connected to the printer in Wi-Fi
Direct (Simple AP) connection are disconnected. If you want to disconnect a specific device, disconnect from the device
instead of the printer.

1. Select Settings on the home screen.

2. Select Network Settings.
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3. Select Wi-Fi Setup.
4. Select Wi-Fi Direct Setup.
5. Select Disable Wi-Fi Direct.

6. Check the message, and then select Yes.

Restoring the Network Settings from the Control
Panel

You can restore all network settings to their defaults.
1. Select Settings on the home screen.
2. Select Restore Default Settings > Network Settings.

3. Check the message, and then select Yes.
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Paper Handling Precautions

[d Read the instruction sheets supplied with the paper.

(d Fan and align the edges of the paper before loading. Do not fan or curl photo paper. Doing so may damage the
printable side.

Yo

[ If the paper is curled, flatten it or curl it slightly in the opposite direction before loading. Printing on curled
paper may cause paper jams and smears on the printout.

AN

[d Do not use paper that is wavy, torn, cut, folded, damp, too thick, too thin, or paper that has stickers stuck to it.
Using these types of paper causes paper jams and smears on the printout.

[d Fan and align the edges of the envelopes before loading. When the stacked envelopes are puffed up with air,
press them down to flatten them before loading.

e &

[d Do not use envelopes that are curled or folded. Using these envelopes causes paper jams and smears on the
printout.

[d Do not use envelopes with adhesive surfaces on the flaps or window envelopes.

[d Avoid using envelopes that are too thin, as they may curl during printing.

Related Information

= “Printer Specifications” on page 192
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Available Paper and Capacities

Epson recommends using genuine Epson paper to ensure high-quality printouts.

Genuine Epson Paper

Media Name Size Loading Capacity (Sheets) 2-Sided Borderless
Printing Printing™!
Paper Paper Rear
Cassette 1 Cassette 2 Paper
Feed

Epson Bright White A4 - 802 10 Auto, -
Ink Jet Paper Manual™3
Epson Ultra Glossy A3 - - 5 - v
Photo Paper

A4 - 20 5

10x15 cm (4%6 in.), 20 20 5

13x18 cm (5%7 in.)
Epson Premium A3 - - 5 - v
Glossy Photo Paper

A4 - 20 5

10x15 cm (4%6 in.), 20 20 5

13%18 cm (5%7 in.)

16:9 wide size

(102%181 mm)
Epson Premium A3 - - 5 - v
Semigloss Photo
Paper A4 - 20 5

10x15 cm (4x6 in.) 20 20 5

13%x18 cm (5%7 in.)
Epson Photo Paper A3 - - 5 - v
Glossy

A4 - 20 5

10x15 cm (4%6 in.), 20 20 5

13x18 cm (5%7 in.)
Epson Matte Paper- A3 - - 5 - v
Heavyweight

A4 - 20 5
Epson Double- A4 - 1 1 Manual™3 4
Sided Matte Paper
Epson Photo A3 - - 5 - -
Quiality Ink Jet
Paper A4 - 80 5
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Media Name Size Loading Capacity (Sheets) 2-Sided Borderless
Printing Printing™!
Paper Paper Rear
Cassette 1 Cassette 2 Paper
Feed

Epson Iron-On Cool A4 - 1 1 - -
Peel Transfer
Paper

*1  Borderless printing is not available for 2-sided printing.
*2  For manual 2-sided printing, you can load up to 30 sheets for paper with one side already printed.
*3  Only rear paper feed is available.

*4  Only printing from computer is available.

Note:
The availability of paper varies by location. For the latest information on paper available in your area, contact Epson
support.

Commercially Available Paper

Media Name Size Loading Capacity (Sheets) 2-Sided Borderless
Printing Printing
Paper Paper Rear
Cassette 1 Cassette 2 Paper
Feed
Copy paper A3,B4"2, 8K (270 x - - 10 - -
*2
Plain paper™! 390 mm)
Letter'2, A4, B5 ™2, - Up to the 10 Auto,
16K (195 x 270 line Manual™
mm)*2 indicated
by the
triangle
symbol on
the edge
guide.3
A5 - Up to the 10 Manual™
line
indicated
by the
triangle
symbol on
the edge
guide.3
Legal *2,8.5x 13 - 1 10" Manual™
in*2
AG™2 20 20 10 Manual™
User Defined™? - 176 1 Manual™
Envelope™ Envelope #10, - 10 5 - -
Envelope DL,
Envelope C6
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*1  Use the rear paper feed to load pre-punched paper.

*2  Only printing from computer or smart device is available.

*3  For manual 2-sided printing, you can load up to 30 sheets for paper with one side already printed.

*4  Only rear paper feed is available.

*5  For manual 2-sided printing, you can load 1 sheet for paper with one side already printed.

*6  Use the rear paper feed to load paper longer than A4 size.

Related Information

= “Part Names and Functions” on page 16

= “Technical Support Web Site” on page 204

List of Paper Types

To obtain optimum printing results, select the paper type that suits the paper.

Media Name

Media Type

Control Panel

Printer Driver, Smart device 2

Epson Bright White Ink Jet Paper™ plain papers plain papers
Epson Ultra Glossy Photo Paper™! Ultra Glossy Epson Ultra Glossy
Epson Premium Glossy Photo Paper”" Prem. Glossy Epson Premium Glossy

Epson Premium Semigloss Photo Paper™!

Prem. Semigloss

Epson Premium Semigloss

Epson Photo Paper Glossy™

Glossy

Photo Paper Glossy

Epson Matte Paper-Heavyweight™!

Epson Double-Sided Matte Paper™!

Matte

Epson Matte

Epson Photo Quality Ink Jet Paper™!

Photo Quality 1J

Epson Photo Quality Ink Jet

Epson Iron-On Cool Peel Transfer Paper plain papers™3 plain papers
Plain paper”’ plain papers plain papers
Envelope Envelope™ Envelope

*1  These paper types are compatible with Exif Print and PRINT Image Matching when printing from the printer driver. For more
details, see the documentation provided with the Exif Print or PRINT Image Matching compatible digital camera.

*2  For smart devices, these media types can be selected when printing using Epson iPrint.

*3  Only for registering the paper information when loading the paper. Printing from the control panel is not available.
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Paper Source Features

This printer has three paper sources. Load paper of the appropriate size and type to suit your printing needs.

(1) Rear paper feed [ You can load multiple sheets of all types of supported paper.
(1 You can also load pre-punched paper which cannot be loaded in the paper
cassette.
(2] Paper cassette 1 d You can load multiple sheets of small size photo paper.

[ If you load the same paper in paper cassette 1 and paper cassette 2 and
select Cassette 1>Cassette 2 as the Paper Source setting in the print
settings, the printer automatically feeds paper from paper cassette 2 when
paper runs out in paper cassette 1.

(3) Paper cassette 2 We recommend loading A4 size plain paper as this is used frequently.

Loading Paper in the Paper Cassette 1

1. Raise the control panel.

| L §

C
S

e
—

2. When the output tray is ejected, check that there is no paper on the tray, and then close it by pushing it with
your hand.
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3. Open the front cover.

4. Check that the printer is not operating, and then pull out paper cassette 1. Paper cassette 1 has an alignment

mark ;} that allows you to locate it easily.

n Important:

If paper cassette 1 is too far inside the printer, turn the printer off and on again.

5. Slide the edge guides to their maximum position.

6. Slide the front edge guide to the paper size you want to use.

KG / 4x6”
10x15¢cm

2L/ 5x7”
13x18cm
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7. With the printable side facing down, load paper against the front edge guide.

AP

n Important:

0 Make sure the paper does not extend beyond the triangle symbol at the end of the cassette.

[ Do not load more than the maximum number of sheets specified for the paper. Do not load paper above the
line indicated by the triangle symbol on the edge guide.

O

1 Do not load different types of paper in the cassette.

8. Slide the right edge guide to the edge of the paper.

QL
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11.

Loading Paper

Insert paper cassette 1. Line up the alignment marks on the printer and the tray.

Check the paper size and paper type settings displayed on the control panel. To use the settings, select
Confirm using the A or ¥ button, press the OK button, and then go to step 12. To change the settings, select
Change using the A or ¥ button, press the OK button, and then go to the next step.

Note:
(1 When the Paper Setting Alert feature in the Guide Functions menu is enabled, a message is displayed if the
registered paper size and paper type settings differ from the print settings.

o

Paper in Cassette 1

does not match your print
settings.

|OK|Proceed

(A The paper setting screen is not displayed if you have disabled Paper Configuration in the following menus. Go to
step 12. In this situation, you cannot print from an iPhone or iPad using AirPrint.

Settings > Printer Setup > Paper Source Setting > Paper Configuration

On the paper size setting screen, select the paper size using the A or ¥ button, and then press the OK button.
On the paper type setting screen, select the paper type in the same way, and then press the OK button. Check
the settings, and then press the OK button.

Note:
You can also display the paper size and paper type settings screen by selecting the paper source in the following menus.

Settings > Printer Setup > Paper Source Setting > Paper Setup
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12. Slide out the output tray.

Related Information

= “Paper Handling Precautions” on page 38

= “Available Paper and Capacities” on page 39

= “Menu Options for Printer Setup” on page 140

= “Menu Options for Guide Functions” on page 144

Loading Paper in the Paper Cassette 2

1. Raise the control panel.

2. When the output tray is ejected, check that there is no paper on the tray, and then close it by pushing it with
your hand.

3. Open the front cover.
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4. Check that the printer is not operating, and then pull out paper cassette 2.

5.

6. Slide the front edge guide to the paper size you want to use.

4 )
LTR } t ‘
A4
\ f—ﬁ
\\ _J

7. With the printable side facing down, load paper against the front edge guide.
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n Important:

[ Make sure the paper does not extend beyond the triangle symbol at the end of the cassette.

A Do not load more than the maximum number of sheets specified for the paper. For plain paper, do not load
above the line indicated by the triangle symbol on the edge guide.

A Do not load different types of paper in the cassette.

[d Envelopes
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8. Slide the right edge guide to the edge of the paper.

-

9. Insert paper cassette 2.

10. Check the paper size and paper type settings displayed on the control panel. To use the settings, select
Confirm using the A or ¥ button, press the OK button, and then go to step 12. To change the settings, select
Change using the A or ¥ button, press the OK button, and then go to the next step.

Note:
(A When the Paper Setting Alert feature in the Guide Functions menu is enabled, a message is displayed if the
registered paper size and paper type settings differ from the print settings.

i

Paper in Cassette 2

does not match your print
settings.

|OK|Proceed

(A The paper setting screen is not displayed if you have disabled Paper Configuration in the following menu. Go to step
12. In this situation, you cannot print from an iPhone or iPad using AirPrint.

Settings > Printer Setup > Paper Source Setting > Paper Configuration
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11. On the paper size setting screen, select the paper size using the A or ¥ button, and then press the OK button.
On the paper type setting screen, select the paper type in the same way, and then press the OK button. Check
the settings, and then press the OK button.

Note:
You can also display the paper size and paper type settings screen by selecting the paper source in the following menus.

Settings > Printer Setup > Paper Source Setting > Paper Setup

12. Slide out the output tray.

>,

Related Information

= “Paper Handling Precautions” on page 38

= “Available Paper and Capacities” on page 39

= “Menu Options for Printer Setup” on page 140

= “Menu Options for Guide Functions” on page 144

Loading Paper in the Rear Paper Feed

1. Open the feeder guard.

=
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2. Extend the paper support, and then tilt it backwards.

o )

3. Slide the edge guides.

n Important:

Do not load more than the maximum number of sheets specified for the paper.
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(d Envelope

Note:
[d Load a single sheet with binding holes at the left or right.

[ Adjust the print position of your file to avoid printing over the holes.

Slide the edge guides to the edges of the paper.
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6. Check the paper size and paper type settings displayed on the control panel. To use the settings, select
Confirm using the A or ¥ button, press the OK button, and then go to step 8. To change the settings, select
Change using the A or ¥ button, press the OK button, and then go to the next step.

Note:
(A When the Paper Setting Alert feature in the Guide Functions menu is enabled, a message is displayed if the
registered paper size and paper type settings differ from the print settings.

(1 The paper setting screen is not displayed if you have disabled Paper Configuration in the following menus. Go to
step 8. In this situation, you cannot print from an iPhone or iPad using AirPrint.

Settings > Printer Setup > Paper Source Setting > Paper Configuration

7. On the paper size setting screen, select the paper size using the A or ¥ button, and then press the OK button.
On the paper type setting screen, select the paper type in the same way, and then press the OK button. Check
the settings, and then press the OK button.

Note:
You can also display the paper size and paper type settings screen by selecting the paper source in the following menus.

Settings > Printer Setup > Paper Source Setting > Paper Setup

8. Slide out the output tray.

>

A
Note:

Return the remaining paper to its package. If you leave it in the printer, the paper may curl or the print quality may
decline.

Related Information
= “Paper Handling Precautions” on page 38
= “Available Paper and Capacities” on page 39
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Placing Originals

Placing Originals on the Scanner Glass

g Important:

When placing bulky originals such as books, prevent exterior light from shining directly onto the scanner glass.

1. Open the document cover.

2. Remove any dust or stains on the scanner glass.

3. Place the original face-down and slide it to the corner mark.

Note:
A range of 1.5 mm from the edges of the scanner glass is not scanned.

4. Close the cover gently.

n Important:

Do not apply too much force to the scanner glass or the document cover. Otherwise, they may be damaged.

5. Remove the originals after scanning.

Note:
If you leave the originals on the scanner glass for a long time, they may stick to the surface of the glass.
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How to Place Various Originals

Placing Photos for Copying

You can place multiple photos at a time to make separate copies. The photos should be larger than 30x40 mm.
Place a photo 5 mm away from the corner mark of the scanner glass, and leave 5mm between photos. You can
place photos of different sizes at the same time.

When Placing Two Photos

Maximum size: 13x18 cm (5%7 in.)

When Placing Three Photos

Maximum size: 13x18 cm (5%7 in.)

Placing an ID Card for Copying

Place an ID card 5 mm away from the corner mark of the scanner glass.

\ ] \ ]
=) L
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Placing a CD/DVD for Copying Labels

Place a CD/DVD in the center of the scanner glass. If the CD/DVD is not placed exactly in the center, the
positioning is automatically adjusted.

Placing Multiple Photos for Scanning at the Same Time

You can scan multiple photos at the same time and save each image in Photo Mode in Epson Scan 2 when you
select Thumbnail from the list at the top of the preview window. Place the photos 4.5 mm away from the
horizontal and vertical edges of the scanner glass, and place them at least 20 mm apart from each other. The photos
should be larger than 15x15 mm.

4.5mm
(0.2"
N le—
15mm
(0.6")
20mm
(0.8")
15mm S
(0.6")
T |
4.5mm
(0.2
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Inserting a Memory Card

Supported Memory Cards

miniSD”

miniSDHC*
microSD*

microSDHC”

microSDXC”

SD
SDHC
SDXC

*  Attach an adapter to fit the memory card slot. Otherwise, the card may get stuck.

Related Information

= “Supported Memory Card Specifications” on page 196

Inserting and Removing a Memory Card

1. Inserta memory card into the printer.

The printer starts reading the data and the light flashes. When reading is complete, the light stops flashing and
remains on.
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n Important:

A Insert a memory card straight into the printer.

A The card should not be fully inserted. Do not try to force it all the way into the slot.

AN é /

m —->

AN é /

2. When you have finished using the memory card, make sure the light is not flashing, and then remove the card.

S s

n Important:

If you remove the memory card while the light is flashing, the data in the memory card may be lost.

Note:

If you access the memory card from a computer, you need to operate the computer to safely remove the removable
device.

Related Information

= “Accessing a Memory Card From a Computer” on page 203
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Loading a CD/DVD for Printing

Printable CD/DVDs

You can print on a circular 12-cm CD/DVD labelled as suitable for printing, for example "printable on the label
surface" or "printable with ink jet printers."

You can also print on Blu-ray Discs™.

CD/DVD Handling Precautions

[J See the documentation provided with your CD/DVD for more information on handling the CD/DVD or
writing data.

4 Do not print on the CD/DVD before writing your data to it. If you do, fingerprints, dirt, or scratches on the
surface may cause errors while writing data.

(d Depending on the CD/DVD type or printing data, smearing may occur. Try making a test print on a spare CD/
DVD. Check the printed surface after waiting for one full day.

(d Compared to printing on genuine Epson paper, the print density is lowered to prevent ink from smearing on the
CD/DVD. Adjust the print density as necessary.

(d Allow the printed CD/DVDs at least 24 hours to dry avoiding direct sunlight. Do not stack or insert the CD/
DVDs into your device until they are completely dry.

[ If the printed surface is sticky even after it has dried, lower the print density.
[d Reprinting on the same CD/DVD may not improve the print quality.

(d If the CD/DVD tray or the internal transparent compartment are accidentally printed on, immediately wipe oft
the ink.

(d Depending on the print area setting, the CD/DVD or CD/DVD tray may get dirty. Make settings to print on the
printable area.

[d You can set the print range for the CD/DVD to a minimum of 18 mm for the inner diameter, and a maximum
of 120 mm for the outer diameter. Depending on the settings, the CD/DVD or tray may be smeared. Set within
the print range for the CD/DVD you want to print.

Related Information
= “Printable Area for CD/DVD” on page 193

Loading and Removing a CD/DVD

When printing on or copying a CD/DVD, instructions are displayed on the control panel informing you when to
load the CD/DVD. Follow the on-screen instructions.

Related Information
= “Printing Photos from a Memory Card onto a CD/DVD Label” on page 62
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= “Copying on a CD/DVD Label” on page 103
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Printing

Printing from the Control Panel

Printing Photos by Selecting from a Memory Card

1.

Load paper in the printer.

Insert a memory card into the printer.

g Important:

Do not remove the memory card until you have finished printing.

Note:
[d Remove the memory card when printing from an external storage device such as a hard disk or USB flash memory.

[ Ifyou have 1000 or more photos on your memory card, photos are automatically divided into groups containing a
maximum of 999 photos and the Select Group screen is displayed. Select a group containing the photos you want to
print.

Enter Print Photos from the home screen using the or P button, and then press the OK button.

Select a photo using the @ or P> button and set the number of copies using the - or + button. When printing
more than one photo, repeat this procedure.

Note:

The following menus, that are displayed by pressing the ¥ button, help you select photos easily when you have many
photos on your memory card.

[ Browse: Use the Browse by Date menu to sort photos by date, and then select all photos of the same date at the same
time.

[ Display Mode: Use the 9-up menu to display nine photos on a screen.

Press the ¥ button to display the menu, select Print Settings using the A or ¥ button, and then press the OK
button.

Note:
Select Crop/Zoom if you want to crop a part of a photo. Use the &, ¥, 4, or W button to move the frame to the area

you want to crop, and then press the - or + button to change the size of the frame. Press the 1 button to rotate the
frame.

Use the A or ¥ button to select setting items such as the paper size and the paper type, and change the
settings using the € or P> button.

Press the < button.
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Related Information

= “Loading Paper in the Paper Cassette 2” on page 46

= “Loading Paper in the Paper Cassette 2” on page 46

= “Loading Paper in the Rear Paper Feed” on page 50

= “List of Paper Types” on page 41

= “Inserting a Memory Card” on page 57

= “Menu Options for Printing from the Control Panel” on page 71

Printing Photos from a Memory Card onto a CD/DVD Label

You can select photos stored on a memory card to print onto a CD/DVD label.

g Important:

[ Before printing on the CD/DVD, see the CD/DVD handling precautions.
1 Do not insert the CD/DVD tray while the printer is operating. This may damage the printer.

1 Do not insert the CD/DVD tray until you are instructed to do so. Otherwise, an error occurs and the CD/DVD is
ejected.

1. Inserta memory card into the printer.

g Important:

Do not remove the memory card until you have finished printing.

2. Press the @ button, select Print on CD/DVD using the A or V button, and then press the OK button.

3. Select the layout using the € or P> button, and then press the OK button.
You can select CD/DVD 1-up, CD/DVD 4-up or CD/DVD Variety.

4. Do one of the following.
[ When you select CD/DVD 1-up or CD/DVD Variety, check the screen, and then press the OK button.

1 When you select CD/DVD 4-up, select Automatic Layout or Place Photos Manually using the & or ¥
button, and then press the OK button.

5. Do one of the following.
(4 When you select CD/DVD 1-up, CD/DVD Variety or Automatic Layout for CD/DVD 4-up, select the

photos you want to print using the € or P> button, set the number of copies using the — or + button, and
then press the OK button.
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[d When you select Place Photos Manually for CD/DVD 4-up, after displaying the photo you want to print
using the € or P> button, select Place this photo using the A or ¥ button, and then press the OK button.

If you want to leave a blank space, select Leave Blank using the A or ¥ button, and then press the OK
button.

Note:

(A The available number of copies is displayed at the top of the screen where you select the photos you want to print and
the number of copies. You can select photos until 0 is indicated.

Q Press the ¥ button, and then select Crop/Zoom using the & or ¥ button if you want to crop a part of the photo.

Use the A, 'V, 4, or P button to move the frame to the area you want to crop, and then press the - or + button to
change the size of the frame.

6. Check the screen, and then press the OK button.

7. Set the outer diameter using the or P button, set the inner diameter using the A or V button, and then
press the OK button.

Note:
You can set 114 to 120 mm as the outer diameter, and 18 to 46 mm as the inner diameter in 1 mm increments.

8. Select Print on a CD/DVD using the A or ¥ button and press the OK button.

Note:

For test printing, select Test Print on A4 Paper using the A or V¥ button, and then load A4 plain paper in the paper
cassette. You can check the printout image before printing on a CD/DVD label.

9. A message is displayed on the screen telling you that the printer is getting ready. You are then instructed to
load a CD/DVD. Press the ¥ button to check the instructions and load a CD/DVD.

n Important:

Place a CD/DVD on the CD/DVD tray with the printable side facing up. Press the center of the CD/DVD to
securely set it on the CD/DVD tray. Otherwise, the CD/DVD may fall off the tray. Turn over the tray to check
that the CD/DVD is firmly secured in the tray.

Note:
You may feel slight friction when inserting the tray into the printer. This is normal and you should continue to insert it
horizontally.
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10. Press the OK button, a message is displayed telling you that the printer is ready, and then press the OK button.

11. Press the <> button.

12. When printing has finished, the CD/DVD tray is ejected automatically. Remove the CD/DVD tray from the
printer, and then remove the CD/DVD.

n Important:

After printing is finished, make sure you remove the CD/DVD tray. If you do not remove the tray and turn the
printer on or off, or run head cleaning, the CD/DVD tray will strike the print head and may cause the printer
to malfunction.

13. Store the CD/DVD tray at the bottom of the printer.

Related Information

= “CD/DVD Handling Precautions” on page 59

= “Inserting a Memory Card” on page 57

= “Loading and Removing a CD/DVD” on page 59

= “Menu Options for Printing from the Control Panel” on page 71

Printing Photos from a Memory Card with Handwritten Notes
You can print a photo on a memory card with handwritten text or drawings. This allows you to create original
cards such as New Year's cards or birthday cards.

First select a photo and print a template on plain paper. Write or draw on the template and then scan it with the
printer. You can then print the photo with your own personal notes and drawings.

1. Inserta memory card into the printer.

n Important:

Do not remove the memory card until you have finished printing.

2. Enter More Functions from the home screen using the € or P> button, and then press the OK button.
3. Select Print Photo Greeting Card using the A or ¥ button, and then press the OK button.

4. Select Select Photo and Print Template using A or ¥ button, and then press the OK button.
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Select a photo using the € or P> button, and then press the OK button.

Select the paper type for printing a photo with handwritten notes using the A or ¥ button, and then press the
OK button.

Select the layout using the A or ¥ button, and then press the OK button.

Select the frame using the A or ¥ button, and then press the OK button.

Load A4-size plain paper in the printer, and then pull out the output tray to print a template.

Press the <> button to print a template.
Follow the instructions on the template to write and draw.

Close the output tray by hand. Load photo paper in paper cassette 1, and then pull out the output tray.

Select Print Greeting Cards from Template using the A or ¥ button, and then press the OK button.

Check the screen, place the template on the scanner glass, and then press the OK button.

Note:
Make sure that the text on the template is completely dry before placing it on the scanner glass. If there are stains on the
scanner glass, the stains are also printed on the photo.

Set the number of copies using the — or + button, and then press the <> button.

Related Information

= “Inserting a Memory Card” on page 57

= “Menu Options for Printing from the Control Panel” on page 71

= “Loading Paper in the Paper Cassette 1” on page 42

= “Loading Paper in the Paper Cassette 2” on page 46

= “List of Paper Types” on page 41

= “Placing Originals on the Scanner Glass” on page 54
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Printing Lined Paper, Calendars, Original Writing Paper, and
Original Greeting Cards

You can easily print lined paper, calendars, original writing paper, and original greeting cards using the Personal
Stationery menu.

1. Load paper in the printer.

2. To print writing paper and greeting cards using a photo on your memory card, insert the memory card into
the printer.

3. Enter More Functions from the home screen using the or P button, and then press the OK button.
4. Select Personal Stationery using the A or ¥ button, and then press the OK button.

5. Select a menu item using the A or ¥ button, and then press the OK button.

Note:
When printing greeting cards, you can add an image stored in the printer instead of using a photo on your memory
card. To add an image stored in the printer, select Template Art.

6. Follow the on-screen instructions to print.

Related Information

= “Loading Paper in the Paper Cassette 2” on page 46
= “Loading Paper in the Rear Paper Feed” on page 50
= “List of Paper Types” on page 41

= “Inserting a Memory Card” on page 57

= “Menu Options for Printing Lined Paper, Calendars, Original Writing Paper, and Original Greeting Cards” on
page 67
= “Menu Options for Printing from the Control Panel” on page 71
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Menu Options for Printing Lined Paper, Calendars, Original Writing Paper,
and Original Greeting Cards

Lined Papers:

Prints some types of lined paper, graph paper, or music paper.

Writing Papers:
Prints some types of writing paper with a photo from the memory card set as the background. The

photo is printed lightly so that it can be easily written on.

Calendar:

Prints a weekly or monthly calender. Select the year and the month for the monthly calendar.

Message Card:
Prints a greeting card using images from the printer or images on the memory card.

[d Image Position

Select where you want to place the image on the greeting card.

[ Line Type
Select the type of ruled line to print on the greeting card.

[ Line Color

Select the color of the ruled line to print on the greeting card.

Printing Original Envelopes

You can create original envelopes by adding an image stored in the printer using the Personal Stationery menu.
You can use the same image to print greeting cards that match the envelopes.

First print a diagram of an envelope on A4 size paper, and then fold it to create an envelope.

1. Enter More Functions from the home screen using the € or P> button, and then press the OK button.
2. Select Personal Stationery using the A or ¥ button, and then press the OK button.
3. Select Origami using the A or ¥ button, and then press the OK button.

4. Select Origami Envelope using the A or ¥ button, and then press the OK button.
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5. Select the image you want to print on the envelopes using the € or P> button, and then press the OK button.

A screen indicating the print position of the image, and whether to print fold lines is displayed.

6. To change the image position and the fold line setting, press the ¥ button to display the setting screen and
change the settings.

7. When you have finished making settings, press the 3 button to return to the setting confirmation screen, and
then press the OK button.

8. Select the size of the envelopes using the € or P> button, and then press the OK button.
9. Load A4 plain paper in the printer, and then press the OK button.

10. Pull out the output tray.

11. Set the number of copies using the — or + button, and then press the <> button.

Related Information
= “Loading Paper in the Paper Cassette 2” on page 46
= “Loading Paper in the Rear Paper Feed” on page 50

Folding Envelopes

After printing a diagram of an envelope, print an instruction sheet that shows you how to fold the envelope, and
then lay the instruction sheet on top of the diagram and fold them together.

1. Select Origami Envelope Instruction from the Origami menu, and then press the OK button.

2. Select the envelope size that you selected to print the envelope diagram using the € and P> button, and then
press the OK button.

3. Load A4 plain paper in the printer, and then press the OK button.
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4. Set the number of copies using the — or + button, and then press the <> button.

The following instruction sheet is printed.
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5. Lay the instruction sheet on top of the envelope diagram, and then fold them together following the
instructions on the instruction sheet.

6.  When finished, unfold them and remove the instruction sheet, and then fold only the envelope diagram again
along its creases.

Printing in Various Layouts

You can print the photos on your memory card in various layouts such as 2-up, 4-up, and upper half.

Enter More Functions from the home screen using the or P button, and then press the OK button. Select Photo
Layout Sheet using the A or ¥ button, and then press the OK button. Follow the on-screen instructions to print.

Related Information

= “Menu Options for Printing from the Control Panel” on page 71
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Printing a Coloring Book

You can print pictures by extracting only the outline of photos or illustrations. This allows you to create unique
coloring books.

Note:
Unless they are being used for personal use (at home or other restricted areas), you need permission from the copyright
holder when using copyright protected originals to create a coloring book.

Enter More Functions from the home screen using the or P button, and then press the OK button. Select

Coloring Book using the A or ¥ button, and then press the OK button. Select whether to scan an original or use
a photo on a memory card to print a coloring book, and then follow the on-screen instructions.

Related Information

= “Menu Options for Paper and Print Settings” on page 71

DPOF Printing

This printer is compatible with DPOF (Digital Print Order Format) Ver. 1.10. DPOF is a format that stores
additional information for photos such as the date, time, user name, and printing information. DPOF-compatible
cameras allow you to set which image on a memory card to print and the number of copies. When the memory
card is inserted into the printer, the photos selected by the camera are printed.

Note:
For information on making print settings on your camera, see the documentation provided with your camera.

When you insert a memory card into the printer, a confirmation screen is displayed. Select Yes using the A or ¥
button, and then press the OK button to display the print start screen. Press the <> button to start printing. If you

want to change the print settings, press the ¥ button. Setting items are the same as in Print Photos.
Related Information

= “Printing Photos by Selecting from a Memory Card” on page 61
= “Menu Options for Printing from the Control Panel” on page 71
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Menu Options for Printing from the Control Panel

Menu Options for Selecting Photos

Browse:

[d Browse by Date

Displays the photos on the memory card sorted by date. Select a date to display all photos saved on
that date.

[ Cancel Browse

Cancels sorting photos and displays all the photos.

Select Photos:
[ Select All Photos

Selects all the photos on the memory card and sets the number of prints.

[ Cancel Photo Selection

Returns the number of prints of all photos to 0 (zero).

Display Mode:
A 1-up
Displays one photo on a screen. Information on settings, such as zoom, is also displayed.

[ 1-up without Information

Displays one photo on a screen. Information on settings, such as zoom, is not displayed.
A 9-up

Displays nine photos on a screen.

Menu Options for Paper and Print Settings

Paper Size:

Select the paper size you loaded.

Paper Type:
Select the paper type you loaded.

Paper Source:

Select the paper source that you want to use.

Borderless:
Prints without margins around the edges. The image is enlarged a little to remove borders from the
edges of the paper.

Quality:

Select the print quality. Selecting Best provides higher quality printing, but the printing speed may be
slower.
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Expansion:

With borderless printing, the image is enlarged a little to remove borders from the edges of the paper.
Select how much to enlarge the image.

Date:

Select the format used to print the date on photos for photos that include the date the photos were
taken or the date they were saved. The date is not printed for some layouts.

Print Info. On Photos:
a Off
Prints without any information.
(d Camera Text

Prints text set on the digital camera. For information on the text settings, see the documentation
provided with your camera. The information can only be printed in borderless printing on 10x15
cm, 13x18 cm, or 16:9 wide size.

1 Landmark
Prints the name of the place or landmark where the photo was taken for digital cameras that have
the landmark feature. See the website of the manufacturer of your camera for more details. The
information can only be printed in borderless printing on 10x15 cm, 13x18 cm, or 16:9 wide size.
Fit Frame:

If the aspect ratio of the image data and the paper size is different, the image is automatically enlarged
or reduced so that the short sides match the short sides of the paper. The long side of the image is
cropped if it extends beyond the long side of the paper. This feature may not work for panorama
photos.

Bidirectional:

Prints while the print head moves to the left and to the right. If vertical or horizontal ruled lines on
your printout look blurred or misaligned, disabling this feature may solve the problem; however, doing
so may reduce print speed.

CD Density:
For CD/DVD printing. Set the density to use when printing onto a CD/DVD.

Density:

For coloring book printing. Select the level of density for the outlines on the coloring sheet.

Line Detection:

For coloring book printing. Select the sensitivity used to detect outlines in the photo.

Menu Options for Photo Adjustment and Zoom

Enhance:

Select one of the image adjustment options. Select PhotoEnhance to produce sharper images and more
vivid colors by automatically adjusting the contrast, saturation, and brightness of the original image
data. Select P.I.M. to adjust the image by using your camera's PRINT Image Matching or Exif Print
information.
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Scene Detection:
Available when selecting PhotoEnhance as the Enhance setting. Improves the image quality for photos
of people, landscapes, and night scenes.

Fix Red-Eye:
Fixes red-eye in photos. Corrections are not applied to the original file, only to the printouts.
Depending on the type of photo, parts of the image other than the eyes may be corrected.

Brightness:
Adjusts the brightness of the image.

Contrast:

Adjusts the difference between the brightness and darkness.

Sharpness:

Enhances or defocuses the outline of the image.

Saturation:

Adjusts the vividness of the image.

Filter:

Prints in sepia or monochrome.

Crop/Zoom:
Enlarges a part of the photo to be printed.

Printing from a Computer

Printing Basics - Windows

Note:
(A See the online help for explanations of the setting items. Right-click an item, and then click Help.

(A Operations differ depending on the application. See the application’s help for details.
1. Load paper in the printer.

2. Open the file you want to print.

3. Select Print or Print Setup from the File menu.

4. Select your printer.
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Select Preferences or Properties to access the printer driver window.

= Printing Preferances e

Main  bore Options  Mainterancs

Printing Presets Faper Source Auba w
Add/Refove Presels... Document Size A4 210 x 207 mm 5
= pocurnent - Fast [ earderiess Sattings...
u Docurnent - Standard Quality Orientation () Partraif {Handscape
= Docurnent - High Guality
o
£l Doturnert - 2-Sided Paper Type Plain paper =

Bl ehaoto - 10 x 15 cm Fortrait
= Photo - 10 x 15 cm Landscape Guality Standard w
(2] Printable CO/DVD Frinting

. '
H photo - a4 Postrant Calor %) Color M rmyscake
W Fhoto - 44 Landscape
2-Sided Pricting | Off w
Selings... Frint Density. ..
@ < Muiti-Fage off v Page Order...
w e [ Do
— L a _’; . DRQ\-prp@ Qrdar
| Quiet Mode Off w
Showr Settings [(DFrine presdes
136t Arranger Lite

Reset Defoults Ink Levels

e

Make the following settings.
[d Paper Source: Select the paper source in which you loaded the paper.
d Document Size: Select the paper size you loaded in the printer.

[d Borderless: Select to print with no margins around the image.

In borderless printing, the print data is enlarged slightly more than the paper size so that no margins are
printed around the edges of the paper. Click Settings to select the amount of enlargement.

[J Orientation: Select the orientation you set in the application.
[J Paper Type: Select the type of paper you loaded.
[ Quality: Select the print quality.
Selecting High provides higher quality printing, but the printing speed may be slower.

[d Color: Select Grayscale when you want to print in black or shades of gray.

Note:
When printing on envelopes, select Landscape as the Orientation setting.

Click OK to close the printer driver window.

Click Print.

Related Information

= “Available Paper and Capacities” on page 39

= “Loading Paper in the Paper Cassette 1” on page 42
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= “Loading Paper in the Paper Cassette 2” on page 46
= “Loading Paper in the Rear Paper Feed” on page 50
= “Guide to Windows Printer Driver” on page 149

= “List of Paper Types” on page 41

Printing Basics - Mac OS

Note:

Explanations in the section use TextEdit as an example. Operations and screens differ depending on the application. See the
application’s help for details.

1. Load paper in the printer.

2. Open the file you want to print.

3. Select Print from the File menu or another command to access the print dialog.

If necessary, click Show Details or ¥ to expand the print window.

Printer:  EPSON 00K E
Presets:  Default Sattings E
Capies: |1
Pages: O Al
From: |1 to: |1
Paper Size:  Ad ﬁ 210 by 297 mm

Orientation: T£ Ta

TextEdit hj

Print header and footer
Rewrap contents to fit page

Cancel w

4. Make the following settings.
[ Printer: Select your printer.
[ Presets: Select when you want to use the registered settings.

[J Paper Size: Select the paper size you loaded in the printer.

When printing with no margins, select a "borderless” paper size.

[d Orientation: Select the orientation you set in the application.
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Note:
(A If the above setting menus are not displayed, close the print window, select Page Setup from the File menu, and then
make settings.

[ When printing on envelopes, select landscape orientation.

5. Select Print Settings from the pop-up menu.

Printer: | EPSON XXX

ol o

Presets: | Default Settings

Copies: 1
Pages: O Al
From: |1 to: 1
Paper Size: | AB 108 by 148 mm

Orientation: l *; ‘l-‘

Print Settings E

Paper Source:  Cassette 2

Media Type: plain papers

2] 2l <

Print Quality: Normal

L ]

Expansion: | Max

Grayscale

Mirror Image

Cancel m

Note:
On OS X Mountain Lion or later, if the Print Settings menu is not displayed, the Epson printer driver has not been
installed correctly.

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), remove the
printer, and then add the printer again. Access the following website, and then enter the product name. Go to Support,
and then see Tips.

http://epson.sn

6. Make the following settings.

[d Paper Source: Select the paper source in which you loaded the paper.

If you enable the Automatic Cassette Switching function, the printer automatically feeds paper from paper
cassette 2 when paper runs out in paper cassette 1. Load the same paper (type and size) in paper cassette 1
and paper cassette 2.

To enable the Automatic Cassette Switching function, select System Preferences from the ‘ menu >
Printers & Scanners (or Print & Scan, Print & Fax), and then select the printer. Make settings on the
screen displayed by clicking Options & Supplies > Options (or Driver).

[d Media Type: Select the type of paper you loaded.
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[ Print Quality: Select the print quality.
Selecting Fine provides higher quality printing, but the printing speed may be slower.

[d Expansion: Available when selecting a borderless paper size.

In borderless printing, the print data is enlarged slightly more than the paper size so that no margins are
printed around the edges of the paper. Select the amount of enlargement.

[d Grayscale: Select to print in black or shades of gray.

7. Click Print.

Related Information

= “Available Paper and Capacities” on page 39

= “Loading Paper in the Paper Cassette 1” on page 42
= “Loading Paper in the Paper Cassette 2” on page 46
= “Loading Paper in the Rear Paper Feed” on page 50
= “Guide to Mac OS Printer Driver” on page 152

= “List of Paper Types” on page 41

Printing on 2-Sides

You can use either of the following methods to print on both sides of the paper.
(d Automatic 2-sided printing
[J Manual 2-sided printing (for Windows only)
When the printer has finished printing the first side, flip the paper over to print on the other side.

You can also print a booklet that can be created by folding the printout. (For Windows only)

9

7
N

I
—
/

Note:
[d This feature is not available for borderless printing.

[ If you do not use paper that is suitable for 2-sided printing, the print quality may decline and paper jams may occur.
[d Depending on the paper and the data, ink may bleed through to the other side of the paper.
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Related Information

= “Available Paper and Capacities” on page 39

Printing on 2-Sides - Windows

Note:

A Manual 2-sided printing is available when EPSON Status Monitor 3 is enabled. If EPSON Status Monitor 3 is disabled,
access the printer driver, click Extended Settings on the Maintenance tab, and then select Enable EPSON Status
Monitor 3.

d Manual 2-sided printing may not be available when the printer is accessed over a network or is used as a shared printer.
1. Load paper in the printer.

2. Open the file you want to print.

3. Access the printer driver window.

4. Select Auto (Long-edge binding), Auto (Short-edge binding), Manual (Long-edge binding), or Manual
(Short-edge binding) from 2-Sided Printing on the Main tab.
5. Click Settings, make the appropriate settings, and then click OK.
Note:
To print a folded booklet, select Booklet.
6. Click Print Density, select the document type from Select Document Type, and then click OK.
The printer driver automatically sets the Adjustments options for that document type.

Note:
(A Printing may be slow depending on the combination of options selected for Select Document Type in the Print
Density Adjustment window and for Quality on the Main tab.

(A For manual 2-sided printing, the Print Density Adjustment setting is not available.
7. Set the other items on the Main and More Options tabs as necessary, and then click OK.

8. Click Print.

For manual 2-sided printing, when the first side has finished printing, a pop-up window is displayed on the
computer. Follow the on-screen instructions.

Related Information

= “Loading Paper in the Paper Cassette 1” on page 42
= “Loading Paper in the Paper Cassette 2” on page 46
= “Loading Paper in the Rear Paper Feed” on page 50
= “Printing Basics - Windows” on page 73

Printing on 2-Sides - Mac OS

1. Load paper in the printer.

2. Open the file you want to print.
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3. Access the print dialog.
4. Select Two-sided Printing Settings from the pop-up menu.
5. Select the bindings in Two-sided Printing.

6. Select the type of original in Document Type.

Note:
(A Printing may be slow depending on the Document Type setting.

3 If you are printing high-density data such as photos or graphs, select Text with Photo or Photo as the Document
Type setting. If scuffing occurs or the image bleeds through to the reverse side, adjust the print density and ink drying
time by clicking the arrow mark next to Adjustments.

7. Set the other items as necessary.

8. Click Print.

Related Information

= “Loading Paper in the Paper Cassette 1” on page 42
= “Loading Paper in the Paper Cassette 2” on page 46
= “Loading Paper in the Rear Paper Feed” on page 50
= “Printing Basics - Mac OS” on page 75

Printing Several Pages on One Sheet

You can print two or four pages of data on a single sheet of paper.
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Printing Several Pages on One Sheet - Windows

Note:
This feature is not available for borderless printing.

1. Load paper in the printer.
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Open the file you want to print.

Access the printer driver window.

Select 2-Up or 4-Up as the Multi-Page setting on the Main tab.

Click Page Order, make the appropriate settings, and then click OK to close the window.
Set the other items on the Main and More Options tabs as necessary, and then click OK.

Click Print.

Related Information

= “Loading Paper in the Paper Cassette 1” on page 42

= “Loading Paper in the Paper Cassette 2” on page 46

= “Loading Paper in the Rear Paper Feed” on page 50

= “Printing Basics - Windows” on page 73

Printing Several Pages on One Sheet - Mac OS

1.

Load paper in the printer.

Open the file you want to print.

Access the print dialog.

Select Layout from the pop-up menu.

Set the number of pages in Pages per Sheet, the Layout Direction (page order), and Border.
Set the other items as necessary.

Click Print.

Related Information

= “Loading Paper in the Paper Cassette 1” on page 42

= “Loading Paper in the Paper Cassette 2” on page 46

= “Loading Paper in the Rear Paper Feed” on page 50

= “Printing Basics - Mac OS” on page 75
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Printing to Fit the Paper Size

You can print to fit the paper size you loaded in the printer.
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Printing to Fit the Paper Size - Windows

Note:
This feature is not available for borderless printing.

1. Load paper in the printer.
2. Open the file you want to print.
3. Access the printer driver window.

4. Make the following settings on the More Options tab.
[d Document Size: Select the paper size you set in the application.

(d Output Paper: Select the paper size you loaded in the printer.

Fit to Page is selected automatically.

Note:
If you want to print a reduced image at the center of the page, select Center.

5. Set the other items on the Main and More Options tabs as necessary, and then click OK.
6. Click Print.

Related Information

= “Loading Paper in the Paper Cassette 1” on page 42
= “Loading Paper in the Paper Cassette 2” on page 46
= “Loading Paper in the Rear Paper Feed” on page 50
= “Printing Basics - Windows” on page 73

Printing to Fit the Paper Size - Mac OS

1. Load paper in the printer.
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2. Open the file you want to print.

3. Access the print dialog.

4. Select the size of the paper you set in the application as the Paper Size setting.
5. Select Paper Handling from the pop-up menu.

6. Select Scale to fit paper size.

7. Select the paper size you loaded in the printer as the Destination Paper Size setting.
8. Set the other items as necessary.

9. Click Print.

Related Information

= “Loading Paper in the Paper Cassette 1” on page 42

= “Loading Paper in the Paper Cassette 2” on page 46

= “Loading Paper in the Rear Paper Feed” on page 50
= “Printing Basics - Mac OS” on page 75

Printing Multiple Files Together (for Windows Only)

Job Arranger Lite allows you to combine several files created by different applications and print them as a single
print job. You can specify the print settings for combined files, such as layout, print order, and orientation.
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1. Load paper in the printer.

2. Open the file you want to print.

3. Access the printer driver window.

4. Select Job Arranger Lite on the Main tab.

5. Click OK to close the printer driver window.

6. Click Print.
The Job Arranger Lite window is displayed and the print job is added to the Print Project.

82



User's Guide

Printing

7.  With the Job Arranger Lite window opened, open the file that you want to combine with the current file, and
then repeat steps 3 to 6.

Note:
A If you close the Job Arranger Lite window, the unsaved Print Project is deleted. To print later, select Save from the
File menu.

[ To open a Print Project saved in Job Arranger Lite, click Job Arranger Lite on the printer driver's Maintenance

tab. Next, select Open from the File menu to select the file. The extension of the saved files is "ecl".

8. Select the Layout and Edit menus in Job Arranger Lite to edit the Print Project as necessary. See the help of
Job Arranger Lite for details.

9. Select Print from the File menu.

Related Information

= “Loading Paper in the Paper Cassette 1” on page 42
= “Loading Paper in the Paper Cassette 2” on page 46
= “Loading Paper in the Rear Paper Feed” on page 50
= “Printing Basics - Windows” on page 73

Printing One Image on Multiple Sheets to Create a Poster (for
Windows Only)

This feature allows you to print one image on multiple sheets of paper. You can create a larger poster by taping
them together.

»::q

This feature is not available for borderless printing.
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&

1. Load paper in the printer.

2. Open the file you want to print.

3. Access the printer driver window.

4. Select 2x1 Poster, 2x2 Poster, 3x3 Poster, or 4x4 Poster from Multi-Page on the Main tab.

5. Click Settings, make the appropriate settings, and then click OK.

Note:
Print Cutting Guides allows you to print a cutting guide.
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6. Set the other items on the Main and More Options tabs as necessary, and then click OK.

7. Click Print.

Related Information

= “Loading Paper in the Paper Cassette 1” on page 42
= “Loading Paper in the Paper Cassette 2” on page 46
= “Loading Paper in the Rear Paper Feed” on page 50
= “Printing Basics - Windows” on page 73

Making Posters Using Overlapping Alignment Marks

Here is an example of how to make a poster when 2x2 Poster is selected, and Overlapping Alignment Marks is
selected in Print Cutting Guides.

sheet1I <:> lsheet2

—>

sheet 3 sheet 4
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1. Prepare Sheet 1 and Sheet 2. Cut off the margins of Sheet 1 along the vertical blue line through the center of
the top and bottom cross marks.
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2. Place the edge of Sheet 1 on top of Sheet 2 and align the cross marks, then temporarily tape the two sheets
together from the back.
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3. Cut the taped sheets in two along the vertical red line through the alignment markers (this time, the line to the
left of the cross marks).

\

\

s

ooy
N
¥

=
¥ sheet1

[ [>:] g R [

sheet2 K ¥ sheet1 sheet2 K

') g d B ')

4. Tape the sheets together from the back.
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5. Repeat steps 1 to 4 to tape Sheet 3 and Sheet 4 together.
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6. Cut off the margins of Sheet 1 and Sheet 2 along the horizontal blue line through the center of the left and right
side cross marks.
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7. Place the edge of Sheet 1 and Sheet 2 on top of Sheet 3 and Sheet 4 and align the cross marks, and then
temporarily tape them together from the back.
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8. Cut the taped sheets in two along the horizontal red line through the alignment markers (this time, the line
above the cross marks).
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9. Tape the sheets together from the back.
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10. Cut off the remaining margins along the outer guide.
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Printing Using Advanced Features

This section introduces a variety of additional layout and printing features available on the printer driver.

Related Information
= “Windows Printer Driver” on page 148
= “Mac OS Printer Driver” on page 151

Adding a Printing Preset to Print Easily

If you create your own preset of frequently used print settings on the printer driver, you can print easily by
selecting the preset from the list.
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Windows

To add your own preset, set items such as the Document Size and Paper Type on the Main or More Options tab,
and then click Add/Remove Presets in Printing Presets.

Note:
To delete an added preset, click Add/Remove Presets, select the preset name you want to delete from the list, and then delete
it.

Mac OS

Access the print dialog. To add your own preset, set items such as the Paper Size and Media Type, and then save
the current settings as the preset in the Presets setting.

Note:
To delete an added preset, click Presets > Show Presets, select the preset name you want to delete from the list, and then
delete it.

Printing a Reduced or Enlarged Document

You can reduce or enlarge the size of a document by a specific percentage.

Windows
Note:

This feature is not available for borderless printing.

Set the Document Size on the More Options tab. Select Reduce/Enlarge Document, Zoom to, and then enter a
percentage.

Mac OS
Note:
Operations differ depending on the application. See the application’s help for details.

Select Page Setup (or Print) from the File menu. Select the printer from Format For, select the paper size, and
then enter a percentage in Scale. Close the window, and then print following the basic printing instructions.

Adjusting the Print Color

You can adjust the colors used in the print job.

PhotoEnhance produces sharper images and more vivid colors by automatically adjusting the contrast, saturation,
and brightness of the original image data.

Note:
(A These adjustments are not applied to the original data.

[d PhotoEnhance adjusts the color by analyzing the location of the subject. Therefore, if you have changed the location of
the subject by reducing, enlarging, cropping, or rotating the image, the color may change unexpectedly. Selecting the
borderless setting also changes the location of the subject resulting in changes in color. If the image is out of focus, the tone
may be unnatural. If the color is changed or becomes unnatural, print in a mode other than PhotoEnhance.

Windows

Select the method of color correction from Color Correction on the More Options tab.
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If you select Automatic, the colors are automatically adjusted to match the paper type and print quality settings. If
you select Custom and click Advanced, you can make your own settings.

Mac OS

Access the print dialog. Select Color Matching from the pop-up menu, and then select EPSON Color Controls.
Select Color Options from the pop-up menu, and then select one of the available options. Click the arrow next to
Advanced Settings and make the appropriate settings.

Printing a Watermark (for Windows Only)

You can print a watermark such as "Confidential" on your printouts. You can also add your own watermark.

Note:
This feature is not available with borderless printing.

Click Watermark Features on the More Options tab, and then select a watermark. Click Settings to change details
such as the density and position of the watermark.

Printing a Header and Footer (for Windows Only)

You can print information such as a user name and printing date as headers or footers.

Click Watermark Features in the More Options tab, and then select Header/Footer. Click Settings and select
necessary items from the drop-down list.

Printing Photos Using Epson Easy Photo Print
Epson Easy Photo Print lets you lay out and print photos easily on various types of paper. See the application's help
for details.

Note:
[d By printing on genuine Epson photo paper, the ink quality is maximized and the printouts are vivid and clear.

[ To perform borderless printing using a commercially available application, make the following settings.

J Create image data to fit the paper size. If a margin setting is available in the application you are using, set the
margin to 0 mm.

(J Enable the borderless printing setting in the printer driver.
Related Information

= “Epson Easy Photo Print” on page 155
= “Installing Applications” on page 159
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Printing a CD/DVD Label with Epson Print CD

Epson Print CD lets you easily create and print an original design CD/DVD label. You can also create and print a
CD/DVD jacket.

You can set the print range for the CD/DVD to a minimum of 18 mm for the inner diameter, and a maximum of
120 mm for the outer diameter. Depending on the settings, the CD/DVD or tray may be smeared. Set within the
print range for the CD/DVD you want to print.

See the application's help for details.

Note:
When printing a CD/DVD label using a commercially available application, make the following settings.

[d For Windows, A4 is automatically selected as the Document Size setting when you select CD/DVD Tray as the Paper
Source setting. Select Portrait as the Orientation setting, and CD/DVD or CD/DVD Premium Surface as the Paper
Type setting.

(4 For Mac OS, select A4 (CD/DVD) as the Paper Size setting. Select portrait as the printing direction, and then select
CD/DVD or CD/DVD Premium Surface as the Media Type on the Print Settings menu.

[d On some applications, you may need to specify the tray type. Select Epson Tray Type 2. The setting name may vary
slightly depending on the application.

Related Information
= “Epson Print CD” on page 156
= “Installing Applications” on page 159

Printing from Smart Devices

Using Epson iPrint

Epson iPrint is an application that allows you to print photos, documents, and web pages from a smart device such
as a smartphone or tablet. You can use local print, printing from a smart device that is connected to the same
wireless network as your printer, or remote print, printing from a remote location over the Internet. To use remote
print, register your printer in the Epson Connect service.

[ -
-E-

EPSON

Related Information

= “Epson Connect Service” on page 146

Installing Epson iPrint

You can install Epson iPrint on your smart device from the following URL or QR code.
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http://ipr.to/a

Printing Using Epson iPrint

Start Epson iPrint from your smart device and select the item you want to use from the home screen.

The following screens are subject to change without notice. The contents may vary depending on the product.

1 2]

seese 7 19:41 2% | seens & 19:41 2% -

Epson iPrint £ Home Photos '— e

35x5in/89x 127 mm

Shopping

Camera
Capture

O

Copy Memory Card

g

Creative Print | More Apps

Documet

Deselect Rotate E'- e

(1) Home screen displayed when the application is started.

(2] Displays information on how to setup the printer and a FAQ.

(3) Displays the screen where you can select the printer and make printer settings. Once you have selected the
printer, you do not need to select it again from the next time.

(4] Select what you want to print such as photos and documents.

(5] Displays the screen to make print settings such as paper size and paper type.

(6] Displays the paper size. When this is displayed as a button, press it to display the paper settings currently
set on the printer.

(7] Displays photos and documents you selected.

(3] Starts printing.
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Note:
To print from the document menu using iPhone, iPad, and iPod touch running iOS, start Epson iPrint after transferring the
document you want to print using the file sharing function in iTunes.

Using Epson Print Enabler

You can wirelessly print your documents, emails, photos, and web pages right from your Android phone or tablet
(Android v4.4 or later). With a few taps, your Android device will discover an Epson printer that is connected to
the same wireless network.

1. Load paper in the printer.

2. Set up your printer for wireless printing.

3. On your Android device, install the Epson Print Enabler plug-in from Google Play.

4. Connect your Android device to the same wireless network as your printer.

5. Go to Settings on your Android device, select Printing, and then enable Epson Print Enabler.

6. From an Android application such as Chrome, tap the menu icon and print whatever is on the screen.

Note:
If you do not see your printer, tap All Printers and select your printer.

Related Information

= “Loading Paper in the Paper Cassette 1” on page 42
= “Loading Paper in the Paper Cassette 2” on page 46
= “Loading Paper in the Rear Paper Feed” on page 50

= “Connecting to a Smart Device” on page 24

Using AirPrint

AirPrint enables instant wireless printing from iPhone, iPad, and iPod touch with the latest version of iOS, and
Mac with the latest version of OS X or macOS.

AirPrint

Note:
If you disabled paper configuration messages on your product control panel, you cannot use AirPrint. See the link below to
enable the messages, if necessary.
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1. Load paper in your product.

2. Set up your product for wireless printing. See the link below.

http://epson.sn
3. Connect your Apple device to the same wireless network that your product is using.

4. Print from your device to your product.

Note:
For details, see the AirPrint page on the Apple website.

Related Information

= “Loading Paper in the Paper Cassette 1” on page 42
= “Loading Paper in the Paper Cassette 2” on page 46
= “Menu Options for Printer Setup” on page 140

Printing from a Digital Camera

Note:
A You can print photos directly from a PictBridge-compatible digital camera. For more details on making operations on
your camera, see the documentation provided with your camera.

A Usually digital camera settings are given priority; however, in the following situations, the printer settings are given
priority.

[ When the camera's print setting is set to "use printer settings"
[ When the Sepia or B&W option is selected in the printer's print settings.

(J When combining the print settings of the camera and the printer produces settings that are not available on
the printer.

[ You can print photos with DPOF settings directly from a camera.

Printing from a Digital Camera Connected by USB Cable

You can print photos directly from a digital camera connected by USB cable.
1. Remove a memory card from the printer.

2. Load paper in the printer.

3. Enter Settings from the home screen using the  or P button, and then press the OK button. Select External
Device Setup using the A or ¥ button, and then press the OK button.

4. Select Print Settings or Photo Adjustments, press the OK button, and then change the settings if necessary.
Select the setting items using the A or ¥ button and change settings using the € or P> button.
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5. Turn on the digital camera, and then connect to the printer using a USB cable.

4 )
5
l%

e

Note:
Use a USB cable that is shorter than two meters.

)

6. Select the photos you want to print from the digital camera, make settings such as the number of copies, and
then start printing.

Related Information

= “Loading Paper in the Paper Cassette 1” on page 42

= “Loading Paper in the Paper Cassette 2” on page 46

= “Loading Paper in the Rear Paper Feed” on page 50

= “Menu Options for Photo Adjustment and Zoom” on page 72
= “Menu Options for Paper and Print Settings” on page 71

Printing from a Digital Camera Connected Wirelessly

You can wirelessly print photos from digital cameras that support the DPS over IP standard (from here on referred
to as PictBridge (wireless LAN)).

1. Make sure the icon that indicates that the printer is connected to a wireless network is displayed on the home
screen.

Note:
You can check the meaning of the icons on the control panel. Select Help on the home screen using the € or W button,

and then press the OK button. Select Icon List using the A or ¥ button, and then press the OK button.

2. Load paper in the printer.

3. Select Settings from the home screen using the € or P> button, and then press the OK button. Select External
Device Setup using the A or ¥ button, and then press the OK button.

4. Select Print Settings or Photo Adjustments, press the OK button, and then change the settings if necessary.
Select the setting items using the A or ¥ button and change settings using the € or P> button.

5. Connect the digital camera to the same network as the printer.
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6. Display the list of available printers on the digital camera, and then select the printer you want to connect to.

Note:
(A To check the printer's name, select Settings > Network Settings > Network Status from the home screen.

A If your digital camera has a function that allows you to register printers, you can connect to the printer by selecting it

from the next time.

7. Select the photos you want to print from the digital camera, make settings such as the number of copies, and
then start printing.

8. Disconnect the PictBridge (wireless LAN) connection to the printer from the digital camera.

g Important:

When using PictBridge (wireless LAN), you cannot use other printer functions or print from other devices.
Disconnect immediately when you have finished printing.

Related Information

= “Loading Paper in the Paper Cassette 1” on page 42

= “Loading Paper in the Paper Cassette 2” on page 46

= “Loading Paper in the Rear Paper Feed” on page 50

= “Menu Options for Photo Adjustment and Zoom” on page 72
= “Menu Options for Paper and Print Settings” on page 71

Canceling Printing

Note:
A In Windows, you cannot cancel a print job from the computer once it has been completely sent to the printer. In this case,
cancel the print job by using the printer's control panel.

(A When printing several pages from Mac OS, you cannot cancel all of the jobs by using the control panel. In this case, cancel
the print job from the computer.

[ Ifyou have sent a print job from Mac OS X v10.6.8 through the network, you may not be able to cancel printing from the
computer. In this case, cancel the print job by using the printer’s control panel.

Canceling Printing - Printer Button

Press the @ button to cancel the print job in progress.

Canceling Printing - Windows

1. Access the printer driver window.
2. Select the Maintenance tab.
3. Click Print Queue.

4. Right-click on the job you want to cancel and then select Cancel.
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Related Information

= “Windows Printer Driver” on page 148

Canceling Printing - Mac OS
1. Click the printer icon in the Dock.
2. Select the job you want to cancel.

3. Cancel the job.
J OS X Mountain Lion or later

Click next to the progress meter.

1 Mac OS X v10.6.8 to v10.7.x
Click Delete.
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Copying Basics

1.

Load paper in the printer.

Place the originals.

Enter Copy from the home screen using the € or P> button, and then press the OK button.

Set the number of copies using the — or + button.
Select color copy or monochrome copy using the € or P> button.

Select Paper and Copy Settings using the ¥ button, and then press the OK button. Check the settings such as
the paper size and the paper type and change the settings if necessary. Select the setting items using the A or
WV button and change the settings using the € or P> button.

Note:

If you want to copy by reducing or enlarging the size of a document by a specific percentage, select Custom Size as the
Reduce/Enlarge setting, and then specify a percentage using the — or + button. You can change the percentage in
increments of 5% by pressing and holding down the - or + button.

Press the < button.

Note:
The color, size, and border of the copied image are slightly different from the original.

Related Information

= “Loading Paper in the Paper Cassette 1” on page 42

= “Loading Paper in the Paper Cassette 2” on page 46

= “Loading Paper in the Rear Paper Feed” on page 50

= “Placing Originals on the Scanner Glass” on page 54

= “Menu Options for Copy Mode” on page 99

Menu Options for Copy Mode

Note:
Available menus vary depending on the layout you selected.

The number of copies:

Enter the number of copies.

Color:

Copies the original in color.
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B&W:

Copies the original in black and white (monochrome).

Density:

Increase the level of density by pressing the P> button when the copying results are faint. Decrease the

level of density by pressing the  button when ink smears.

Remove Background:

Detects the paper color (background color) of the original document, and removes or lightens the
color. Depending on the darkness and vividness of the color, it may not be removed or lightened.

2-Sided Copying:
[J 1>1-Sided
Copies one side of an original onto a single side of paper.
[J 1>2-Sided

Copies two single-sided originals onto both sides of a single sheet of paper.

Layout:
[ With Border

Copies with margins around the edges.

[ Borderless

Copies without margins around the edges. The image is enlarged a little to remove margins from the
edges of the paper.

1 A4, 2-up Copy
Copies two A4 single-sided originals onto a single sheet of A4 size paper in 2-up layout.
1 A4, Book/2-up
Copies two A4 facing pages of a book and so on onto a single sheet of A4 size paper in 2-up layout.

[ Book/2-Sided

Copies two separate pages of a book and so on onto both sides of a single sheet of paper. This
settings is only available when 1>2-Sided is selected as the 2-sided copying setting.

Reduce/Enlarge:

Enlarges or reduces the originals.

[ Custom Size

Specifies the magnification used to enlarge or reduce the original within a range of 25 to 400%.

J Actual Size

Copies at 100 % magnification.
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[d Auto Fit Page

Detects the scan area and automatically enlarges or reduces the original to fit to the paper size you
selected. When there are white margins around the original, the white margins from the corner
mark of the scanner glass are detected as the scan area, but the margins at the opposite side may be
cropped.

Hello! | || [ - :

Hello!

J 10x15cm->A4, A4->10x15cm, and so on

Automatically enlarges or reduces the original to fit to a specific paper size.

Paper Size:

Select the paper size you loaded.

Paper Type:
Select the paper type you loaded.

Paper Source:

Select the paper source that you want to use.

Document Type:

Select the type of your original.

Quiality:

Select the print quality. Draft provides faster printing, but the printouts may be faint. Best provides
higher quality printing, but the printing speed may be slower.

For users in Western Europe, the draft mode is not available.

Document Orientation:

Select the orientation of your original.

Binding Margin:

Select the binding position of the copies.

Expansion:

With borderless copying, the image is enlarged a little to remove borders from the edges of the paper.
Select how much to enlarge the image.

Dry Time:

Select the drying time for 2-sided copying. Increase the level of drying time when ink smears.
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Copying Photos

You can copy multiple photos at the same time. You can also restore the colors in faded photos.

Note:
(A The smallest size of original you can copy is 30 x 40 mm.

[ White space around the photo may not be detected.

1.

Load paper in the printer.
Enter More Functions from the home screen using the € or P> button, and then press the OK button.
Select Copy/Restore Photos using the A or ¥ button, and then press the OK button.

Select whether or not to restore the colors in faded photos using the A or ¥ button, and then press the OK
button.

Press the ¥ button to display the instructions on how to place originals, and then place the photos on the
scanner glass.

Press the < button.

The photos are scanned and displayed on the screen.

Select Paper and Copy Settings using the ¥ button, and then press the OK button. Check the settings such as
the paper size and the paper type and change the settings if necessary. Select the setting items using the A or
W button and change the settings using the € or P> button.

Note:
If you want to print by enlarging part of a photo, select Crop/Zoom on the same screen as Paper and Copy Settings,

and then press the OK button. Move the print area frame using the &, ¥, Q or W button, and then change the frame
size using the — or + button.

Press the < button.

Related Information

= “Loading Paper in the Paper Cassette 1” on page 42

= “Loading Paper in the Paper Cassette 2” on page 46

= “Loading Paper in the Rear Paper Feed” on page 50

= “Placing Photos for Copying” on page 55

= “Menu Options for Copy/Restore Photos” on page 102

Menu Options for Copy/Restore Photos

Color Restoration:

Restores the color of faded photos.
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Display Mode:
3 1-up
Displays one photo on a screen. Information on settings, such as zoom, is also displayed.
(d 1-up without Information

Displays one photo on a screen. Information on settings, such as zoom, is not displayed.

Paper and Copy Settings:
[ Paper Size
Select the paper size you loaded.
[ Paper Type
Select the paper type you loaded.
(4 Paper Source
Select the paper source that you want to use.

[ Borderless

To copy without margins around the edges, select Borderless. The image is enlarged a little to
remove margins from the edges of the paper. To copy with margins around the edges, select With
Border.

[d Expansion

With borderless copying, the image is enlarged a little to remove borders from the edges of the paper.
Select how much to enlarge the image.

Photo Adjustments:

Selecting PhotoEnhance produces sharper images and more vivid colors by automatically adjusting the
contrast, saturation, and brightness of the original image data.

Filter:

Copies in monochrome.

Crop/Zoom:
Enlarges a part of the photo to be copied.

Copying on a CD/DVD Label

You can copy a disc label or a square original such as a photo onto a CD/DVD label.

g Important:

1 Before printing on the CD/DVD, see the CD/DVD handling precautions.
1 Do not insert the CD/DVD tray while the printer is operating. This may damage the printer.

1 Do not insert the CD/DVD tray until you are instructed to do so. Otherwise, an error occurs and the CD/DVD is
ejected.

1. Press the © button, select Copy to CD/DVD using A or ¥ button, and then press the OK button.

2. Place the original following the instructions displayed on the screen, and then press the OK button.
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3. Follow the on-screen instructions, set the print area by specifying the outer diameter using the € or P button,

and the inner diameter using the A or ¥ button, and then press the OK button.

Note:
You can set 114 to 120 mm as the outer diameter, and 18 to 46 mm as the inner diameter in 1 mm increments.

4. Select Print on a CD/DVD using the A or ¥ button, and then press the OK button.

Note:

For test printing, select Test Print on A4 Paper using the A or ¥ button, and then load A4 plain paper in the printer.
You can check the printout image before printing on a CD/DVD label.

5. A message is displayed on the screen telling you that the printer is getting ready. You are then instructed to
load a CD/DVD. Press the ¥ button to check the instructions and load a CD/DVD.

g Important:

Place a CD/DVD on the CD/DVD tray with the printable side facing up. Press the center of the CD/DVD to
securely set it on the CD/DVD tray. Otherwise, the CD/DVD may fall off the tray. Turn over the tray to check
that the CD/DVD is firmly secured in the tray.

Note:
You may feel slight friction when inserting the tray into the printer. This is normal and you should continue to insert it
horizontally.

6. Press the OK button, check the final screen for printing preparations, and then press the OK button.
7. Select color copy or monochrome copy using the € or P button.

8. If you want to change the settings such as copy density, select Paper and Copy Settings using the ¥ button.
Select the setting items using the A or ¥ button and change the settings using the € or P> button.

9. Press the < button.
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10. When printing has finished, the CD/DVD tray is ejected automatically. Remove the CD/DVD tray from the
printer, and then remove the CD/DVD.

g Important:

After printing is finished, make sure you remove the CD/DVD tray and store it at the bottom of the printer. If
you do not remove the tray and turn the printer on or off, or run head cleaning, the CD/DVD tray will strike
the print head and may cause the printer to malfunction.

11. Store the CD/DVD tray at the bottom of the printer.

Related Information

= “CD/DVD Handling Precautions” on page 59

= “Placing a CD/DVD for Copying Labels” on page 56
= “Menu Options for Copy to CD/DVD” on page 105

Menu Options for Copy to CD/DVD

Outer, Inner:

Specify the print range. Up to 120 mm for the outer diameter, and a minimum of 18 mm for the inner
diameter can be specified. Depending on the setting, the CD/DVD or CD/DVD tray may get dirty. Set
the range to fit the printable area of your CD/DVD.

Print on a CD/DVD, Test Print on A4 Paper:

Select whether to print on a CD/DVD or make a test print on A4 size plain paper. When you select Test
Print on A4 Paper, you can check the print result before printing on a CD/DVD.

Color:

Copies the original in color.

B&W:

Copies the original in black and white (monochrome).

Density:
Increase the level of density by pressing the P> button when the copying results are faint. Decrease the

level of density by pressing the  button when ink smears.

Document Type:

Select the type of your original.
Quiality:

Select the copy quality when printing a test on A4 size plain paper. Selecting Best provides higher
quality printing, but the printing speed may be slower.
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Scanning

Scanning Using the Control Panel

Scanning to a Memory Card

You can save the scanned image to a memory card.
1. Place the originals.

2. Inserta memory card into the printer.
3. Enter Scan from the home screen using the € or P> button, and then press the OK button.
4. Select Scan to Memory Card using the  or P button, and then press the OK button.

5. Check settings such as the save format, and change them if necessary. Select the setting items using the A or

WV button and change settings using the € or P> button.

6. Press the < button.

Note:
The color, size, and border of the scanned image will not be exactly the same as the original.

Related Information

= “Inserting a Memory Card” on page 57

= “Placing Originals on the Scanner Glass” on page 54
= “Menu Options for Scanning” on page 110

Scanning to the Cloud
You can send scanned images to cloud services using the Scan to Cloud feature. You can also send the scanned

images by email. Before using this feature, make settings using Epson Connect. See the following Epson Connect
portal website for details.

https://www.epsonconnect.com/

http://www.epsonconnect.eu (Europe only)

1. Make sure that you have made settings using Epson Connect.

You need to register destinations to the destination list on the user page.

2. Place the originals.

3. Enter Scan from the home screen using the € or P> button, and then press the OK button.
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4. Select Scan to Cloud using the € or P button, and then press the OK button.
5. Select the destination using the A or ¥ button, and then press the OK button.

6. Check settings such as the save format, and change them if necessary. Select the setting items using the A or

WV button and change settings using the € or P> button.

7. Press the < button.

Note:
The color, size, and border of the scanned image will not be exactly the same as the original.

Related Information
= “Placing Originals on the Scanner Glass” on page 54
= “Menu Options for Scanning” on page 110

Scanning to a Computer

You can save the scanned image to a computer.

g Important:

Make sure you have installed Epson Scan 2 and Epson Event Manager on your computer before using this feature.

1. Place the originals.
2. Enter Scan from the home screen using the or P button, and then press the OK button.

3. Select how to save the scanned image to a computer from the following menus using the € or P> button, and
then press the OK button.

[d Scan to Computer (JPEG): Saves the scanned image in JPEG format.
(d Scan to Computer (PDF): Saves the scanned image in PDF format.

(d Scan to Computer (Email): Starts the email client on your computer, and then automatically attaches it to
an email.

4. Select the computer to which you want to save the scanned images.

Note:
[d You can change the scan settings such as the scanning size, folder to save, or save format, by using Epson Event
Manager.

[ When the printer is connected to a network, you can select the computer to which you want to save the scanned
image. Up to 20 computers can be displayed on the printer's control panel.

[ When the computer to which you want to save the scanned images is detected on the network, the initial 15
characters of the computer name are displayed on the control panel. If you set Network Scan Name
(Alphanumeric) on Epson Event Manager, it is displayed on the control panel.

107



User's Guide

Scanning

5. Press the <> button.

Note:
The color, size, and border of the scanned image will not be exactly the same as the original.

Related Information
= “Placing Originals on the Scanner Glass” on page 54
= “Epson Event Manager” on page 155

Scanning to a Computer (WSD)

Note:
(A This feature is only available for computers running English version of Windows 10/ Windows 8.1/ Windows 8/ Windows 7/
Windows Vista.

3 If you are using Windows 7/ Windows Vista, you need to setup your computer in advance using this feature.

1. Place the originals.
2. Enter Scan from the home screen using the € or P> button, and then press the OK button.

3. Select Scan to Computer (WSD) using the < or P button, and then press the OK button.

4. Select a computer.

5. Press the < button.

Note:
The color, size, and border of the scanned image will not be exactly the same as the original.

Related Information

= “Placing Originals on the Scanner Glass” on page 54

Setting Up a WSD Port

This section explains how to set up a WSD port for Windows 7/Windows Vista.

Note:
For Windows 10/Windows 8.1/Windows 8, the WSD port is set up automatically.

The following is necessary to set up a WSD port.
[d The printer and the computer are connected to the network.

(4 The printer driver is installed on the computer.
1. Turn the printer on.
2. Click start, and then click Network on the computer.

3. Right-click the printer, and then click Install.

Click Continue when the User Account Control screen is displayed.
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Click Uninstall and start again if the Uninstall screen is displayed.

vr‘ » Network » = |“f” Search Network |

Organize »  Install  Search Active Directory  Network and Sharing Center  Add a printer  » g 0 @
=TT TUrNC O T L C v ICC S (I T __{'

I Favorites i

B Desktop g e

8 Downloads

" Recent Places 4 Other Devices (1)
G Libraries d’ s

¥ Documents :

o' Music 4 Printers (5)

=l Pictures

=
™ C [

ompute_l g - Py N TEe
&L Local Disk (C) =

a Local Disk (D:)
‘ : H g
€ Network
— | VICW OCVILE WEopagc
1 o )
o i - sl BS Cresteshortcut B
4 EPSONM “4f e 4% Categories: Printers Properties
d Network location: g sl
Note:

The printer name you set on the network and model name (EPSON XXXXXX (XX-XXXX)) are displayed on the
network screen. You can check the printer's name set on the network from the printer's control panel or by printing a
network status sheet.

4. Click Your device is ready to use.

l "ML Your device is ready to use % |

o~

=l (. 12:00 PM

5. Check the message, and then click Close.

Four device i5 ready o use

WED Scan Dwvica wf Rady b2 uin
WD Primk D wof Ready bz e
EPSO0 NE-ITK Series of ey tn e

6. Open the Devices and Printers screen.
[ Windows 7

Click start > Control Panel > Hardware and Sound (or Hardware) > Devices and Printers.
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[ Windows Vista

Click start > Control Panel > Hardware and Sound > Printers.

7. Check that an icon with the printer's name on the network is displayed.

Select the printer name when using with WSD.

Related Information

= “Printing a Network Status Sheet” on page 34

Menu Options for Scanning

The following options are available on the Scan to Memory Card menu and Scan to Cloud menu.

Format

Select the format in which to save the scanned image.

Color

Select whether to scan in color or in monochrome.

Scan Area

Select the scan area. To crop the white space around the text or image when scanning, select Auto
Cropping. To scan at the maximum area of the scanner glass, select Max Area. Select this setting and
scan again if the edges of the scanned image are cropped when A4 is selected.

Document

Select the type of your original.

Resolution
Select the scanning resolution.
Contrast

Select the contrast of the scanned image. Increase the level of contrast by pressing the P> button and

decrease by pressing the @ button.

Document Orientation

Select the orientation of your original.

Scanning from a Computer

Scanning Using Epson Scan 2

You can scan by using the scanner driver "Epson Scan 2". See the Epson Scan 2 help for an explanation of each
setting item.
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Related Information

= “Epson Scan 2 (Scanner Driver)” on page 154

Scanning Documents (Document Mode)

Using Document Mode in Epson Scan 2, you can scan originals using detailed settings that are suitable for text
documents.

1. Place the originals.
2. Start Epson Scan 2.
3. Select Document Mode from the Mode list.

4. Make the following settings on the Main Settings tab.

& Epson Scan2 — O *
Scanner : | EPSON XXXXX v]

Scan Settings | Mot Selected - |

Mode : | Document Mode v|

Main Settings = Advanced Settings

Document Size : | A4 v|
Image Type : | Color v|
Resolution : | 200 ~ | dpi
HOate © | u= vl
Correct Document Skew : | off w

[ Add or edit pages after scanning

Image Format : | PDF “ |
File Name : [ imgyYYYMMDD_HHMMSSSS.pdf |
Folder : | Documents V|

e o Preview Scan

[d Document Size: Select the size of the original you placed.
[J Image Type: Select the color for saving the scanned image.

[ Resolution: Select the resolution.

Note:
[ The Document Source setting is fixed as Scanner Glass. You cannot change this setting.

1 If you set Add or edit pages after scanning, you can scan additional originals after scanning the original. In
addition, if you set the Image Format as PDF or Multi-TIFF, you can save the scanned images as one file.
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5. Make other scan settings if necessary.

[J You can preview the scanned image by clicking the Preview button. The preview window opens, and the
previewed image is displayed.

[d On the Advanced Settings tab, you can make detailed image adjustment settings that are suitable for text
documents, such as the following.

[ Remove Background: Remove the background of the originals.
(d Text Enhancement: You can make blurred letters in the original clear and sharp.

(J Auto Area Segmentation: You can make letters clear and images smooth when performing black and
white scanning for a document that contains images.

(J Color Enhance: You can enhance the color specified for the scanned image, and then save it in grayscale
or black and white.

(J Brightness: You can adjust the brightness for the scanned image.

[J Contrast: You can adjust the contrast for the scanned image.

[ Gamma: You can adjust the gamma (brightness of the intermediate range) for the scanned image.
(J Threshold: You can adjust the border for monochrome binary (black and white).

(J Unsharp Mask: You can enhance and sharpen the outlines of the image.

[J Descreening: You can remove moiré patterns (web-like shadows) that appear when scanning printed
papers such as a magazine.

(J Edge Fill: You can remove the shadow created around the scanned image.

(d Dual Image Output (Windows Only): You can scan once and save two images with different output
settings at the same time.

Note:
The items may not be available depending on other settings you made.
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6. Set the file saving settings.

& Epson Scan 2 - [m| s
Scanner : | EPSON X000 vl

Scan Settings | Mot Selected - |

Mode : | Document Mode v|

Main Settings = Advanced Settings

Document Source : | Scanner Glass v|
Document Size : | A4 v|
Image Type : | Color v|
Resolution : | 200 ~ | dpi
Rotate: |0° |
Correct Document Skew : | Off v|

[ Add or edit pages after scanning

Image Format | PDF v |
File Name : [ imgyYYYMMDD_HHMMSSSS.pdf |
Folder : | Documents V|
& ™ pr— p—

(J Image Format: Select the save format from the list.

You can make detailed settings for each save format except BITMAP and PNG. Select Options from the list
after selecting the save format.

(d File Name: Confirm the save file name displayed.

You can change settings for the file name by selecting Settings from the list.

[ Folder: Select the save folder for the scanned image from the list.

You can select another folder or create a new folder by selecting Select from the list.
7. Click Scan.

Related Information

= “Placing Originals on the Scanner Glass” on page 54

Scanning Photos or Pictures (Photo Mode)

Using Photo Mode in Epson Scan 2, you can scan originals with wide variety of image adjustment features that are
suitable for photos or pictures.

1. Place the originals.

By placing multiple originals on the scanner glass, you can scan them all at the same time. Make sure there is a
gap of at least 20 mm between the originals.
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2. Start Epson Scan 2.
3. Select Photo Mode from the Mode list.

4. Make the following settings on the Main Settings tab.

[& Epson Scan 2 - O >
Scanner : | EPSON 3000CK v
Scan Settings : | Not Selected v|
Mode : | Photo Mode v|

Main Settings Advanced Settings

Document Source : ‘ Scanner Glass v|

Document Tvoe : | Reflective |

Image Type : ‘ Color v|
Resolution : |300 ~ | dpi

Color Management...

Thumbnail Options...

Image Format : | FDF

File Name : |ingYYYMMDD_HHMMSSSS.pdf V|

Folder : | Documents V|

e a Preview Scan

[J Image Type: Select the color for saving the scanned image.
[d Resolution: Select the resolution.
Note:

The Document Source setting is fixed as Scanner Glass, and the Document Type setting is fixed as Reflective.

(Reflective means originals which are not transparent, for example ordinary papers or photos.) You cannot change these
settings.
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5. Click Preview.

The preview window opens, and the previewed images are displayed as thumbnails.

& Epson Scan 2 - O X

Scanner : | EPSON 30000¢

Sean Settings : | Not Selected

Mode : ‘ Photo Made

Main Settings Advanced Settings

Document Source : | Scanner Glass ~]

Document Type : | Reflective ~ |

Image Type : | Color vl
Resolution : |300 ~| dpi

Thumbnail Options...

Image Format : ‘ BDE

File Name : [ imgyYYMMDD_HHMMSSSS. pdf

Folder : [ pocuments

eo Preview ]‘ Scan

Note:
To preview the entire scanned area, clear the Thumbnail check box at the top of the preview widow.

6. Confirm the preview, and make image adjustment settings on the Advanced Settings tab if necessary.

B Epson Scan 2 - O X

Scanner : | EPSON 30000¢

Scan Settings : | Not Selected

Brightness : ‘ 1 U Cl
Contrast : . I O

Saturation : . I 0 l:l

Unsharp Mask : | off v‘

Color Restoration : | off v‘

Backlight Correction : | off v‘

Descreening : |Dﬂ’ v‘

Dust Removal | off v‘

g e pUE

File Name : - [imgyyyyMMDD_HHMMSSSS. pdf

Folder : [ pocuments

2. == e

115



User's Guide

Scanning

You can adjust the scanned image using detailed settings that are suitable for photos or pictures, such as the
following.

[ Brightness: You can adjust the brightness for the scanned image.

[d Contrast: You can adjust the contrast for the scanned image.

[ Saturation: You can adjust the saturation (color vividness) for the scanned image.

[J Unsharp Mask: You can enhance and sharpen the outlines of the scanned image.

[d Color Restoration: You can correct images that have faded to return them to their original colors.
[J Backlight Correction: You can lighten scanned images that are dark due to backlight.

[d Descreening: You can remove moiré patterns (web-like shadows) that appear when scanning printed papers
such as a magazine.

(d Dust Removal: You can remove dust on the scanned image.

Note:
(A The items may not be available depending on other settings you made.

(A Depending on the original, the scanned image may not be adjusted correctly.
(A When multiple thumbnails are created, you can adjust the image quality for each thumbnail. Depending on the

adjustment items, you can adjust the quality of scanned images all together by selecting multiple thumbnails.

7. Set the file saving settings.

& Epson Scan 2 - O x

Scanner : | EPSON 30000C

Scan Settings : | Not Selected

Mode : | Photo Mode

Main Settings Advanced Settings

Brightness : :‘f I :Cf* l:|
Contrast . I O l:|
Saturation : . I 0 l:|

Unsharp Mask : ‘ off V|

Color Restoration : | Off “]

Backlight Correction : ‘ off vl

Descreening : ‘ off V|

Dust Removal : ‘ off V|

Image Format : ‘ EDE

File Name : \umgWWMMDD,HHMMssss.pdf

Folder : ‘ Documents

LT R [ | - Scan Count : 2

[J Image Format: Select the save format from the list.

You can make detailed settings for each save format except BITMAP and PNG. Select Options from the list
after selecting the save format.

[ File Name: Confirm the save file name displayed.

You can change settings for the file name by selecting Settings from the list.
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[ Folder: Select the save folder for the scanned image from the list.

You can select another folder or create a new folder by selecting Select from the list.
8. Click Scan.
Related Information

= “Placing Originals on the Scanner Glass” on page 54
= “Placing Photos for Copying” on page 55

Scanning from Smart Devices

Epson iPrint is an application that allows you to scan photos and documents from a smart device, such as a
smartphone or tablet, that is connected to the same wireless network as your printer. You can save the scanned
data on a smart device or to Cloud services, send it by email, or print it.

[ -
-E-

EPSON

Installing Epson iPrint

You can install Epson iPrint on your smart device from the following URL or QR code.

http://ipr.to/a

Scanning Using Epson iPrint

Start Epson iPrint from your smart device and select the item you want to use from the home screen.

117


http://ipr.to/a

User's Guide

Scanning

The following screens are subject to change without notice.

Documet Cloud

7 19:41

Epson iPrint

Place an image/documant, and then press the scan
button —

Camera
Capture

Copy Memory Card

g

Creative Print | More Apps

1]
© 00

Home screen displayed when the application is started.

®

Displays information on how to setup the printer and a FAQ.

<]

Displays the screen where you can select the printer and make printer settings. Once you have selected the
printer, you do not need to select it again from the next time.

Displays the scanning screen.

Displays the screen where you can make scan settings such as resolution.

Displays scanned images.

Starts scanning.

Displays the screen where you can save scanned data to a smart device or Cloud services.

Displays the screen where you can send scanned data by email.

e 06 0 o0 | 6 o

Displays the screen where you can print scanned data.
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Refilling Ink and Replacing Maintenance
Boxes

Checking the Status of the Remaining Ink and the
Maintenance Box

To confirm the actual ink remaining, visually check the ink levels in all of the printer's tanks.

Important:

Prolonged use of the printer when the ink level is below the lower line could damage the printer.

You can check the approximate ink levels from the computer, and the approximate service life of the maintenance
box from the control panel or the computer.

Checking the Status of the Maintenance Box - Control Panel

1. Enter Maint. from the home screen using the € or P> button, and then press the OK button.

2. Select Maintenance Box Service Life using the A or ¥ button, and then press the OK button.

Checking the Status of the Remaining Ink and the Maintenance Box
- Windows

1. Access the printer driver window.

2. Click EPSON Status Monitor 3 on the Maintenance tab.

Note:
If EPSON Status Monitor 3 is disabled, click Extended Settings on the Maintenance tab, and then select Enable
EPSON Status Monitor 3.
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Related Information

= “Windows Printer Driver” on page 148

Checking the Status of the Remaining Ink and the Maintenance Box
- Mac OS

1. Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Options & Supplies > Utility > Open Printer Utility.

3. Click EPSON Status Monitor.

Ink Bottle Codes

Epson recommends the use of genuine Epson ink bottles.

The following are the codes for genuine Epson ink bottles.

BK: Black PB: Photo Black C: Cyan M: Magenta Y: Yellow
105 106 106 106 106

For Australia and New Zealand
BK: Black PB: Photo Black C: Cyan M: Magenta Y: Yellow
512 512 512 512 512

g Important:

Epson warranty does not cover damage caused by inks other than those specified, including any genuine Epson ink
not designed for this printer or any third party ink.

Other products not manufactured by Epson may cause damage that is not covered by Epson’s warranties, and under
certain circumstances, may cause erratic printer behavior.

Note:
[ Ink bottle codes may vary by location. For the correct codes in your area, contact Epson support.

[ For users in Europe, visit the following website for information on Epson's ink bottle yields.

http://www.epson.eu/pageyield

Related Information
= “Technical Support Web Site” on page 204
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Ink Bottle Handling Precautions

Read the following instructions before refilling ink.

Handling precautions
[d Use ink bottles with the correct part code for this printer.

(4 This printer requires careful handling of ink. Ink may splatter when the ink tanks are filled or refilled with ink.
If ink gets on your clothes or belongings, it may not come off.

(4 Do not shake too vigorously or squeeze the ink bottles.

(d Once you open an ink bottle, we recommend using it as soon as possible.

[ Store ink bottles at normal room temperature and keep them away from direct sunlight.
[d Epson recommends using the ink bottle before the date printed on the package.

[ Store the ink bottles in the same environment as the printer.

[d When storing or transporting an ink bottle, do not tilt the bottle and do not subject it to impacts or temperature
changes. Otherwise, ink may leak even if the cap on the ink bottle is tightened securely. Be sure to keep the ink
bottle upright when tightening the cap, and take precautions to prevent ink from leaking when transporting the
bottle, for example, putting the bottle in a bag.

[J After bringing an ink bottle inside from a cold storage site, allow it to warm up at room temperature for at least
three hours before using it.

(d Do not open the ink bottle package until you are ready to fill the ink tank. The ink bottle is vacuum packed to
maintain its reliability. If you leave an ink bottle unpacked for a long time before using it, normal printing may
not be possible.

(d Prolonged use of the printer when the ink level is below the lower line could damage the printer. Fill the ink
tank to the upper line while the printer is not operating. To display the correct ink level estimates, reset the ink
level after filling the tank.

[d To ensure you receive premium print quality and to help protect your print head, a variable ink safety reserve
remains in the ink tank when your printer indicates to refill ink. The yields quoted for you do not include this
reserve.

(d For optimum print results do not maintain low ink levels for extended periods of time.
[d Although the ink bottles may contain recycled materials, this does not affect printer function or performance.
[d Specifications and appearance of the ink bottle are subject to change without prior notice for improvement.

d Quoted yields may vary depending on the images that you are printing, the paper type that you are using, the
frequency of your prints and environmental conditions such as temperature.

Ink consumption

(d To maintain optimum print head performance, some ink is consumed from all ink tanks not only during
printing but also during maintenance operation such as print head cleaning.

(d When printing in monochrome or grayscale, color inks instead of black ink may be used depending on the
paper type or print quality settings. This is because a mixture of color inks is used to create black.

(d The ink in the ink bottles supplied with your printer is partly used during initial setup. In order to produce high
quality printouts, the print head in your printer will be fully charged with ink. This one-off process consumes a
quantity of ink and therefore these bottles may print fewer pages compared to subsequent ink bottles.
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Refilling the Ink Tanks

1. Open the scanner unit with the document cover closed.

2. Open the ink tank cover.

A message is displayed prompting you to refill the ink tank to the upper line. Press the OK button.

3. Open the cap of the ink tank.

o
1
1

J )

Qﬂooo

u Important:
Make sure that the color of the ink tank matches the ink color that you want to refill.
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4. While holding the ink bottle upright, turn the cap slowly to remove it.

= r

n Important:

([ Be careful not to spill any ink.

1 Do not touch the top of the ink bottle after removing the cap; otherwise you may be smeared with ink.

5. Position the top of the ink bottle along the slot in front of the filling port, and then stand the bottle slowly to
insert it into the filling port.

g Important:

Do not allow the top of the ink bottle to hit against any objects after removing its cap; otherwise ink may spill.
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6. Insert the top of the ink bottle securely into the filling port of the tank to refill the tank with ink.

Ink pours into the tank just by holding the bottle normally without squeezing. The ink flow stops
automatically when the ink is filled to the upper line.

.

Note:
If the ink does not start flowing into the tank, remove the ink bottle and try reinserting it.

7. When you have finished refilling the ink, remove the ink bottle, and then close the cap of the ink tank securely.

n Important:

Do not leave the ink bottle inserted; otherwise the bottle may be damaged or ink may leak.

Note:
If any ink remains in the ink bottle, tighten the cap and store the bottle upright for later use.

-
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8. Close the ink tank cover firmly.

@\.ﬁ@

9. Close the scanner unit.

10. Select the color of the ink you refilled up to the upper line using the  or P button, and then press the OK
button.

11. Press the < button to reset the ink level.

12. Confirm the message, and then press the OK button.

n Important:

If you continue to use the printer after resetting the ink level without refilling the ink tank to the upper line,
printing may be performed without ink and this may damage the printer. Before you start printing, make sure
you visually check the ink levels in all of the ink tanks.

Related Information

= “Ink Bottle Codes” on page 120

= “Ink Bottle Handling Precautions” on page 121
= “Ink Spilled” on page 191

Maintenance Box Code

Epson recommends the use of a genuine Epson maintenance box.
The following is the code for the genuine Epson maintenance box.

T04D0

n Important:

Once a maintenance box has been installed in a printer it cannot be used with other printers.

Maintenance Box Handling Precautions

Read the following instructions before replacing the maintenance box.
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(d Do not touch the green chip on the side of the maintenance box. Doing so may prevent normal operation and
printing.

[d Do not replace the maintenance box during printing; otherwise, ink may leak.

d Do not remove the maintenance box and its cover except when replacing the maintenance box; otherwise ink
may leak.

(d Do not reuse a maintenance box which has been removed and left detached for a long period. Ink inside the box
will have solidified and no more ink can be absorbed.

(d Keep the maintenance box out of direct sunlight.

[ Do not store the maintenance box in high or freezing temperatures.

Replacing a Maintenance Box

In some print cycles a very small amount of surplus ink may be collected in the maintenance box. To prevent ink
leakage from the maintenance box, the printer is designed to stop printing when the absorbing capacity of the
maintenance box has reached its limit. Whether and how often this is required will vary according to the number
of pages you print, the type of material that you print and the number of cleaning cycles that the printer performs.
Replace the maintenance box when you are promoted to do so. The Epson Status Monitor, your LCD, or lights on
the control panel will advise you when this part needs replacing. The need for replacement of the box does not
mean that your printer has ceased to operate in accordance with its specifications. The Epson warranty does not
cover the cost of this replacement. It is a user-serviceable part.

1. Remove the new maintenance box from its package.

g Important:

Do not touch the green chip on the side of the maintenance box. Doing so may prevent normal operation and
printing.

Note:
A transparent bag for the used maintenance box is provided with the new maintenance box.

2. Loosen the screw with a flat-head screwdriver, and then remove the cover.

4 )
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3. Remove the used maintenance box.

>

g Important:

Do not touch the sections shown in the illustration. Doing so may prevent normal operation and you may get
smeared with ink.

4. Put the used maintenance box in the transparent bag that came with the new maintenance box and seal the
bag shut.

5. Insert the new maintenance box all the way into the printer. Make sure you insert the box in the correct
direction.
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6. Reattach the cover.

7. Check the message, and then press the OK button.
Related Information

= “Maintenance Box Code” on page 125

= “Maintenance Box Handling Precautions” on page 125
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Maintaining the Printer

Checking and Cleaning the Print Head

If the nozzles are clogged, the printouts become faint, there is visible banding, or unexpected colors appear. When
print quality has declined, use the nozzle check feature and check if the nozzles are clogged. If the nozzles are
clogged, clean the print head.

n Important:

A Do not open the scanner unit or turn off the printer during head cleaning. If the head cleaning is incomplete, you
may not be able to print.

(A Because print head cleaning uses some ink, clean the print head only if quality declines.

U

When ink is low, you may not be able to clean the print head. Prepare a new ink bottle.

[ If print quality has not improved after repeating nozzle check and head cleaning three times, wait for at least 12
hours without printing, and then run the nozzle check again and repeat the head cleaning if necessary. We
recommend to turn off the printer. If print quality has still not improved, run Power Cleaning. If it has still not
improved, contact Epson support.

(A To prevent the print head from drying out, do not unplug the printer while the power is on.

Checking and Cleaning the Print Head - Control Panel

1. Load A4-size plain paper in the paper cassette.
2. Enter Maint. from the home screen using the € or P> button, and then press the OK button.

3. Select Nozzle Check using the A or ¥ button, and then press the OK button.
4. Follow the on-screen instructions to print the nozzle check pattern.
5. Examine the printed pattern. If there are broken lines or missing segments as shown in the "NG" pattern, the

print head nozzles may be clogged. Go to the next step. If you cannot see any broken lines or missing segments
as in the following "OK" pattern, the nozzles are not clogged. Print head cleaning is not necessary. Select OK

using the A button.

OK

]

BK C Y

6. Select NG using the ¥ button.
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7. Follow the on-screen instructions to clean the print head.

8. When cleaning is finished, select Check using the A or ¥ button, and then follow the on-screen instructions
to print the nozzle check pattern again. Repeat cleaning and printing the pattern until all lines are printed
completely.

Related Information

= “Loading Paper in the Paper Cassette 2” on page 46

Checking and Cleaning the Print Head - Windows
1. Load A4-size plain paper in the paper cassette.

2. Access the printer driver window.

3. Click Nozzle Check on the Maintenance tab.

4. Follow the on-screen instructions.

Related Information

= “Loading Paper in the Paper Cassette 2” on page 46
= “Windows Printer Driver” on page 148

Checking and Cleaning the Print Head - Mac OS

1. Load A4-size plain paper in the paper cassette.

2. Select System Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

3. Click Options & Supplies > Utility > Open Printer Utility.
4. Click Nozzle Check.
5. Follow the on-screen instructions.

Related Information

= “Loading Paper in the Paper Cassette 2” on page 46

Running Power Cleaning

The Power Cleaning utility allows you to replace all of the ink inside the ink tubes. In the following situations, you
may need to use this feature to improve the print quality.

[d You printed or performed head cleaning when the ink levels were too low to be seen in the ink tank windows.
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[d You performed the nozzle check and head cleaning several times and then waited for at least 12 hours without
printing, but print quality still did not improve.

Before running this feature, read the following instructions.

n Important:
Make sure that there is enough ink in the ink tanks.

Visually check all ink tanks are at least a third full. Low ink levels during Power Cleaning could damage the product.

n Important:

An interval of 12 hours is required between each Power Cleaning.

Normally, a single Power Cleaning should resolve the print quality issue within 12 hours. Therefore, to avoid
unnecessary ink usage, you must wait 12 hours before you try it again.

n Important:

Maintenance box replacement may be required.

Ink will be deposited to the maintenance box. If it becomes full, you must prepare and install a replacement
maintenance box to continue printing.

Note:
When the ink levels or the free space in the maintenance box are insufficient for Power Cleaning, you cannot run this
feature. Even in this case, the levels and the free space for printing may remain.

Running Power Cleaning - Control Panel

Read the instructions for Power Cleaning before running this feature.

1. Turn off the printer, and then press the (D button, OK button, and ¥ button at the same time to display the
confirmation screen.

2. Follow the on-screen instructions to run the Power Cleaning feature.

Note:
If you cannot run this feature, solve the problems that are displayed on the screen. Next, follow this procedure from step
1 to run this feature again.

3. After running this feature, run the nozzle check to make sure the nozzles are not clogged.

Related Information

= “Running Power Cleaning” on page 130

Running Power Cleaning - Windows
1. Access the printer driver window.

2. Click Power Cleaning on the Maintenance tab.
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3. Follow the on-screen instructions.

Note:
If you cannot run this feature, solve the problems that are displayed on the printer's control panel. Next, follow this
procedure from step 1 to run this feature again.

Related Information

= “Windows Printer Driver” on page 148

Running Power Cleaning - Mac OS

1. Select System Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Options & Supplies > Utility > Open Printer Utility.
3. Click Power Cleaning.

4. Follow the on-screen instructions.

Note:
If you cannot run this feature, solve the problems that are displayed on the printer's control panel. Next, follow this
procedure from step 1 to run this feature again.

Aligning the Print Head

If you notice a misalignment of vertical lines or blurred images, align the print head.

Aligning the Print Head - Control Panel

1. Load A4-size plain paper in the paper cassette.
2. Enter Maint. from the home screen using the € or P> button, and then press the OK button.
3. Select Print Head Alignment using the A or ¥ button, and then press the OK button.

4. Select one of the alignment menus using the A or ¥ button, and then press the OK button.
[d Vertical Alignment : Select this if your printouts look blurry or vertical ruled lines appear misaligned.

(J Horizontal Alignment : Select this if you see horizontal banding at regular intervals.

Select Color or B&W according to the print settings.
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5. Follow the on-screen instructions to print a pattern for alignment and align the print head.

[ Vertical Alignment : Find and select the number for the most solid pattern in each group using the A or ¥
button, and then press the OK button.

#1

(J Horizontal Alignment : Find and select the number for the least separated and overlapping pattern using

the A or ¥ button, and then press the OK button.

no

Note:
The test pattern may vary by model.

Related Information

= “Loading Paper in the Paper Cassette 2” on page 46

Cleaning the Paper Path

When the printouts are smeared or scuffed, clean the roller inside.

n Important:

Do not use tissue paper to clean the inside of the printer. The print head nozzles may be clogged with lint.

Cleaning the Paper Path for Ink Smears
1. Make sure there is no dust or stains on the scanner glass and the document cover.

2. Load A4 -size plain paper in the printer.
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3. Start copying without placing the original.

Note:
Repeat this procedure until the paper is not smeared with ink. If you are using the rear paper feed, load A3 or A4-size

plain paper.

Related Information

= “Loading Paper in the Paper Cassette 2” on page 46
= “Loading Paper in the Rear Paper Feed” on page 50
= “Copying Basics” on page 99

Cleaning the Scanner Glass

When the copies or scanned images are smeared or scuffed, clean the scanner glass.

n Important:

Never use alcohol or thinner to clean the printer. These chemicals can damage the printer.

1. Open the document cover.

2. Use a soft, dry, clean cloth to clean the surface of the scanner glass.

Important:

[ If the glass surface is stained with grease or some other hard-to-remove material, use a small amount of
glass cleaner and a soft cloth to remove it. Wipe off all remaining liquid.

(4 Do not press the glass surface too hard.

[d Be careful not to scratch or damage the surface of the glass. A damaged glass surface can decrease the scan
quality.

Cleaning the Translucent Film

When the printout is not improved after aligning the print head or cleaning the paper path, the translucent film
inside the printer may be smeared.

Items required:

[ Cotton swabs (several)
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[d Water with a few drops of detergent (2 to 3 drops of detergent in 1/4 cup of tap water)
[ Light for checking smears

n Important:

Do not use cleaning liquid other than water with a few drops of detergent.

1. Turn off the printer by pressing the O button.

2. Open the scanner unit.

3. Check if the translucent film is smeared. Smears are easier to see if you use a light.

If there are smears (such as finger marks or grease) on the translucent film (A), go to the next step.

A: Translucent film

B: Rail

g Important:

Be careful not to touch the rail (B). Otherwise, you may not be able to print. Do not wipe off the grease on the
rail, because this is necessary for operations.
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4. Moisten a cotton swab with the water with a few drops of detergent so that it is not dripping water, and then
wipe the smeared part.

g Important:

Wife off the smear gently. If you press the cotton swab too hard to the film, the springs of the film may be
dislocated and the printer may be damaged.

5. Use a new dry cotton swab to wipe the film.

g Important:

Do not leave any fibers on the film.

Note:
To prevent the smear from spreading, frequently replace the cotton swab with a new one.

6. Repeat steps 3 and 4 until the film is not smeared.

7. Visually check that the film is not smeared.

Checking the Total Number of Pages Fed Through the
Printer

You can check the total number of pages (sheets of paper and CDs/DVDs) fed through the printer.

Checking the Total Number of Pages Fed Through the Printer -
Control Panel

The information is printed together with the nozzle check pattern.

1. Load A4-size plain paper in the paper cassette.
2. Enter Maint. from the home screen using the € or P> button, and then press the OK button.

3. Select Nozzle Check using the A or ¥ button, and then press the OK button.
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4. Follow the on-screen instructions to print the nozzle check pattern.

Related Information

= “Loading Paper in the Paper Cassette 2” on page 46

Checking the Total Number of Pages Fed Through the Printer -
Windows

1. Access the printer driver window.
2. Click Printer and Option Information on the Maintenance tab.

Related Information

= “Windows Printer Driver” on page 148

Checking the Total Number of Pages Fed Through the Printer - Mac
os

1. Select System Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Options & Supplies > Utility > Open Printer Utility.

3. Click Printer and Option Information.

Saving Power

The printer enters sleep mode or turns off automatically if no operations are performed for a set period. You can
adjust the time before power management is applied. Any increase will affect the product's energy efficiency. Please
consider the environment before making any change.

Depending on the location of purchase, the printer may have a feature that turns it off automatically if it is not
connected to the network for 30 minutes.

Saving Power - Control Panel

1. Enter Settings from the home screen using the € or P> button, and then press the OK button.

2. Select Printer Setup using the A or ¥ button, and then press the OK button.

3. Do one of the following.

[ Select Sleep Timer or Power Off Settings > Power Off If Inactive or Power Off If Disconnected using the
A or 'V button, and then press the OK button.
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O Select Sleep Timer or Power Off Timer using the A or ¥ button, and then press the OK button.

Note:
Your product may have the Power Off Settings or Power Off Timer feature depending on the location of purchase.

4. Select the setting using the A or ¥ button, and then press the OK button.
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Menu Options for Settings Mode

By selecting Settings on the home screen from the control panel, you can make printer settings or perform printer
maintenance.

Menu Options for Maintenance

Select the menus on the control panel as described below.

Settings > Maintenance

Nozzle Check:

Select this feature to check if the print head nozzles are clogged. The printer prints a nozzle check
pattern.

Head Cleaning:

Select this feature to clean clogged nozzles in the print head.

Power Cleaning:

Select this feature to replace all of the ink inside the ink tubes. More ink is consumed than in usual
cleaning. See the "Related Information" below for details on using this feature.

Print Head Alignment:
Select this feature to adjust the print head to improve print quality.
[ Vertical Alignment

Select this feature if your printouts look blurry or text and lines are misaligned.

(J Horizontal Alignment

Select this feature if horizontal banding appears at regular intervals in your printouts.

Reset Ink Levels:
Select this feature to reset the ink levels to 100% when refilling the ink tank.

Maintenance Box Service Life:

Displays the approximate service life of the maintenance box. When the ! icon is displayed, the
maintenance box is nearly full. When the X icon is displayed, the maintenance box is full.

Related Information

= “Checking and Cleaning the Print Head” on page 129

= “Running Power Cleaning” on page 130

= “Aligning the Print Head” on page 132

= “Checking the Status of the Remaining Ink and the Maintenance Box” on page 119
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Menu Options for Printer Setup

Select the menus on the control panel as described below.

Settings > Printer Setup

Paper Source Setting:

Paper Setup:

Select the paper size and paper type you loaded in the paper sources.

Paper Configuration:

Select On to display the paper settings screen automatically by referring to Settings > Printer
Setup > Paper Source Setting > Paper Setup when paper is loaded in the paper source. If you
disable this feature, you cannot print from an iPhone or iPad using AirPrint

CD/DVD:
Adjusts the printing position of a CD/DVD by moving up, down, left, or right to fit.

Stickers:

Adjusts the printing position of a photo sticker by moving up, down, left, or right to fit.

Thick Paper:

Select On to prevent ink from smearing on your printouts, however, this may lower the print speed.

Quiet Mode:

Select On to reduce noise during printing, however, this may lower the print speed. Depending on
the paper type and print quality settings you selected, there may be no difference in the printer's noise
level.

Screen Saver:

Select Memory Card Data to display photos as a slideshow when no operations are performed for
about three minutes.

Auto Power On:

Select On to turn on the printer automatically when it receives a print or scan job over a USB-
connection or a network connection. To start printing, you need to slide out the output tray. Also,
enabling Auto Power On increases power consumption slightly in standby status when compared to
turning the printer off completely.

Use the Power Off Timer setting if you want the printer to automatically turn off when the job is
finished and a set time period has passed with no operations performed. This is useful when printing
from a remote location such as over the Internet.

Power Off Settings:

Your product may have this feature or the Power Oft Timer feature depending on the location of
purchase.
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(d Power Off If Inactive

Select this setting to turn the printer off automatically if it is not used for a specified period of
time. Any increase will affect the product’s energy efficiency. Please consider the environment
before making any change.

(d Power Off If Disconnected

Select this setting to turn the printer off after 30 minutes when all network ports including the
LINE port are disconnected.

Power Off Timer:

Your product may have this feature or the Power Off Settings feature depending on the location of
purchase.

Select this setting to turn the printer off automatically when it is not used for a specified period of
time. You can adjust the time before power management is applied. Any increase will affect the
product’s energy efficiency. Please consider the environment before making any change.

Sleep Timer:
Adjust the time period to enter a sleep mode (energy saving mode) when the printer has not
performed any operations. The LCD screen turns black when the setting time passes.
Language:

Select the language used on the LCD screen.

Related Information

= “Saving Power” on page 137

Menu Options for Network Settings

Select the menus on the control panel as described below.

Settings > Network Settings

Network Status:

Displays the network settings and connection status.

Wi-Fi Setup:
[ Wi-Fi Setup Wizard
Select a SSID, enter a password, and then connect the printer to a wireless (Wi-Fi) network.

(d Push Button Setup (WPS)

Connects the printer to a wireless (Wi-Fi) network by pressing a WPS push button on a wireless
router.

(4 PIN Code Setup (WPS)

In the wireless router utility, enter the PIN code displayed on the printer's screen to connect the
printer to a wireless (Wi-Fi) network.
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1 Wi-Fi Auto Connect

Connects the printer to a wireless (Wi-Fi) network using a computer that is connected to the access
point. Insert the software disc supplied with the printer into the computer, and then follow the on-
screen instructions. When you are prompted to operate the printer, run this menu.

[ Disable Wi-Fi

Disables the connection by turning off the wireless signal without deleting the network information.
To enable the connection, set up the wireless (Wi-Fi) network again.

[ Wi-Fi Direct Setup

Connects the printer to a wireless (Wi-Fi) network without a wireless router.

Manual Network Setup:

Changes the network settings, such as the device name or TCP/IP.

Connection Check:

Checks the status of the network connection and prints the network connection report. If there are any
problems with the connection, see the report to solve the problem.

Related Information

= “Checking the Network Connection Status” on page 29

= “Making Wi-Fi Settings Manually” on page 25

= “Making Wi-Fi Settings by Push Button Setup” on page 26

= “Making Wi-Fi Settings by PIN Code Setup (WPS)” on page 27

= “Disconnecting Wi-Fi Direct (Simple AP) connection from the Control Panel” on page 36

Menu Options for Epson Connect Services

Select the menus on the control panel as described below.

Settings > Epson Connect Services

Register/Delete:
Register or delete the printer to or from the Epson Connect services.
For usage guides, see the following portal website.
https://www.epsonconnect.com/

http://www.epsonconnect.eu (Europe only)

Suspend/Resume:

Select whether to suspend or resume Epson Connect services.

Email Address:

Check the printer's email address that is registered to the Epson Connect services.

Status:

Check whether or not the printer is registered and connected to the Epson Connect services.

142


HTTPS://WWW.EPSONCONNECT.COM/
http://www.epsonconnect.eu/

User's Guide

Menu Options for Settings Mode

Related Information

= “Epson Connect Service” on page 146

Menu Options for Google Cloud Print Services

Select the menus on the control panel as described below.

Settings > Google Cloud Print Services

Suspend/Resume

Select whether to suspend or resume the Google Cloud Print services.

Unregister

Unregister the Google Cloud Print services.

Status

Check whether or not the printer is registered and connected to the Google Cloud Print services.

For registration and usage guides, see the following portal website.
https://www.epsonconnect.com/

http://www.epsonconnect.eu (Europe only)

Menu Options for File Sharing Setup

Select the menus on the control panel as described below.

Settings > File Sharing Setup

Select the connection method between the printer and a computer that will have write access to the memory card
inserted in the printer. Read and write access is given to the computer with the priority connection. Only read
access is given to other computers.

Related Information

= “Accessing a Memory Card From a Computer” on page 203

Menu Options for External Device Setup

Select the menus on the control panel as described below.

Settings > External Device Setup

Change the print settings to print directly from an external device such as a digital camera. See related information
for an explanation on each setting item.
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Related Information
= “Menu Options for Paper and Print Settings” on page 71
= “Menu Options for Photo Adjustment and Zoom” on page 72

Menu Options for Guide Functions

Select the menus on the control panel as described below.

Settings > Guide Functions

Paper Setting Alert:

Displays a warning if the paper settings (print settings) for the print job do not match the printer's
paper settings made when you loaded the paper. This setting prevents misprinting. However, the
paper setting screen is not displayed when Paper Configuration is disables in the following menus.

Settings > Printer Setup > Paper Source Setting

Menu Options for Firmware Update

Select the menus on the control panel as described below.

Settings > Firmware Update

Update:

Checks if the latest version of the firmware has been uploaded to the network server. If an update is
available, you can select whether or not to start updating.

Current Version:

Displays the current firmware version of your printer.
Notification:

Checks for firmware updates periodically and notifies you if an update is available.

Related Information

= “Updating the Printer's Firmware using the Control Panel” on page 160

Menu Options for Restore Default Settings

Select the menus on the control panel as described below.

Settings > Restore Default Settings

Network Settings:

Resets the network settings to their defaults.

144



User's Guide

Menu Options for Settings Mode

All Except Network Settings:

Resets all settings except for network settings to their defaults.

All Settings:

Resets all settings to their defaults.
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Network Service and Software
Information

This section introduces the network services and software products available for your printer from the Epson
website or the supplied software disc.

Epson Connect Service

By using Epson Connect service available on the Internet, you can print from your smartphone, tablet PC, or
laptop, anytime and practically anywhere. You need to register your printer with the Epson Connect service in
advance.

The features available on the Internet are as follows.

Email Print Epson iPrint remote print Scan to Cloud Remote Print Driver

v/ 4 4 4

Follow the steps below to register the printer.

1. Select Settings > Epson Connect Services > Register/Delete on the home screen to print the registration sheet.
2. Follow the instructions on the registration sheet to register the printer.

See the Epson Connect web portal for details.

https://www.epsonconnect.com/

http://www.epsonconnect.eu (Europe only)

Application for Configuring Printer Operations (Web
Config)

Web Config is an application that runs in a web browser, such as Internet Explorer and Safari, on a computer or
smart device. You can confirm the printer status or change the network service and printer settings. To use the
Web Config, connect the printer and the computer or device to the same network.

The following browsers are supported.

(01 Browser
Windows XP SP3 or later Internet Explorer 8 or later, Firefox”, Chrome”
Mac OS X v10.6.8 or later Safari®, Firefox”, Chrome”
ios” Safari”
Android 2.3 or later Default browser
Chrome OS” Default browser
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Use the latest version.

Running Web Config on a Web Browser

1.

Check the printer's IP address.

Select Settings > Network Settings > Network Status from the home screen, and then check the printer's IP
address.

Launch a Web browser from a computer or smart device, and then enter the printer's IP address.
Format:

IPv4: http://the printer's IP address/

IPv6: http://[the printer's IP address]/

Examples:

IPv4: http://192.168.100.201/

IPv6: http://[2001:db8::1000:1]/

Note:

Using the smart device, you can also run Web Config from the maintenance screen of Epson iPrint.

Related Information

= “Using Epson iPrint” on page 92

Running Web Config on Windows

When connecting a computer to the printer using WSD, follow the steps below to run Web Config.

1.

Access the devices and printers screen in Windows.

J Windows 10

Right-click the start button or press and hold it, and then select Control Panel > View devices and printers
in Hardware and Sound.

[ Windows 8.1/Windows 8

Select Desktop > Settings > Control Panel > View devices and printers in Hardware and Sound (or
Hardware).

[ Windows 7

Click the start button, and select Control Panel > View devices and printers in Hardware and Sound.

[ Windows Vista

Click the start button, and select Control Panel > Printers in Hardware and Sound.

Right-click on your printer and select Properties.

Select the Web Service tab and click the URL.
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Running Web Config on Mac OS

1. Select System Preferences from the i menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Options & Supplies> Show Printer Webpage.

Windows Printer Driver

The printer driver controls the printer according to the commands from an application. Making settings on the
printer driver provides the best printing results. You can also check the status of the printer or keep it in top
operating condition using the printer driver utility.

Note:
You can change the language of the printer driver. Select the language you want to use from the Language setting on the
Maintenance tab.

Accessing the printer driver from applications
To make settings that apply only to the application you are using, access from that application.
Select Print or Print Setup from the File menu. Select your printer, and then click Preferences or Properties.

Note:
Operations differ depending on the application. See the application’s help for details.

Accessing the printer driver from the control panel
To make settings that apply to all of the applications, access from the control panel.

J Windows 10

Right-click the start button or press and hold it, and then select Control Panel > View devices and printers in
Hardware and Sound. Right-click on your printer, or press and hold it and then select Printing preferences.

[J Windows 8.1/Windows 8

Select Desktop > Settings > Control Panel > View devices and printers in Hardware and Sound. Right-click
on your printer, or press and hold it and then select Printing preferences.

[ Windows 7

Click the start button, and select Control Panel > View devices and printers in Hardware and Sound. Right-
click on your printer and select Printing preferences.

[J Windows Vista

Click the start button, and select Control Panel > Printers in Hardware and Sound. Right-click on your printer
and select Select printing preferences.

(J Windows XP

Click the start button, and select Control Panel > Printers and Other Hardware > Printers and Faxes. Right-
click on your printer and select Printing preferences.

Accessing the printer driver from the printer icon on the task bar
The printer icon on the desktop task bar is a shortcut icon allowing you to quickly access the printer driver.

If you click the printer icon and select Printer Settings, you can access the same printer settings window as the one
displayed from the control panel. If you double-click this icon, you can check the status of the printer.
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Note:
If the printer icon is not displayed on the task bar, access the printer driver window, click Monitoring Preferences on the
Maintenance tab, and then select Register the shortcut icon to the taskbar.

Starting the utility

Access the printer driver window. Click the Maintenance tab.

Guide to Windows Printer Driver

Help is available in the printer driver for Windows. To view explanations of the setting items, right-click on each
item, and then click Help.

Main Tab
You can make basic settings for printing, such as paper type or paper size.

You can also make settings for printing both sides of the paper or printing multiple pages on one sheet.

== Printing Preferences et

Mar  pore Optiors  Manterancs

Printing Presets Papar Source Alita w
AlddfRemove Presels... Documaent Size | A4 210 X 297 mm S
&) Decurnent - Fast [ earderiess Sattings...
; s f;::.::ﬁ:ew onentstion  @Perrail  (Jiandscape
£l Document - 2-Sided Paper Type Fe— »

B #hoto - 10 x 15 em Portrait
= Fhoto - 10 x 15 cm Landscape Quality Standard i
(%) Printable CO/DVD Frinting

. s’
8 Fhoto - A4 Prtralt Calor ) Color (}Grayscale
= Fhoto - A4 Landscape
2-Sided Pricting | OfF '
Selings... Frink Density. ..
@ < Muiti-Fage off E Fage Order...
o copes 113 BAcotae
— L a ‘_; ' DRE\'prs@ Qrdar
! Quiet Mode aff W
Show Settings [ Pring Presiew

[C13et Arranger Lite
Reset Defoults Ink Levels e

e i
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More Options Tab
You can select additional layout and printing options such as changing the size of a printout or making color
corrections.
= Printing Preferences
Main  Mare Opbars  Maintenance
Printing Presets Document Size | A4 210 x 737 mm
[ Add/Remowe Frosats.., Oulput Paper :same 2 Decument Size
=l bocument - Fast [C) Reduce/Eriasge Decument
=l pocument - Standard Quatty £t Paa - =
| poeument - High Quality FitaFage b =
£ Document - 2-Sided Center
E Fhoto - 10 15 om Porirait - -
= Fhoto - 10 % 15 om Landscape Coler Correction
(=) Frintable €0/EVD Frinkng @) Automatic Ocustom Avanced...
H Fhoto - A4 Porfrat "
= Fhoto - Ad Landscape Image Optians...
Wakermark Features..,
al -
—_— & Addtianal Setings
= {i [ mizate 1807
._LI [#] High Speed
i[l] ‘_‘L!il ‘_‘D‘il [ mirree tmage
Shew Seltings |
Rusot Defaults
| Gancel Apphy Halp
Maintenance Tab

You can run maintenance features such as nozzle check and print head cleaning, and by starting EPSON Status
Monitor 3, you can check printer status and error information.

i Printing Preferences

Main  Mare Options  Mainbenance

Mgzl Chack

L

C@ Powar Claaning

EFSCH Status Manitar 3
Head Cleaning Munitaring Preferences
Extended Settings
Print Queus

@ Job Arranger Lite Frinter and Optien Information

Language English (English) ~ B software Updata
Version X0 Teﬁ‘h“mfsuppoﬂ
QK Cancal Bippby Help

Making Operation Settings for the Windows Printer Driver

You can make settings such as enabling EPSON Status Monitor 3.
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1. Access the printer driver window.
2. Click Extended Settings on the Maintenance tab.
3. Make the appropriate settings, and then click OK.

See the online help for explanations of the setting items.

Related Information

= “Windows Printer Driver” on page 148

Mac OS Printer Driver

The printer driver controls the printer according to the commands from an application. Making settings on the
printer driver provides the best printing results. You can also check the status of the printer or keep it in top
operating condition using the printer driver utility.

Accessing the printer driver from applications

Click Page Setup or Print on the File menu of your application. If necessary, click Show Details (or ¥) to expand
the print window.

Note:
Depending on the application being used, Page Setup may not be displayed in the File menu, and the operations for
displaying the print screen may differ. See the application’s help for details.

Starting the utility

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
select the printer. Click Options & Supplies > Utility > Open Printer Utility.
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Guide to Mac OS Printer Driver

Print dialog

Switch the pop-up menu on the center of the screen to show more items.

Frintar:  EPSON 330X

(o ff &)

Presets:  Default Sattings

Capies: |1
Pages: O all
From: |1 tar 1
Paper Size:  Ad ﬂ 210 by 297 mm

Orientation: Ii' Ta

TextEdit H

Print header and footer
Rewrap contents to fit page

Cencel (IS

Pop-up Menu Descriptions

Layout You can select a layout for printing several pages on one sheet or select to print a border.

Color Matching You can adjust the colors.

Paper Handling You can reduce or enlarge the size of the print job to automatically fit the paper size you
loaded.

Cover Page You can select a cover for your documents. Select Cover Page Type to set the contents to be

printed on the cover.

Print Settings You can make the basic print settings such as paper type and print quality.

Color Options When you select EPSON Color Controls from the Color Matching menu, you can select a
color correction method.

Two-sided Printing You can select a binding direction for 2-sided printing or select a document type.
Settings

Note:
On OS X Mountain Lion or later, if Print Settings menu is not displayed, Epson printer driver has not been installed
correctly.

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), remove the printer,
and then add the printer again. Access the following website, and then enter the product name. Go to Support, and then see
Tips.

http://epson.sn
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Epson Printer Utility

You can run a maintenance feature such as nozzle check and print head cleaning, and by starting EPSON Status
Monitor, you can check printer status and error information.

2 Epson Prinfer Utility 4

EPSON Erson xox sSeries

g on E0a] o0
&
© Comeactes [ Upsite |
S A ~V &
CRSON Status Heaxls Chack Hewd Claaring mel'."-«.ll:q

Lt L

Sz

Frivigs and G
Infarmaikan

Printesr List

Making Operation Settings for the Mac OS Printer Driver

Accessing the Operation Settings Window of the Mac OS Printer Driver

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
select the printer. Click Options & Supplies > Options (or Driver).

Operation Settings of the Mac OS Printer Driver

[d Thick paper and envelopes: Prevents the ink from smearing when printing on thick paper. However, this may
reduce print speed.

[ Skip Blank Page: Avoids printing blank pages.

4 Quiet Mode: Reduces the noise the printer makes, however, may reduce print speed.

[J Automatic Cassette Switching: Automatically feeds paper from paper cassette 2 when paper run out in paper
cassette 1.

[J High Speed Printing: Prints when the print head moves in both directions. The print speed is faster, but the
quality may decline.

[ Warning Notifications: Allows the printer driver to display warning notifications.

153



User's Guide

Network Service and Software Information

[ Establish bidirectional communication: Usually, this should be set to On. Select Off when acquiring the printer
information is impossible because the printer is shared with Windows computers on a network or for any other
reason.

Epson Scan 2 (Scanner Driver)

Epson Scan 2 is an application for controlling scanning. You can adjust the size, resolution, brightness, contrast,
and quality of the scanned image.

Note:
You can also start Epson Scan 2 from a TWAIN-compliant scanning application.

Starting on Windows
[ Windows 10
Click the start button, and then select EPSON > Epson Scan 2.

J Windows 8.1/Windows 8

Enter the application name in the search charm, and then select the displayed icon.

(1 Windows 7/Windows Vista/Windows XP
Click the start button, and then select All Programs or Programs > EPSON > Epson Scan 2> Epson Scan 2.

Starting on Mac OS
Note:
Epson Scan 2 does not support the Mac OS fast user switching feature. Turn off fast user switching.

Select Go > Applications > Epson Software > Epson Scan 2.

Related Information

= “Installing Applications” on page 159

Adding the Network Scanner

Before using Epson Scan 2, you need to add the network scanner.

1. Start the software, and then click Add on the Scanner Settings screen.

Note:
A If Add is grayed out, click Enable Editing.

(A If the main screen of Epson Scan 2 is displayed, it has already been connected to the scanner. If you want to connect
to another network, select Scanner > Settings to open the Scanner Settings screen.
2. Add the network scanner. Enter the following items, and then click Add.
[d Model: Select the scanner you want to connect to.
(d Name: Enter the scanner name within 32 characters.

(d Search for Network: When the computer and the scanner are on the same network, the IP address is

displayed. If it is not displayed, click the " button. If the IP address is still not displayed, click Enter
address, and then enter the IP address directly.
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3. Select the scanner on the Scanner Settingsscreen, and then click OK.

Epson Event Manager

Epson Event Manager is an application that allows you to manage scanning from the control panel and save images
to a computer. You can add your own settings as presets, such as the document type, the save folder location, and
the image format. See the application's help for details.

Starting on Windows
(d Windows 10

Click the start button, and then select Epson Software > Event Manager.

J Windows 8.1/Windows 8

Enter the application name in the search charm, and then select the displayed icon.

[ Windows 7/Windows Vista/Windows XP

Click the start button, and then select All Programs or Programs > Epson Software > Event Manager.

Starting on Mac OS

Select Go > Applications > Epson Software > Event Manager.

Related Information
= “Scanning to a Computer” on page 107
= “Installing Applications” on page 159

Epson Easy Photo Print

Epson Easy Photo Print is an application that allows you to easily print photos with various layouts. You can
preview the photo image and adjust the images or position. You can also print photos with a frame. See the
application's help for details.

Note:
To use this application, the printer driver needs to be installed.

Starting on Windows
(d Windows 10
Click the start button, and then select Epson Software > Epson Easy Photo Print.

J Windows 8.1/Windows 8

Enter the application name in the search charm, and then select the displayed icon.

[ Windows 7/Windows Vista/Windows XP

Click the start button, and then select All Programs or Programs > Epson Software > Epson Easy Photo
Print.

Starting on Mac OS
Select Go > Applications > Epson Software > Epson Easy Photo Print.
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Related Information

= “Installing Applications” on page 159

Epson Print CD

Epson Print CD is an application that allows you to design a CD/DVD label to be printed directly onto a CD/DVD.
You can also print a CD/DVD jacket for CD/DVD case. See the application's help for details.

Note:
To use this application, the printer driver needs to be installed.

Starting on Windows
J Windows 10
Click the start button, and then select Epson Software > Print CD.

[ Windows 8/Windows 8.1

Enter the application name in the search charm, and then select the displayed icon.

(1 Windows 7/Windows Vista/Windows XP
Click the start button, and then select All Programs or Programs > Epson Software > Print CD.

Starting on Mac OS
Select Go > Applications > Epson Software > Print CD > Print CD.

Related Information

= “Installing Applications” on page 159

E-Web Print (for Windows Only)

E-Web Print is an application that allows you to easily print web pages with various layouts. See the application's
help for details. You can access the help from the E-Web Print menu on the E-Web Print tool bar.

Note:
Check for supported browsers and the latest version from the download site.

Starting
When you install E-Web Print, it is displayed in your browser. Click Print or Clip.

Related Information

= “Installing Applications” on page 159

EPSON Software Updater

EPSON Software Updater is an application that checks for new or updated software on the internet and installs it.
You can also update the printer's firmware and manual.
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Starting on Windows
([ Windows 10

Click the start button, and then select Epson Software > EPSON Software Updater.
(4 Windows 8.1/Windows 8

Enter the application name in the search charm, and then select the displayed icon.

[J Windows 7/Windows Vista/Windows XP

Click the start button, and then select All Programs (or Programs) > Epson Software > EPSON Software
Updater.

Note:
You can also start EPSON Software Updater by clicking the printer icon on the task bar on the desktop, and then selecting
Software Update.

Starting on Mac OS
Select Go > Applications > Epson Software > EPSON Software Updater.

Related Information

= “Installing Applications” on page 159

Uninstalling Applications

Log in to your computer as an administrator. Enter the administrator password if the computer prompts you.

Uninstalling Applications - Windows

1. Press the () button to turn off the printer.
2. Quit all running applications.

3. Open Control Panel:

(J Windows 10
Right-click the start button or press and hold it, and then select Control Panel.

(d Windows 8.1/Windows 8
Select Desktop > Settings > Control Panel.

[ Windows 7/Windows Vista/Windows XP
Click the start button and select Control Panel.

4. Open Uninstall a program (or Add or Remove Programs):

[ Windows 10/Windows 8.1/Windows 8/Windows 7/Windows Vista

Select Uninstall a program in Programs.

1 Windows XP
Click Add or Remove Programs.
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Select the application you want to uninstall.

You cannot uninstall the printer driver if there is any print jobs. Delete or wait to be printed the jobs before
uninstalling.

Uninstall the applications:

[ Windows 10/Windows 8.1/Windows 8/Windows 7/Windows Vista
Click Uninstall/Change or Uninstall.

J Windows XP

Click Change/Remove or Remove.

Note:
If the User Account Control window is displayed, click Continue.

Follow the on-screen instructions.

Uninstalling Applications - Mac OS

1.

Download the Uninstaller using EPSON Software Updater.

Once you have downloaded the Uninstaller, you do not need to download it again each time you uninstall the
application.

| .
Press the O button to turn off the printer.

To uninstall the printer driver, select System Preferences from the ‘ menu > Printers & Scanners (or Print
& Scan, Print & Fax), and then remove the printer from the enabled printers list.

Quit all running applications.
Select Go > Applications > Epson Software > Uninstaller.

Select the application you want to uninstall, and then click Uninstall.

n Important:

The Uninstaller removes all drivers for Epson inkjet printers on the computer. If you use multiple Epson inkjet
printers and you only want to delete some drivers, delete all of them first, and then install the necessary printer
driver again.

Note:

If you cannot find the application you want to uninstall in the application list, you cannot uninstall using the
Uninstaller. In this situation, select Go > Applications > Epson Software, select the application you want to uninstall,
and then drag it to the trash icon.

Related Information
= “EPSON Software Updater” on page 156
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Installing Applications

Connect your computer to the network and install the latest version of applications from the website.

Note:
(A Log on to your computer as an administrator. Enter the administrator password if the computer prompts you.

(A When reinstalling an application, you need to uninstall it first.
1. Quit all running applications.

2. When installing the printer driver or Epson Scan 2, disconnect the printer and the computer temporarily.
Note:
Do not connect the printer and the computer until you are instructed to do so.

3. Install the applications by following the instructions on the website below.
http://epson.sn

Note:
If you are using a Windows computer and you cannot download applications from the website, install them from the
software disc that came with the printer.

Related Information

= “Uninstalling Applications” on page 157

Updating Applications and Firmware

You may be able to clear certain problems and improve or add functions by updating the applications and the
firmware. Make sure you use the latest version of the applications and firmware.

1. Make sure that the printer and the computer are connected, and the computer is connected to the internet.

2. Start EPSON Software Updater, and update the applications or the firmware.

n Important:

Do not turn off the computer or the printer until the update is complete; otherwise, the printer may
malfunction.

Note:
If you cannot find the application you want to update in the list, you cannot update using the EPSON Sofiware
Updater. Check for the latest versions of the applications from your local Epson website.

http://www.epson.com

Related Information
= “EPSON Software Updater” on page 156
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Updating the Printer's Firmware using the Control Panel
If the printer is connected to the Internet, you can update the printer's firmware using the control panel. By

updating the firmware, the printer's performance may improve, or new functions may be added. You can also set
the printer to regularly check for firmware updates and notify you if any are available.

1. Enter Settings from the home screen using the  or P button, and then press the OK button.
2. Select Firmware Update using the A or ¥ button, and then press the OK button.

3. Select Update using the A or ¥ button, and then press the OK button.

Note:

Select Notification > On to set the printer to regularly check for available firmware updates.
4. Check the message displayed on the screen and press the OK button.

The printer starts searching for available updates.

5. If a message is displayed on the LCD screen informing you that a firmware update is available, follow the on-
screen instructions to start the update.

n Important:

(A Do not turn off or unplug the printer until the update is complete; otherwise, the printer may malfunction.

[ If the firmware update is not completed or is unsuccessful, the printer does not start up normally and
"Recovery Mode" is displayed on the LCD screen the next time the printer is turned on. In this situation, you
need to update the firmware again using a computer. Connect the printer to the computer with a USB cable.
While "Recovery Mode" is displayed on the printer, you cannot update the firmware over a network
connection. On the computer, access your local Epson website, and then download the latest printer
firmware. See the instructions on the website for the next steps.

Related Information

= “Technical Support Web Site” on page 204
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Solving Problems

Checking the Printer Status

Checking Messages on the LCD Screen

If an error message is displayed on the LCD screen, follow the on-screen instructions or the solutions below to
solve the problem.

Error Messages

Solutions

Printer error. Turn the power off and on again.
For details, see documentation.

If the error message is still displayed after turning the power off and on
again, contact Epson support.

Operation canceled. An error occurred while
saving.

The external storage device, such as a memory card, may be damaged.
Check if the device is available.

Paper Configuration is disabled. Some features
may not be available. For details, see your
documentation.

If Paper Configuration is disabled, you cannot use AirPrint. In addition,
messages notifying you that the paper size and type do not match are
not displayed. Keep this setting enabled unless you always use the same
size and type of paper and do not need to change the paper settings.

The printer's borderless printing ink pad is
nearing the end of its service life. Please contact
Epson support.

Contact Epson or an authorised Epson service provider to replace the
ink pad*. It is not a user-serviceable part. The message will be displayed
until the ink pad is replaced.

Press the <> button to resume printing.

The printer's borderless printing ink pad has
reached the end of its service life. Please contact
Epson support.

Contact Epson or an authorised Epson service provider to replace the
ink pad*. It is not a user-serviceable part.

Communication error. Check if a computer is
connected.

Connect the computer and the printer correctly. If you are connecting
over a network, see the page that describes the network connection
method from the computer.

If the error message is displayed during scanning, make sure that Epson
Scan 2 and Epson Event Manager are installed on the computer.

Combination of the IP address and the subnet
mask is invalid. See your documentation.

Enter the correct IP address or default gateway. Contact the person who
setup the network for assistance.

Update the root certificate to use cloud services.

Run Web Config, and then update the root certificate.

Recovery Mode

The printer has started in recovery mode because the firmware update
failed. Follow the steps below to try to update the firmware again.

1. Connect the computer and the printer with a USB cable. (During
recovery mode, you cannot update the firmware over a network
connection.)

2. Visit your local Epson website for further instructions.

* In some print cycles a very small amount of surplus ink may be collected in the ink pad. To prevent ink leakage
from the pad, the printer is designed to stop printing when the pad has reached its limit. Whether and how often
this is required will vary according to the number of pages you print, the type of material that you print and the
number of cleaning cycles that the printer performs. The need for replacement of the pad does not mean that your
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printer has ceased to operate in accordance with its specifications. The printer will advise you when the pad
requires replacing and this can only be performed by an authorised Epson Service provider. The Epson warranty
does not cover the cost of this replacement.

Related Information

= “Contacting Epson Support” on page 205

= “Supported Memory Card Specifications” on page 196

= “Supported External Storage Device Specifications” on page 196

= “Installing Applications” on page 159

= “Application for Configuring Printer Operations (Web Config)” on page 146
= “Updating Applications and Firmware” on page 159

Checking the Printer Status - Windows

1. Access the printer driver window.

2. Click EPSON Status Monitor 3 on the Maintenance tab.

Note:

(A You can also check the printer status by double-clicking the printer icon on the taskbar. If the printer icon is not
added to the taskbar, click Monitoring Preferences on the Maintenance tab, and then select Register the shortcut
icon to the taskbar.

[d If EPSON Status Monitor 3 is disabled, click Extended Settings on the Maintenance tab, and then select Enable
EPSON Status Monitor 3.

Related Information

= “Windows Printer Driver” on page 148

Checking the Printer Status - Mac OS

1. Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Options & Supplies > Utility > Open Printer Utility.

3. Click EPSON Status Monitor.

You can check the printer status, ink levels, and error status.

Removing Jammed Paper

Check the error displayed on the control panel and follow the instructions to remove the jammed paper including
any torn pieces. Next, clear the error.
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n Important:

(d Remove the jammed paper carefully. Removing the paper vigorously may cause damage to the printer.

[ When removing jammed paper, avoid tilting the printer, placing it vertically, or turning it upside down;
otherwise ink may leak.

Removing Jammed Paper from the Rear Paper Feed

Remove the jammed paper.

Removing Jammed Paper from the Paper Cassette

1. Close the output tray.

2. Pull out the paper cassette.
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3. Remove the jammed paper.

5"

4.  Align the edges of the paper and slide the edge guides to the edges of the paper.

- =
N N
5. Insert the paper cassette in the printer.

Removing Jammed Paper from Inside the Printer

A Caution:

[ Be careful not to trap your hand or fingers when opening or closing the scanner unit. Otherwise you may be
injured.

[d Never touch the buttons on the control panel while your hand is inside the printer. If the printer starts operating,
it could cause an injury. Be careful not to touch the protruding parts to avoid injury.

1. Open the scanner unit with the document cover closed.

%g 1
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2. Remove the jammed paper.

g Important:

Do not touch the white flat cable, translucent film, and ink tubes inside the printer. Doing so may cause a
malfunction.

%

- J

3. Close the scanner unit.
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Removing Jammed Paper from the Rear Cover

1. Remove the rear cover.

2. Remove the jammed paper.

D

3. Insert the rear cover in the printer. Push it in all the way.

Paper Does Not Feed Correctly

Check the following points, and then take the appropriate actions to solve the problem.

[ Place the printer on a flat surface and operate in the recommended environmental conditions.
[d Use paper supported by this printer.

[d Follow the paper handling precautions.

(d Do not load more than the maximum number of sheets specified for the paper. For plain paper, do not load
above the line indicated by the triangle symbol on the edge guide.

[ Make sure the paper size and paper type settings match the actual paper size and paper type loaded in the
printer.

Related Information

= “Environmental Specifications” on page 198
= “Paper Handling Precautions” on page 38
= “Available Paper and Capacities” on page 39
= “List of Paper Types” on page 41
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Paper Jams

[d Load paper in the correct direction, and slide the edge guides against the edges of the paper.

[d Load one sheet of paper at a time if you have loaded several sheets of paper.

Related Information

= “Removing Jammed Paper” on page 162

= “Loading Paper in the Paper Cassette 1” on page 42
= “Loading Paper in the Paper Cassette 2” on page 46
= “Loading Paper in the Rear Paper Feed” on page 50

Paper Feeds at a Slant

Load paper in the correct direction, and slide the edge guides against the edges of the paper.

Related Information

= “Loading Paper in the Paper Cassette 1” on page 42
= “Loading Paper in the Paper Cassette 2” on page 46
= “Loading Paper in the Rear Paper Feed” on page 50

Several Sheets of Paper are Fed at a Time

(d Load one sheet of paper at a time.

[d When several sheets of paper are fed at a time during manual 2-sided printing, remove any paper which is
loaded in the printer before you reload the paper.

Paper Out Error Occurs

When a paper out error occurs although paper is loaded in the rear paper feed, reload paper in the center of the
rear paper feed.

CD/DVD Tray is Ejected

[d Make sure the disc is properly set on the tray and reinsert the tray correctly.

4 Do not insert the CD/DVD tray until you are instructed to do so. Otherwise, an error occurs and the tray is
ejected.

Related Information

= “Printing Photos from a Memory Card onto a CD/DVD Label” on page 62
= “Copying on a CD/DVD Label” on page 103
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Power and Control Panel Problems

Power Does Not Turn On

[d Make sure the power cord is securely plugged in.

O Hold down the O button for a little longer.

Lights Came On and then Went Out

The printer's voltage may not match the outlet rating. Turn off the printer and unplug it immediately. Then check
the label on the printer.

A Caution:

If the voltage does not match, DO NOT PLUG YOUR PRINTER BACK IN. Contact your dealer.

Power Does Not Turn Off

Hold down the ) button for a little longer. If you still cannot turn off the printer, unplug the power cord. To
prevent the print head from drying out, turn the printer back on and turn it off by pressing the O button.

Power Turns Off Automatically

[ Select Power Off Settings in Printer Setup, and then disable the Power Off If Inactive and Power Off If
Disconnected settings.

(d Disable the Power Off Timer setting in Printer Setup.

Note:
Your product may have the Power Off Settings or Power Off Timer feature depending on the location of purchase.

Related Information

= “Menu Options for Printer Setup” on page 140

LCD Screen Gets Dark

The printer is in sleep mode. Press any button on the control panel to return the LCD screen to its former state.

The Auto Power On Feature does not Work

[d Make sure that the Auto Power On setting in Printer Setup has been enabled.

[d Make sure that the printer is properly connected with a USB cable or to a network.
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Related Information

= “Menu Options for Printer Setup” on page 140

Cannot Print from a Computer

Checking the connection
[d Connect the USB cable securely to the printer and the computer.
[ If you are using a USB hub, try to connect the printer directly to the computer.

[ If you cannot print over a network, see the page that describes the network connection method from the
computer.

Checking the software and data

[d Make sure that a genuine Epson printer driver is installed. If a genuine Epson printer driver is not installed, the
available functions are limited. We recommend using a genuine Epson printer driver. See the related
information link below for details.

[ If you are printing a large data size image, the computer may run out of memory. Print the image at a lower
resolution or a smaller size.

Checking the printer status from the computer (Windows)
Click Print Queue on the printer driver's Maintenance tab, and then check the following.
[d Check if there are any paused print jobs.
Cancel printing if necessary.
[d Make sure the printer is not offline or pending.
If the printer is offline or pending, clear the offline or pending setting from the Printer menu.

[ Make sure the printer is selected as the default printer from the Printer menu (there should be a check mark on
the menu item).

If the printer is not selected as the default printer, set it as the default printer.

[d Make sure the printer port is selected correctly in Property > Port from the Printer menu as follows.

Select "USBXXX" for a USB connection, or "EpsonNet Print Port" for a network connection.

Checking the printer status from the computer (Mac OS)
Make sure the printer status is not Pause.

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
double-click the printer. If the printer is paused, click Resume (or Resume Printer).

Related Information

= “Connecting to a Computer” on page 23

= “Installing Applications” on page 159

= “Canceling Printing” on page 97

= “Checking for Genuine Epson Printer Drivers” on page 170
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Checking for Genuine Epson Printer Drivers

You can check if a genuine Epson printer driver is installed on your computer by using one of the following
methods.

Windows

Select Control Panel > View devices and printers (Printers, Printers and Faxes), and then do the following to
open the print server properties window.

4 Windows 10/Windows 8.1/Windows 8/Windows 7

Click the printer icon, and then click Print server properties at the top of the window.
(d Windows Vista

Right-click on the Printers folder, and then click Run as administrator > Server Properties.
4 Windows XP

From the File menu, select Server Properties.

Click the Driver tab. If your printer name is displayed in the list, a genuine Epson printer driver is installed on
your computer.

3 Devices and Printers
« « 4 x> ControlPanel » Hardware and Sound > Devices and Printers » v

Fle Edit View Tools Help

Addadevice  Addaprinter  Seewhat's printing | Print server properties |) Remove device

* Printers (19) = Print Server Propertlese x
Forms F‘nrtacur\ty Avansed
-~ =
<N ; | XXX

XXXXX Series

Installed printer drivers:

_m/ Name Processor Type &
2 p EPSON XXXXXX Series

Type 3 - User Mode

XXX

—_—
EPSON
XXXXKXXK
Series.

P
-
~—

Add... Remove.. Properties

Gchanga Driver Settings

Sancel ooty
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Mac OS

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
select the printer. Click Options & Supplies, and if the Options tab and Utility tab are displayed on the window, a
genuine Epson printer driver is installed on your computer.

Printers & Scanners

General Supply Levels

Open Printer Utility
Print Test Page

Clean Print Heads

Cancel (LN

Related Information

= “Installing Applications” on page 159

When You Cannot Make Network Settings

[ Turn off the devices you want to connect to the network. Wait for about 10 seconds, and then turn on the
devices in the following order; access point, computer or smart device, and then printer. Move the printer and
computer or smart device closer to the access point to help with radio wave communication, and then try to
make network settings again.

[ Select Settings > Network Settings > Connection Check, and then print the network connection report. If an
error has occurred, check the network connection report and then follow the printed solutions.

Related Information
= “Printing a Network Connection Report” on page 30

= “Cannot Connect from Devices Even Though Network Settings are No Problems” on page 171

Cannot Connect from Devices Even Though Network Settings are
No Problems

If you cannot connect from the computer or smart device to the printer even though the network connection
report does not show any problems, see the following.
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[d When you are using multiple access points at the same time, you may not be able to use the printer from the
computer or smart device depending on the settings of the access points. Connect the computer or smart device
to the same access point as the printer.

[J You may not be able to connect to the access point when the access point has multiple SSIDs and devices are

connected to different SSIDs on the same access point. Connect the computer or smart device to the same SSID
as the printer.

\\
N

-
SSIDT:XXXXX-G1 _\-\\ SSIDT:XXXXX-G1
SSID2:XXXXX-G2 SSID2:XXXXX-G2

)

ﬁ
N
v

7z
]
SSIDT:XXXXX-G1 SSID2:XXXXX-G2 SSID2:XXXXX-G2

[d An access point that is compliant with both IEEE802.11a and IEEE802.11g has SSIDs of 2.4 GHz and 5 GHz. If
you connect the computer or smart device to a 5 GHz SSID, you cannot connect to the printer because the

printer only supports communication over 2.4 GHz. Connect the computer or smart device to the same SSID as
the printer.

N

\'\
2.4GHz SSID:XXXXX_G

) 5GHz SSID:XXXXX_A
- 2.4GHz SSIDXXXXX_G

a ===

\\\

)

)
\?m

=

SSID:XXXXX_A SSID:XXXXX_G SSID:XXXXX_G
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[d Most access points have a privacy separator feature that blocks communication between connected devices. If
you cannot communicate between the printer and the computer or smart device even if they are connected to
the same network, disable the privacy separator on the access point. See the manual provided with the access
point for details.

Jolee | T =

Related Information
= “Checking the SSID Connected to the Printer” on page 173
= “Checking the SSID for the Computer” on page 174

Checking the SSID Connected to the Printer

Select Settings > Network Settings > Network Status. SSIDs are displayed on each Wi-Fi network and Wi-Fi
Direct network.
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Checking the SSID for the Computer

Windows

Click in the task tray on the desktop. Check the name of the connected SSID from the list displayed.

Mac OS

Click the Wi-Fi icon at the top of the computer screen. A list of SSIDs is displayed and the connected SSID is
indicated with a check mark.

)] 54% (4

Turn Wi-Fi OR

o ) -'—
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Suddenly the Printer Cannot Print over a Network
Connection

(4 When you have changed your access point or provider, try making network settings for the printer again.
Connect the computer or smart device to the same SSID as the printer.

(4 Turn off the devices you want to connect to the network. Wait for about 10 seconds, and then turn on the
devices in the following order; access point, computer or smart device, and then printer. Move the printer and
computer or smart device closer to the access point to help with radio wave communication, and then try to
make network settings again.

(d In Windows, click Print Queue on the printer driver's Maintenance tab, and then check the following.
[J Check if there are any paused print jobs. Cancel printing if necessary.

[J Make sure the printer is not offline or pending. If the printer is offline or pending, clear the offline or
pending setting from the Printer menu.

(1 Make sure the printer is selected as the default printer from the Printer menu (there should be a check mark
on the menu item).

If the printer is not selected as the default printer, set it as the default printer.

J Check if the selected port is correct in Printer Properties > Port

[ Select Settings > Network Settings > Connection Check, and then print the network connection report. If the
report shows that the network connection failed, check the network connection report and then follow the
printed solutions.

[ Try accessing any website from your computer to make sure that your computer's network settings are correct.
If you cannot access any website, there is a problem on the computer. See the manual provided with your
computer for more details.

Related Information

= “Checking the SSID Connected to the Printer” on page 173
= “Checking the SSID for the Computer” on page 174

= “Printing a Network Connection Report” on page 30

Suddenly the Printer Cannot Print Using a USB
Connection

(d Disconnect the USB cable from the computer. Right-click on the printer icon displayed on the computer, and
then select Remove Device. Next, connect the USB cable to the computer and try a test print. If printing is
possible, the setup is complete.

[d Re-set the USB connection following the steps in [Changing a Connection Method to a Computer] in this
manual.

Related Information

= “Changing the Connection Method to a Computer” on page 35
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Cannot Print from an iPhone or iPad

[d Connect the iPhone or iPad to the same network (SSID) as the printer.
[J Enable Paper Configuration in the following menus.
Settings > Printer Setup > Paper Source Setting > Paper Configuration

(d Enable the AirPrint setting on Web Config.

Related Information

= “Connecting to a Smart Device” on page 24

= “Application for Configuring Printer Operations (Web Config)” on page 146

Printout Problems

Printout is Scuffed or Color is Missing

[ If you have not used the printer for a long time, the print head nozzles may be clogged and ink drops may not
be discharged. Perform a nozzle check, and then clean the print head if any of the print head nozzles are
clogged.

[ If you printed when the ink levels were too low to be seen in the ink tank windows, refill the ink tanks to the
upper lines and then use the Power Cleaning utility to replace the ink inside the ink tubes. After you use the
utility, perform a nozzle check to see if print quality has improved.

Related Information

= “Checking and Cleaning the Print Head” on page 129
= “Refilling the Ink Tanks” on page 122

= “Running Power Cleaning” on page 130

Banding or Unexpected Colors Appear

. I‘:I‘*i

r. =" i
The print head nozzles may be clogged. Perform a nozzle check to check if the print head nozzles are clogged.

ol %
lli
Clean the print head if any of the print head nozzles are clogged.

Related Information

® “Checking and Cleaning the Print Head” on page 129
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Colored Banding Appears at Intervals of Approximately 2.5 cm

[ Select the appropriate paper type setting for the type of paper loaded in the printer.
(d Align the print head using the Horizontal Alignment feature.

(1 When printing on plain paper, print using a higher quality setting.
Related Information

= “List of Paper Types” on page 41
= “Aligning the Print Head - Control Panel” on page 132

Blurry Prints, Vertical Banding, or Misalignment

SIINACH anc
y Antdrack . W
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Align the print head using the Vertical Alignment feature.

Related Information

= “Aligning the Print Head - Control Panel” on page 132

Print Quality Does Not Improve Even After Aligning the Print Head

During bidirectional (or high speed) printing, the print head prints while moving in both directions, and vertical
lines may be misaligned. If print quality does not improve, disable the bidirectional (or high speed) setting.
Disabling this setting may slow down printing speed.

(4 Control panel

Disable Bidirectional in the print settings.

d Windows
Clear High Speed on the printer driver’s More Options tab.
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1 Mac OS

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
select the printer. Click Options & Supplies > Options (or Driver). Select Off as the High Speed Printing
setting.

Related Information

= “Menu Options for Paper and Print Settings” on page 71

Print Quality is Poor

Check the following if the print quality is poor due to blurry prints, banding, missing colors, faded colors, and
misalignment in the prints.

Checking the printer

[d Make sure the initial ink charging is complete.

[ Refill the ink tank if the ink level is below the lower line.

(d Perform a nozzle check, and then clean the print head if any of the print head nozzles are clogged.

(d Align the print head.

Checking the paper

[d Use paper supported by this printer.

(d Do not print on paper that is damp, damaged, or too old.
[ If the paper is curled or the envelope is puffed up, flatten it.
(d Do not stack the paper immediately after printing.

[ Dry the printouts completely before filing or displaying them. When drying the printouts, avoid direct sun light,
do not use a dryer, and do not touch the printed side of paper.

[d When printing images or photos, Epson recommends using genuine Epson paper rather than plain paper. Print
on the printable side of the genuine Epson paper.

Checking the print settings
[ Select the appropriate paper type setting for the type of paper loaded in the printer.

[ Print using a higher quality setting.

Checking the ink bottle
[d Use ink bottles with the correct part code for this printer.
[d Epson recommends using the ink bottle before the date printed on the package.

[ Try to use genuine Epson ink bottles. This product is designed to adjust colors based on the use of genuine
Epson ink bottles. The use of non-genuine ink bottles may cause print quality to decline.

Related Information

= “Available Paper and Capacities” on page 39
= “List of Paper Types” on page 41
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= “Paper Handling Precautions” on page 38
= “Checking and Cleaning the Print Head” on page 129
= “Aligning the Print Head - Control Panel” on page 132

Paper Is Smeared or Scuffed

[ When horizontal banding appears or the top or bottom of the paper is smeared, load paper in the correct
direction and slide the edge guides to the edges of the paper.

v

[ When vertical banding appears or the paper is smeared, clean the paper path.

|V

[ Place the paper on a flat surface to check if it is curled. If it is, flatten it.

[ If thick paper is scuffed, enable the reduce scuffing setting. If you enable this setting, print quality may decline
or printing may slow down.

J Control panel
Select Settings > Printer Setup from the home screen, and then enable Thick Paper.

d Windows

Click Extended Settings on the printer driver's Maintenance tab, and then select Thick Paper and
Envelopes.

(d Mac OS

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer. Click Options & Supplies > Options (or Driver). Select On as the Thick paper and
envelopes setting.

[d When performing manual 2-sided printing, make sure that the ink is completely dry before reloading the paper.

Related Information

= “Loading Paper in the Paper Cassette 1” on page 42

= “Loading Paper in the Paper Cassette 2” on page 46

= “Loading Paper in the Rear Paper Feed” on page 50

= “Cleaning the Paper Path for Ink Smears” on page 133
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Paper is Smeared During Automatic 2-Sided Printing

When using the automatic 2-sided printing feature and printing high density data such as images and graphs, set
the print density to lower and the drying time to longer.

Related Information
= “Printing on 2-Sides” on page 77
= “Menu Options for Copy Mode” on page 99

Printed Photos are Sticky

You may be printing on the wrong side of the photo paper. Make sure you are printing on the printable side.

When printing on the wrong side of the photo paper, you need to clean the paper path.

Related Information

= “Cleaning the Paper Path for Ink Smears” on page 133

Images or Photos are Printed in Unexpected Colors

When printing from the control panel or from the Windows printer driver, the Epson auto photo adjustment
setting is applied by default depending on the paper type. Try change the setting.

(d Control panel

Change the Scene Detection setting from Automatic to any other option. If changing the setting does not work,
select any other option other than PhotoEnhance as the Enhance setting.

(A Windows printer driver

On the More Options tab, select Custom in Color Correction, and then click Advanced. Change the Scene
Correction setting from Auto Correct to any other option. If changing the setting does not work, use any color
correction method other than PhotoEnhance in Color Management.

Colors Differ from What You See on the Display

(4 Display devices such as computer screens have their own display properties. If the display is unbalanced, the
image are not displayed with proper brightness and colors. Adjust the properties of the device. Next, perform
the following.

J Windows

Access the printer driver window, select Custom as the Color Correction setting on the More Options tab,
and then click Advanced. Select EPSON Standard as the Color Mode setting.

[d Mac OS

Access the print dialog. Select Color Options from the pop-up menu, and then click the arrow next to
Advanced Settings. Select EPSON Standard as the Mode setting.

(J Light shining into the display has an effect on how the image is seen on the display. Avoid direct sunlight and
confirm the image where an appropriate illuminance is assured.
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[d Colors may differ from what you see on smart devices such as smart phones or tablets with high-resolution
displays.

(d Colors on a display are not quite identical to those on paper because the display device and the printer have a
different process of producing colors.

Cannot Print Without Margins

Make borderless setting in the print settings. If you select a paper type that does not support borderless printing,
you cannot select Borderless. Select a paper type that supports borderless printing.

Related Information

= “Menu Options for Paper and Print Settings” on page 71
= “Menu Options for Copy Mode” on page 99

= “Printing Basics - Windows” on page 73

= “Printing Basics - Mac OS” on page 75

Edges of the Image are Cropped During Borderless Printing
During borderless printing, the image is slightly enlarged and the protruding area is cropped. Select a smaller
enlargement setting.

(d Control panel
Change the Expansion setting.

1 Windows
Click Settings next to the Borderless checkbox on the printer driver's Main tab, and then change the settings.

1 Mac OS

Change the Expansion setting from the print dialog's Print Settings menu.

Related Information
= “Menu Options for Paper and Print Settings” on page 71
= “Menu Options for Copy Mode” on page 99

The Position, Size, or Margins of the Printout Are Incorrect

[d Load paper in the correct direction, and slide the edge guides against the edges of the paper.

[d When placing the originals on the scanner glass, align the corner of the original with the corner indicated by a
symbol on the frame of the scanner glass. If the edges of the copy are cropped off, move the original slightly
away from the corner.

(d When placing the originals on the scanner glass, clean the scanner glass and the document cover. If there is dust
or stains on the glass, the copy area may extend to include the dust or stains, resulting in the wrong copying
position or small images.

[ Select the appropriate paper size setting.

(d Adjust the margin setting in the application so that it falls within the printable area.
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Related Information

= “Loading Paper in the Paper Cassette 1” on page 42
= “Loading Paper in the Paper Cassette 2” on page 46
= “Loading Paper in the Rear Paper Feed” on page 50
= “Cleaning the Scanner Glass” on page 134

= “Printable Area” on page 192

Multiple Originals are Copied onto a Single Sheet

When you place multiple originals on the scanner glass to copy them separately, but they are copied onto a single
sheet, place the originals at least 5 mm apart. If the problem continues, place one original at a time.

Related Information

= “Placing Photos for Copying” on page 55

Printing Position of Photo Stickers is Incorrect

Adjust the printing position in the Printer Setup > Stickers menu on the control panel.

Related Information

= “Menu Options for Printer Setup” on page 140

Printing Position on a CD/DVD is Incorrect

Adjust the printing position in the Printer Setup > CD/DVD menu on the control panel.

Related Information

= “Menu Options for Printer Setup” on page 140

Printed Characters Are Incorrect or Garbled

[d Connect the USB cable securely to the printer and the computer.
[d Cancel any paused print jobs.

(d Do not put the computer manually into the Hibernate mode or the Sleep mode while printing. Pages of garbled
text may be printed next time you start the computer.

Related Information

= “Canceling Printing” on page 97
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The Printed Image Is Inverted

Clear any mirror image settings in the printer driver or the application.

J Windows

Clear Mirror Image on the printer driver's More Options tab.

[ Mac OS

Clear Mirror Image from the print dialog's Print Settings menu.

Mosaic-Like Patterns in the Prints

When printing images or photos, print using high-resolution data. Images on websites are often low resolution
although they look good enough on the display, and so print quality may decline.

Uneven Colors, Smears, Dots, or Straight Lines Appear in the Copied
Image

[ Clean the paper path.
[ Clean the scanner glass.

(d Do not press too hard on the original or the document cover when you are placing the originals on the scanner
glass.

[ When the paper is smeared, lower the copy density setting.

Related Information
= “Cleaning the Scanner Glass” on page 134
= “Menu Options for Copy Mode” on page 99

Moiré (Cross-Hatch) Patterns Appear in the Copied Image

Change the reduce and enlarge setting or place the original at a slightly different angle.

Related Information

= “Menu Options for Copy Mode” on page 99

An Image of the Reverse Side of the Original Appears in the Copied
Image

[ For a thin original, place the original on the scanner glass and then place a piece of black paper over it.

(d Lower the copy density setting on the control panel.

Related Information

= “Menu Options for Copy Mode” on page 99
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The Printout Problem Could Not be Cleared

If you have tried all of the solutions and have not solved the problem, try uninstalling and then reinstalling the
printer driver.

Related Information
= “Uninstalling Applications” on page 157
= “Installing Applications” on page 159

Other Printing Problems

Printing Is Too Slow

[d Close any unnecessary applications.
[d Lower the quality setting. High quality printing slows down the printing speed.

(d Enable the bidirectional (or high speed) setting. When this setting is enabled, the print head prints while
moving in both directions, and the printing speed increases.

(d Control panel

Enable Bidirectional in the print settings.
J Windows

Select High Speed on the printer driver's More Options tab.
d Mac OS

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer. Click Options & Supplies > Options (or Driver). Select On as the High Speed
Printing setting.

[ Disable Quiet Mode.
J Control panel

From the home screen, select Quiet Mode, and then disable it.

1 Windows
Disable the Quiet Mode setting on the printer driver's Main tab.

[d Mac OS

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer. Click Options & Supplies > Options (or Driver). Select Off as the Quiet Mode
setting.

Related Information

= “Menu Options for Paper and Print Settings” on page 71
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Printing Slows Down Dramatically During Continuous Printing

Printing slows down to prevent the printer mechanism from overheating and being damaged. However, you can
continue printing. To return to normal printing speed, leave the printer idle for at least 30 minutes. Printing speed
does not return to normal if the power is off.

Cannot Cancel Printing from a Computer Running Mac OS X v10.6.8

If you want to stop printing from your computer, make the following settings.

Run Web Config, and then select Port9100 as the Top Priority Protocol setting in AirPrint Setup. Select System

Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), remove the printer, and
then add the printer again.

Related Information

= “Application for Configuring Printer Operations (Web Config)” on page 146

Cannot Start Scanning

(d Connect the USB cable securely to the printer and the computer. If you are using a USB hub, try to connect the
printer directly to the computer.

[ If you scan at a high resolution over a network, a communication error may occur. Lower the resolution.

[ Make sure that the correct printer (scanner) is selected on Epson Scan 2.

Check whether or not the printer is recognized when using Windows

In Windows, make sure the printer (scanner) is displayed in Scanner and Camera. The printer (scanner) should be
displayed as "EPSON XXXXX (printer name)". If the printer (scanner) is not displayed, uninstall and then re-
install Epson Scan 2. See the following to access Scanner and Camera.

J Windows 10

Right-click the start button or press and hold it, select Control Panel, enter "Scanner and Camera" in the search
charm, click View scanners and cameras, and then check if the printer is displayed.

(d Windows 8.1/Windows 8

Select Desktop > Settings > Control Panel, enter "Scanner and Camera" in the search charm, click Show
Scanner and Camera, and then check if the printer is displayed.

(J Windows 7

Click the start button and select Control Panel, enter "Scanner and Camera" in the search charm, click View
scanners and cameras, and then check if the printer is displayed.

(d Windows Vista

Click the start button, select Control Panel > Hardware and Sound > Scanners and Cameras, and then check
if the printer is displayed.

(d Windows XP

Click the start button, select Control Panel > Printers and Other Hardware > Scanner and Cameras, and then
check if the printer is displayed.
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Related Information
= “Uninstalling Applications” on page 157
= “Installing Applications” on page 159

Cannot Start Scanning when Using the Control Panel

(1 Make sure Epson Scan 2 and Epson Event Manager are installed correctly.

[d Check the scanning setting assigned in Epson Event Manager.

Related Information
= “Epson Scan 2 (Scanner Driver)” on page 154
= “Epson Event Manager” on page 155

Scanned Image Problems

Uneven Colors, Dirt, Spots, and so on Appear when Scanning from
the Scanner Glass

(4 Clean the scanner glass.
(J Remove any trash or dirt that adheres to the original.

[d Do not press with too much force on the original or the document cover. If you press with too much force,
blurring, smudges, and spots may occur.

Related Information

= “Cleaning the Scanner Glass” on page 134

The Image Quality Is Rough

[d Set the Mode in Epson Scan 2 according to the original you want to scan. Scan using the settings for documents
in Document Mode, and the settings for photos in Photo Mode.

(d In Epson Scan 2, adjust the image using items on the Advanced Settings tab, and then scan.

(4 If the resolution is low, try increasing the resolution and then scanning.

Related Information

= “Scanning Using Epson Scan 2” on page 110

Offset Appears in the Background of Images

Images on the back of the original may appear in the scanned image.
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[ In Epson Scan 2, select the Advanced Settings tab, and then adjust the Brightness.

This feature may not be available depending on the settings on the Main Settings tab > Image Type or other
settings on the Advanced Settings tab.

(4 In Document Mode in Epson Scan 2, select the Advanced Settings tab, and then Image Option > Text
Enhancement.

[d When scanning from the scanner glass, place black paper or a desk pad over the original.

Related Information
® “Placing Originals on the Scanner Glass” on page 54
= “Scanning Using Epson Scan 2” on page 110

Text is Blurred

(d In Document Mode in Epson Scan 2, select the Advanced Settings tab, and then Image Option > Text
Enhancement.

[ Select Document Mode as the Mode in Epson Scan 2. Scan using the settings for documents in Document
Mode.

[ In Document Mode in Epson Scan 2, when Image Type on the Main Settings tab is set to Black & White,
adjust Threshold on the Advanced Settings tab. When you increase the Threshold, the black color area
becomes larger.

(4 If the resolution is low, try increasing the resolution and then scanning.

Related Information

= “Scanning Documents (Document Mode)” on page 111

Moiré Patterns (Web-Like Shadows) Appear

If the original is a printed document, moiré patterns (web-like shadows) may appear in the scanned image.

(4 On the Advanced Settings tab in Epson Scan 2, set Descreening.

- —
|
(d Change the resolution, and then scan again.

Related Information

= “Scanning Using Epson Scan 2” on page 110
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Cannot Scan the Correct Area on the Scanner Glass

(J Make sure the original is placed correctly against the alignment marks.
[ If the edge of the scanned image is missing, move the original slightly away from the edge of the scanner glass.

[d When placing multiple originals on the scanner glass, make sure there is a gap of at least 20 mm (0.79 in.)
between the originals.

[d When scanning from the control panel and selecting the auto scan area cropping function, remove any trash or
dirt from the scanner glass and document cover. If there is any trash or dirt around the original, the scanning
range expands to include it.

Related Information

= “Placing Originals on the Scanner Glass” on page 54

Cannot Preview in Thumbnail

[ When placing multiple originals on the scanner glass, make sure there is a gap of at least 20 mm (0.79 in.)
between the originals.

[d Check that the original is placed straight.

[d Depending on the original, previewing may not be performed in Thumbnail. In this situation, scan in Normal
preview, and then create marquees manually.

Related Information

= “Scanning Photos or Pictures (Photo Mode)” on page 113

Text is Not Recognized Correctly when Saving as a Searchable PDF

(4 On the Image Format Options window in Epson Scan 2, check that Text Language is set correctly on the Text
tab.

[d Check that the original is placed straight.
[J Use an original with clear text. Text recognition may decline for the following types of originals.
[ Originals that have been copied a number of times
J Originals received by fax (at low resolutions)
J Originals on which the letter spacing or line spacing is too small
[ Originals with ruled lines or underlining over the text
(1 Originals with hand-written text

[d Originals with creases or wrinkles

(d In Document Mode in Epson Scan 2, when Image Type on the Main Settings tab is set to Black & White,
adjust Threshold on the Advanced Settings tab. When you increase the Threshold, black becomes stronger.

(4 In Document Mode in Epson Scan 2, select the Advanced Settings tab, and then Image Option > Text
Enhancement.
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Related Information

= “Scanning Documents (Document Mode)” on page 111

Cannot Solve Problems in the Scanned Image

If you have tried all of the solutions and have not solved the problem, initialize the Epson Scan 2 settings using
Epson Scan 2 Utility.

Note:

Epson Scan 2 Utility is an application that comes with Epson Scan 2.

1. Start Epson Scan 2 Utility.

(4 Windows 10
Click the start button, and then select EPSON > Epson Scan 2 Utility.

J Windows 8.1/Windows 8

Enter the application name in the search charm, and then select the displayed icon.

[ Windows 7/Windows Vista/Windows XP

Click the start button, and then select All Programs or Programs > EPSON > Epson Scan 2 > Epson Scan
2 Utility.

d Mac OS
Select Go > Applications > Epson Software > Epson Scan 2 Utility.

2. Select the Other tab.

3. Click Reset.

Note:
If initialization does not solve the problem, uninstall and re-install Epson Scan 2.

Related Information
= “Uninstalling Applications” on page 157
= “Installing Applications” on page 159

Other Scanning Problems

Scanning Speed Is Slow

(d Lower the resolution, and then scan again. When the resolution is high, scanning may take some time.

(d The scanning speed may be reduced depending on the image adjustment features in Epson Scan 2.

(d On the Configuration screen which is displayed by clicking the o button in Epson Scan 2, if you set Quiet
Mode on the Scan tab, the scanning speed may be reduced.

Related Information

= “Scanning Using Epson Scan 2” on page 110
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= “Menu Options for Scanning” on page 110

Scanning Stops when Scanning to PDF/Multi-TIFF

[ When scanning using Epson Scan 2, you can continuously scan up to 999 pages in PDF format and up to 200
pages in Multi-TIFF format.
[d When scanning large volumes, we recommend scanning in grayscale.

[ Increase the free space on the computer's hard disk. Scanning may stop if there is not enough free space.

[d Try scanning at a lower resolution. Scanning stops if the total data size reaches the limit.

Related Information

= “Scanning Using Epson Scan 2” on page 110

Other Problems

Slight Electric Shock when Touching the Printer

If many peripherals are connected to the computer, you may feel a slight electric shock when touching the printer.
Install a ground wire to the computer that is connected to the printer.

Operation Sounds Are Loud

If operations sounds are too loud, enable Quiet Mode. Enabling this feature may reduce printing speed.

[ Control Panel

From the home screen, select Quiet Mode, and then enable it.

[ Windows
Enable Quiet Mode on the Main tab in the printer driver.

d Mac OS

Select System Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
select the printer. Click Options & Supplies > Options (or Driver). Select On as the Quiet Mode setting.

(4 Epson Scan 2

Click the L] button to open the Configuration window. Next, set the Quiet Mode on the Scan tab.

Cannot Save the Data to a Memory Card

(4 Use a memory card which is supported by the printer.
(4 Check that the memory card is not write protected.

[d Check that the memory card has enough available memory. If the available memory is low, data cannot be
saved.
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Related Information

= “Supported External Storage Device Specifications” on page 196

Application Is Blocked by a Firewall (for Windows Only)

Add the application to the Windows Firewall allowed program in security settings on the Control Panel.

"?"Is Displayed on the Photo Selection Screen

"?" is displayed on the LCD screen when the image file is not supported by the product.

Related Information

= “Supported Data Specifications” on page 197

A Message Prompting You to Reset the Ink Levels is Displayed

Refill all or the specified ink tanks, select the color that you refilled on the LCD screen, and then press the <>
button to reset the ink levels.

Depending on the usage conditions, the message may be displayed when there is still ink in the tank.

Related Information
= “Refilling the Ink Tanks” on page 122

Ink Spilled

[ If ink adheres to the area around the tank, wipe it off using a napless, clean cloth or cotton swab.

[ If ink spills on the desk or floor, wipe it off immediately. When ink is dried, it will be difficult to remove the
smear. To prevent the smear from spreading, blot the ink with a dry cloth, and then wipe it with a moist cloth.

[ If ink gets on your hands, wash them with water and soap.
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Technical Specifications
Printer Specifications
Print Head Nozzle Placement Black ink nozzles: 360

Photo black ink nozzles: 180

Color ink nozzles: 180 for each color

Weight of Paper” Plain Paper 64 to 90 g/m? (17 to 24lb)

Envelopes Envelope #10, DL, C6: 75 to 90 g/m? (20 to 24 Ib)

* Even when the paper thickness is within this range, the paper may not feed in the printer or the print quality may decline
depending on the paper properties or quality.

Printable Area

Printable Area for Single Sheets

Print quality may decline in the shaded areas due to the printer's mechanism.

Printing with borders

AH :[C A 3.0mm (0.12in.)
B 3.0mm(0.12in.)
C 41.0mm (1.61in.)
D 37.0mm (1.46in.)
A+ jD
H H
B B

Borderless printing

A A 44,0 mm (1.73in.)

B 40.0 mm (1.57 in.)

192



User's Guide

Printable Area for Envelopes

Appendix

Print quality may decline in the shaded areas due to the printer's mechanism.

AH IC
I
At T
B B

A 3.0mm (0.121in.)
B 5.0mm (0.20in.)
C 18.0 mm (0.70in.)
D 41.0mm(1.61in.)

Printable Area for CD/DVD

Print quality may decline in the shaded areas due to the printer's mechanism.

A 18 mm (0.71in.)
B 43 mm (1.69in.)
‘K C 116 mm (4.57 in.)
D 120 mm (4.72in.)
AT
B
C
D
Scanner Specifications
Scanner Type Flatbed

Photoelectric Device

cls

Maximum Document Size

216x297 mm (8.5x11.7in.)
A4, Letter

Resolution

1200 dpi (main scan)
2400 dpi (sub scan)

Color Depth

Color

[ 48 bits per pixel internal (16 bits per pixel per color internal)

[ 24 bits per pixel external (8 bits per pixel per color external)

Grayscale
[ 16 bits per pixel internal

[ 8 bits per pixel external

Black and white
1 16 bits per pixel internal

[ 1 bits per pixel external

Light Source

LED
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Interface Specifications
For Computer Hi-Speed USB
For External USB Devices and Hi-Speed USB
PictBridge
Network Function List
Network Functions and IPv4/IPv6
Functions Supported Remarks
Network Printing EpsonNet Print (Windows) IPv4 v -
Standard TCP/IP (Windows) IPv4, IPv6 v -
WSD Printing (Windows) IPv4, IPv6 v Windows Vista or
later
Bonjour Printing (Mac OS) IPv4, IPv6 v -
IPP Printing (Windows, Mac IPv4, IPv6 v -
05)
UPnP Printing IPv4 - Information
appliance
PictBridge Printing (Wi-Fi) IPv4 v Digital camera
Epson Connect (Email Print, IPv4 v -
Remote Print)
AirPrint (i0S, Mac OS) IPv4, IPv6 v iOS 5 or later, Mac
0OS Xv10.7 or later
Google Cloud Print IPv4, IPv6 v -
Network Scanning Epson Scan 2 IPv4, IPv6 v -
Event Manager IPv4 v -
Epson Connect (Scan to IPv4 v -
Cloud)
AirPrint (Scan) IPv4, IPv6 v OS X Mavericks or
later
ADF (2-sided scanning) - -
Fax Send a fax IPv4 - -
Receive a fax IPv4 - -
AirPrint (Faxout) IPv4, IPv6 - -
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Standards

IEEE802.11b/g/n"1"2

Frequency Range

24 GHz

Maximum Radio-Frequency Power
Transmitted

19.8 dBm (EIRP)

Coordination Modes

Infrastructure, Wi-Fi Direct (Simple AP)"3

Wireless Securities

WEP (64/128bit), WPA2-PSK (AES)™

*1  Complies with either IEEE 802.11b/g/n or IEEE 802.11b/g depending on location of purchase.

*2  |EEE802.11n is only available for the HT20.

*3  Not supported for IEEE 802.11b.

*4  Complies with WPA2 standards with support for WPA/WPA2 Personal.

Ethernet Specifications

Standards

IEEE802.3i (10BASE-T)"
IEEE802.3u (100BASE-TX)

IEEE802.3az (Energy Efficient Ethernet)™2

Communication Mode

Auto, 10Mbps Full duplex, 10Mbps Half duplex, 100Mbps
Full duplex, 100Mbps Half duplex

Connector

RJ-45

*1  Use a category 5e or higher STP (Shielded twisted pair) cable to prevent risk of radio interference.

*2  The connected device should comply with IEEE802.3az standards.

Security Protocol

SSL/TLS

HTTPS Server/Client, IPPS

Supported Third Party Services

AirPrint

Print

iOS 5 or later/Mac OS X v10.7.x or later

Scan

OS X Mavericks or later

Google Cloud Print
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External Storage Device Specifications

Supported Memory Card Specifications

Compatible Memory Cards

Maximum Capacities

miniSD” 2GB
miniSDHC” 32GB
microSD” 2GB
microSDHC" 32GB
microSDXC" 64 GB
SD 2GB
SDHC 32 GB
SDXC 64 GB

*  Attach an adapter to fit the memory card slot. Otherwise, the card may get stuck.

Supported External Storage Device Specifications

Compatible External Storage
Devices

Maximum Capacities

CD-R Drive™
DVD-R Drive™!

Blu-ray Drive"’

CD-ROM2/CD-R: 700 MB
DVD-ROM*2/DVD-R: 4.7 GB

(CD-RW, DVD+R, DVD+RW, DVD-RAM, and Blu-ray Disc™ are not supported.)

MO Drive™!

1.3GB

HDD™
USB Flash Drive

2 TB (formatted in FAT, FAT32, or exFAT)

*1  We do not recommend using external USB devices that are powered by USB. Use only external USB devices with
independent AC power sources.

*2  Readonly.

You cannot use the following devices:

(4 A device that requires a dedicated driver

(4 A device with security settings (password, encryption, and so on)

[ A device with a built-in USB hub

Epson cannot guarantee operations for all externally connected devices.
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Supported Data Specifications

File Format JPEGs (*.JPG) with the Exif Version 2.31 standard taken by digital cameras DCF"'
version 1.0 or 2.0"2 compliant

Image Size Horizontal: 80 to 10200 pixels
Vertical: 80 to 10200 pixels

File Size Less than 2 GB

Maximum Number of Files 9990*3

*1  Design rule for Camera File system.
*2  Photo data stored in the built-in memory of a digital camera is not supported.

*3  Upto 999 files can be displayed at a time. (If the number of files exceeds 999, the files are displayed in groups.)

Note:
"?" is displayed on the LCD screen when the printer cannot recognize the image file. In this situation, if you select a multiple
image layout, blank sections will be printed.

Dimensions

Dimensions Storage
d Width: 526 mm (20.7 in.)
(d Depth:415 mm (16.3in.)

(1 Height: 168 mm (6.6 in.)

Printing

d Width: 526 mm (20.7 in.)
(d Depth: 743 mm (29.3in.)
(1 Height: 453 mm (17.8in.)

Approx. 10.5 kg (23.1 Ib)

Weight”

*  Without the ink, power cord, and the CD/DVD tray.

Electrical Specifications

Model 100 to 240 V Model 100 to 120V Model 220 to 240 V Model
Rated Frequency Range 50 to 60 Hz 50 to 60 Hz 50 to 60 Hz
Rated Current 0.5t00.3A 0.5A 03A

Power Consumption
(with USB Connection)

Standalone copying: Approx.

13 W (ISO/IEC24712)

Ready mode: Approx. 6.4 W
Sleep mode: Approx. 0.9 W
Power off: Approx.0.15 W

Standalone copying: Approx.

13 W (ISO/IEC24712)

Ready mode: Approx. 6.4 W
Sleep mode: Approx. 0.9 W
Power off: Approx. 0.1 W

Standalone copying: Approx.
14 W (ISO/IEC24712)

Ready mode: Approx. 6.4 W
Sleep mode: Approx. 0.9 W
Power off: Approx. 0.2 W
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[ Check the label on the printer for its voltage.

[d For European users, see the following Website for details on power consumption.

http://www.epson.eu/energy-consumption

Environmental Specifications

Operation Use the printer within the range shown in the following graph.
%
80
55
20
10 27 35 ©
Temperature: 10 to 35°C (50 to 95°F)
Humidity: 20 to 80% RH (without condensation)
Storage Temperature: -20 to 40°C (-4 to 104°F)"

Humidity: 5 to 85% RH (without condensation)

* You can store for one month at 40°C (104°F).

Environmental Specifications for Ink Bottles

Storage Temperature

-20 t0 40 °C (-4 to 104 °F)"

Freezing Temperature

-15°C(5°F)

Ink thaws and is usable after approximately 2 hours at 25 °C (77 °F).

* You can store for one month at 40 °C (104 °F).

System Requirements

[ Windows 10 (32-bit, 64-bit)/Windows 8.1 (32-bit, 64-bit)/Windows 8 (32-bit, 64-bit)/Windows 7 (32-bit, 64-
bit)/Windows Vista (32-bit, 64-bit)/Windows XP SP3 or later (32-bit)/Windows XP Professional x64 Edition SP2

or later

[d macOS Sierra/OS X El Capitan/OS X Yosemite/OS X Mavericks/OS X Mountain Lion/Mac OS X v10.7.x/Mac

0OS X v10.6.8

Note:

[ Mac OS may not support some applications and features.

(A The UNIX File System (UFS) for Mac OS is not supported.
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Regulatory Information

Standards and Approvals

Standards and Approvals for U.S. Model

Safety UL60950-1
CAN/CSA-C22.2 No.60950-1

EMC FCC Part 15 Subpart B Class B
CAN/CSA-CEI/IEC CISPR 22 Class B

This equipment contains the following wireless module.
Manufacturer: Askey Computer Corporation
Type: WLU6320-D69 (RoHS)

This product conforms to Part 15 of the FCC Rules and RSS-210 of the IC Rules. Epson cannot accept
responsibility for any failure to satisfy the protection requirements resulting from a non-recommended
modification of the product. Operation is subject to the following two conditions: (1) this device may not cause
harmful interference, and (2) this device must accept any interference received, including interference that may
cause undesired operation of the device.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from
windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject
to licensing.

This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled environment and
meets the FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65 and RSS-102 of the IC radio
frequency (RF) Exposure rules. This equipment should be installed and operated so that the radiator is kept at least
7.9 inches (20 cm) or more away from a person's body (excluding extremities: hands, wrists, feet and ankles).

Standards and Approvals for European Model

For European users

Hereby, Seiko Epson Corporation declares that the following radio equipment model is in compliance with
Directive 2014/53/EU. The full text of the EU declaration of conformity is available at the following website.

http://www.epson.eu/conformity
C496A

For use only in Ireland, UK, Austria, Germany, Liechtenstein, Switzerland, France, Belgium, Luxemburg,
Netherlands, Italy, Portugal, Spain, Denmark, Finland, Norway, Sweden, Iceland, Croatia, Cyprus, Greece,
Slovenia, Malta, Bulgaria, Czech, Estonia, Hungary, Latvia, Lithuania, Poland, Romania, and Slovakia.

Epson cannot accept responsibility for any failure to satisfy the protection requirements resulting from a non-
recommended modification of the products.

C€
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Standards and Approvals for Australian Model

EMC AS/NZS CISPR32 Class B

Epson hereby declares that the following equipment Models are in compliance with the essential requirements and
other relevant provisions of AS/NZS4268:

C496A

Epson cannot accept responsibility for any failure to satisfy the protection requirements resulting from a non-
recommended modification of the products.

Restrictions on Copying

Observe the following restrictions to ensure the responsible and legal use of the printer.
Copying of the following items is prohibited by law:

[J Bank bills, coins, government-issued marketable securities, government bond securities, and municipal
securities

(d Unused postage stamps, pre-stamped postcards, and other official postal items bearing valid postage

4 Government-issued revenue stamps, and securities issued according to legal procedure

Exercise caution when copying the following items:

[d Private marketable securities (stock certificates, negotiable notes, checks, etc.), monthly passes, concession
tickets, etc.

[ Passports, driver’s licenses, warrants of fitness, road passes, food stamps, tickets, etc.

Note:
Copying these items may also be prohibited by law.

Responsible use of copyrighted materials:

Printers can be misused by improperly copying copyrighted materials. Unless acting on the advice of a
knowledgeable attorney, be responsible and respectful by obtaining the permission of the copyright holder before
copying published material.

Transporting and Storing the Printer

When you need to store the printer or transport it when moving or for repairs, follow the steps below to pack the
printer.

A Caution:

Be careful not to trap your hand or fingers when opening or closing the scanner unit. Otherwise you may be injured.

200



User's Guide

Appendix

n Important:

[ When storing or transporting the printer, place the printer in the plastic bag and fold it closed. Avoid tilting the
printer, placing it vertically, or turning it upside down; otherwise ink may leak.

]

IQQ’

[ When storing or transporting an ink bottle, do not tilt the bottle and do not subject it to impacts or temperature
changes. Otherwise, ink may leak even if the cap on the ink bottle is tightened securely. Be sure to keep the ink
bottle upright when tightening the cap, and take precautions to prevent ink from leaking when transporting the
bottle, for example, putting the bottle in a bag.

(4 Do not put opened ink bottles in the box with printer.

1. Turn off the printer by pressing the O button.

2. Make sure the power light turns off, and then unplug the power cord.

g Important:

Unplug the power cord when the power light is off. Otherwise, the print head does not return to the home
position causing the ink to dry, and printing may become impossible.

3. Disconnect all cables such as the power cord and USB cable.
4. Make sure there is no memory card inserted.
5. Remove all of the paper from the printer.

6. Make sure there are no originals on the printer.
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7. Open the scanner unit with the document cover closed. Secure the print head to the case with tape.
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10. Close the scanner unit.

=

11. Prepare to pack the printer as shown below.

©.

12. Place the printer in the plastic bag and fold it closed.

13. Pack the printer in its box using the protective materials.

When you use the printer again, make sure you remove the tape securing the print head. If print quality has
declined the next time you print, clean and align the print head.

Related Information

= “Part Names and Functions” on page 16

= “Checking and Cleaning the Print Head” on page 129
= “Aligning the Print Head” on page 132

Accessing a Memory Card From a Computer

You can write or read data on an external storage device such as a memory card that has been inserted in the
printer from a computer.
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n Important:

1 Insert a memory card after removing write protection.

A If an image is saved to the memory card from a computer, the image and the number of photos are not refreshed
on the LCD screen. Remove and insert the memory card again.

[ When sharing an external device inserted in the printer between computers connected over USB and over a
network, write access is only allowed to the computers that are connected by the method you selected on the
printer. To write to the external storage device, enter Settings on the control panel and select File Sharing Setup
and a connection method.

Note:
It takes a while to recognize data from a computer if a large external storage device, such as 2TB HDD, is connected.

Windows

Select an external storage device in Computer or My Computer. The data on the external storage device is
displayed.

Note:

If you connected the printer to the network without the software disc or Web Installer, map a memory card slot or USB port
as a network drive. Open Run and enter a printer name \\XXXXX or a printer's IP address \\XXX. XXX XXX . XXX to
Open:. Right-click a device icon displayed to assign the network. The network drive appears in Computer or My Computer.

Mac OS
Select a corresponding device icon. The data on the external storage device is displayed.

Note:
(A To remove an external storage device, drag and drop the device icon to the trash icon. Otherwise, data in the shared drive
may not be displayed correctly when another external storage device is inserted.

[ To access an external storage device through the network, select Go > Connect to Server from the menu on the desktop.
Enter a printer name cifs://XXXXX or smb://XXXXX (Where "XXXXX" is the printer name) in the Server Address, and
then click Connect.

Related Information
= “Inserting a Memory Card” on page 57
= “External Storage Device Specifications” on page 196

Where to Get Help

Technical Support Web Site

If you need further help, visit the Epson support website shown below. Select your country or region and go to the
support section of your local Epson website. The latest drivers, FAQs, manuals, or other downloadables are also
available from the site.

http://support.epson.net/
http://www.epson.eu/Support (Europe)

If your Epson product is not operating properly and you cannot solve the problem, contact Epson support services
for assistance.
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Contacting Epson Support

Before Contacting Epson

If your Epson product is not operating properly and you cannot solve the problem using the troubleshooting
information in your product manuals, contact Epson support services for assistance. If Epson support for your area
is not listed below, contact the dealer where you purchased your product.

Epson support will be able to help you much more quickly if you give them the following information:

[ Product serial number

(The serial number label is usually on the back of the product.)
1 Product model

[ Product software version

(Click About, Version Info, or a similar button in the product software.)
(4 Brand and model of your computer
[J Your computer operating system name and version

[J Names and versions of the software applications you normally use with your product

Note:

Depending on the product, network settings may be stored in the product’s memory. Due to breakdown or repair of a
product, settings may be lost. Epson shall not be responsible for the loss of any data, for backing up or recovering settings
even during a warranty period. We recommend that you make your own backup data or take notes.

Help for Users in Europe

Check your Pan-European Warranty Document for information on how to contact Epson support.

Help for Users in Australia

Epson Australia wishes to provide you with a high level of customer service. In addition to your product manuals,
we provide the following sources for obtaining information:

Internet URL
http://www.epson.com.au

Access the Epson Australia World Wide Web pages. Worth taking your modem here for the occasional surf! The
site provides a download area for drivers, Epson contact points, new product information and technical support (e-
mail).

Epson Helpdesk
Phone: 1300-361-054

Epson Helpdesk is provided as a final backup to make sure our clients have access to advice. Operators on the
Helpdesk can aid you in installing, configuring and operating your Epson product. Our Pre-sales Helpdesk staff
can provide literature on new Epson products and advise where the nearest dealer or service agent is located. Many
types of queries are answered here.
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We encourage you to have all the relevant information on hand when you ring. The more information you prepare,
the faster we can help solve the problem. This information includes your Epson product manuals, type of
computer, operating system, application programs, and any information you feel is required.

Transportation of Product

Epson recommends retaining product packaging for future transportation. Securing the ink tank with tape and
keeping the product upright is also recommended.

Help for Users in New Zealand

Epson New Zealand wishes to provide you with a high level of customer service. In addition to your product
documentation, we provide the following sources for obtaining information:

Internet URL
http://www.epson.co.nz

Access the Epson New Zealand World Wide Web pages. Worth taking your modem here for the occasional surf!
The site provides a download area for drivers, Epson contact points, new product information and technical
support (e-mail).

Epson Helpdesk
Phone: 0800 237 766

Epson Helpdesk is provided as a final backup to make sure our clients have access to advice. Operators on the
Helpdesk can aid you in installing, configuring and operating your Epson product. Our Pre-sales Helpdesk staft
can provide literature on new Epson products and advise where the nearest dealer or service agent is located. Many
types of queries are answered here.

We encourage you to have all the relevant information on hand when you ring. The more information you prepare,
the faster we can help solve the problem. This information includes your Epson product documentation, type of
computer, operating system, application programs, and any information you feel is required.

Transportation of Product

Epson recommends retaining product packaging for future transportation. Securing the ink tank with tape and
keeping the product upright is also recommended.
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